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Introduction  

 

Graphics are a key component of statistical analysis, enabling data to be visualized and 

summarized. An essential tool in exploratory data analysis, graphs are useful for checking 

and examining data, allowing unusual observations, such as outliers or typographical 

errors, to be identified and (where possible) corrected. Furthermore, the use of graphs to 

explore data can help guide the selection of an appropriate statistical model and reveal 

relationships between variables. Following a statistical analysis, graphs provide an 

effective tool for conveying information on the results of analysis in a compact and easily 

accessible format. 

This guide is designed to introduce you to Genstat’s suite of graphical tools, and enable 

you to use them correctly and effectively. Focusing on the menu interface, and using a set 

of examples that demonstrate the range of graphs available, the first two chapters provide 

an overview of Genstat graphics. The latter chapters are designed to provide more 

experienced users with the skills to create more advanced graphs using the Genstat 

command language.  

Chapter 1 provides an overview of the Genstat graphics system and the Genstat 

Graphics Wizard, which guides users through the process of creating high-resolution 

graphs appropriate to their needs. High-resolution graphs are drawn in the Genstat 

Graphics Viewer, a program that runs independently of Genstat. The functionality of the 

Graphics Viewer is described, including how to edit and save graphical output. The overall 

look and feel of high-resolution graphical output is controlled by the Graphics 

Environment. The chapter demonstrates how the appearance of a graph changes according 

to which built-in environment is active, and how to modify, save and activate a Graphics 

Environment. 

Chapter 2 gives four case-studies; a bar chart, a line plot, a 3D scatter plot and a trellis 

plot. Using these exemplars, the functionality of the Graphics menu and the Graphics 

Viewer is demonstrated.  

Chapter 3 provides an introduction to the generation of high-resolution graphics via 

the command language. The command language accommodates greater functionality than 

the menu interface, enabling more advanced graphics to be created. The chapter focuses 

on the directive DGRAPH, for drawing high-resolution graphs containing points, lines or 

shaded polygons, and the directive FRAME, PEN, XAXIS, YAXIS and ZAXIS, for 

modifying the Graphics Environment.  
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Further examples of using the command language to produce high-resolution graphics 

are provided in Chapter 4. These examples showcase the breadth of graphics possible in 

Genstat.  

Chapter 5 provides appendices listing Genstat’s graphical directives, procedures, pre-

defined colours, pre-defined symbols and pre-defined line styles. 
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1 Overview of Genstat graphics 

 

To help users generate high-resolution graphs appropriate to their needs, Genstat offers a 

Graphics Wizard. High-resolution graphs are then drawn in the Graphics Viewer, a program 

that runs independently of Genstat for display, editing and saving graphical output. 

Graphical output can be saved as a Genstat Meta File (file extension .gmf), a special file 

format that enables a graph to be re-loaded into the Graphics Viewer at a later date. 

The overall look and feel of the graphical output is controlled by the Graphics 

Environment. The default Graphics Environment is designed to be appropriate for the most 

common types of graph. To obtain more control over the appearance of your graphical 

output, you can change the Graphics Environment. 

 

In this chapter you will learn how to: 

• generate a graph using the Graphics Wizard (Section 1.1) 

• use the Graphics Viewer, including how to view, edit and save a graph (Section 1.2) 

• save graphical output as a Genstat Meta File and open it in the Graphics Viewer at a 

later date (Section 1.2.4.1) 

• make changes to the global settings of the Graphics Viewer (Section 1.2.5) 

• create, save and activate a Graphics Environment (Section 1.2.4) 
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1.1 Genstat Graphics Wizard 

 

Prior to analysis, it is often helpful to explore the data using graphical displays. Graphs 

can be used to examine the structure of the data, identify unusual observations, such as 

outliers or typographical errors, and/or to display the distribution of the data. Similarly, 

graphs are useful post analysis for visualizing and summarizing the results. Many types 

of graph can be accessed directly as options of the Graphics menu (see Chapter 2). 

Alternatively, Genstat provides a Graphics Wizard to help you select an appropriate graph.  

In this section we demonstrate use of the 

Graphics Wizard using the Sulphur.gsh 

data set, collected in 1990 to investigate 

changing levels of air pollution. The data 

set comprises two variates and two factors 

each containing 114 values: the amount of 

sulphur in the air each day (variate, 

Sulphur), the strength (variate, Windsp) 

and direction (factor, Winddir) of the 

wind and a factor Rain indicating whether 

or not it had rained. To load the data, click 

on File on the menu bar and select the Open Example Data Sets… option (Figure 1.1). This 

launches the Example Data Sets menu (Figure 1.2), where we select Sulphur.gsh.  

 

 
Figure 1.2: Opening Sulphur.gsh using the Example Data Sets menu. 

Figure 1.1: Loading a Genstat example data set. 
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To access the Graphics Wizard, 

from the menu select Graphics | 

Create Graph (Figure 1.3). This opens 

the Choose Graph menu (Figure 1.4), 

designed to help you select a graph 

appropriate for the type of data 

structures that you have available. 

The top pane, What is the form of the 

data?, lists  common categories used 

to describe the data. When you select 

an item in this pane, the list of graphs 

provided for that particular type of data is displayed in the second pane, Select the type of 

graph:. (In Table 1-1 the graphs corresponding to each form of data are listed.) To further 

assist in selecting an appropriate graphic, clicking on an item in the Select the type of graph: 

pane produces an example graph with a short description. We’ll use the Graphics Wizard 

to investigate the distribution of sulphur measurements (Single variate) using a 2D 

Histogram (see Figure 1.4). 
 

 
Figure 1.4: Choose Graph menu of the Graphics Wizard. 

Figure 1.3: Opening the Graphics Wizard. 
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Table 1-1: Data type with corresponding graphs offered by the Graphics Wizard. 

 

Single 

variate 

Single 

variate 

and 

grouping 

factor 

Two or 

more 

variates 

Two or 

more 

variates 

and 

grouping 

factor 

Summary 

tables Matrix 

2D Scatter Plot  ✓ ✓ ✓   

3D Scatter Plot   ✓ ✓   

Confidence Region Plot   ✓ ✓   

2D Line Plot  ✓ ✓ ✓   

2D Line & Scatter Plot  ✓ ✓ ✓   

2D Histogram ✓ ✓ ✓ ✓   

3D Histogram      ✓ 

Dot Histogram ✓ ✓ ✓ ✓   

Bar Chart     ✓  

Two-way Bar Chart     ✓  

Plot Table     ✓  

Boxplot ✓ ✓ ✓ ✓   

Dot-plot ✓ ✓ ✓ ✓   

Bland-Altman Plot   ✓    

Separation Plot ✓ ✓ ✓ ✓   

Rug Plot ✓ ✓ ✓ ✓   

Pie Chart ✓    ✓  

1D Density Plot ✓ ✓ ✓    

2D Density Plot   ✓    

Contour Plot      ✓ 

Surface Plot      ✓ 

Shade Plot      ✓ 

Image Plot      ✓ 

Scatter Plot Matrix   ✓ ✓   

Trellis Plot   ✓ ✓   

Windrose Diagram ✓      

Circular Plot ✓  ✓    

Polar Plot   ✓ ✓   

Spider-web / Star Plot    ✓ ✓  

Separation Plot ✓ ✓ ✓ ✓  ✓ 

 

Clicking the OK button opens the menu corresponding to the chosen graphic, here 2D 

Histogram (see Figure 1.5). Each menu has a similar structure comprising a Data tab and 
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an Options tab, and where relevant tabs for Error bars, Lines and Symbols, Key, X-Axis, Y-

Axis, Z-Axis and Frame. Although the fields within each tab are customized to the chosen 

graphic, the essential function is the same: 

• Data tab: specifies the data for plotting; 

• Options tab: controls the appearance of the graph (e.g. providing a title); 

• Error bars tab: used to add error bars to the graph (for an example, see Section 2.1.2); 

• Lines and Symbols tab: controls the colour and style of the plotted lines and/or symbols 

(for an example, see Section 1.1.2); 

• Key tab: controls the appearance and contents of the key (for an example, see Section 

2.2.2); 

• X-Axis, Y-Axis, Z-Axis tabs: used to set the attributes of the axes to control the appearance 

of the graph (e.g. specifying lower and upper axes limits; for an example, see Section 

1.1.1); 

• Frame tab: used to set the attributes of the frame in which the graph is displayed (see 

Section 1.1.3). 

 

In the bottom right-hand corner of the Graphics menu are three buttons (see Figure 1.5): 

Run produces the graph, Cancel closes the graphics menu, and Defaults returns the options 

to their default settings. In the bottom left-hand corner are four action icons: 

 
Pin The Pin icon controls whether the menu remains open after the Run 

button is clicked. When the pin is down ( ), the menu is kept 

open. This allows you to try different settings, until you get the 

graph you want, without having to reopen the Graphics menu and 

reset all the fields. When the pin is sideways (  , the default), the 

menu will close after the Run button is clicked.  

 
Restore The Restore icon restores the input field settings used previously. 

 
Clear The Clear icon clears the input fields. 

 
Help The Help icon launches the help documentation for the Graphics 

menu. 

 

The 2D Histogram menu opens on the Data tab, where we enter the data to be plotted 

(Figure 1.5). To create a histogram of the sulphur measurements, select Sulphur from 

within the Available data: list. Click the arrow (or double mouse-click) to place it into the 

Data variates: field.  
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Figure 1.5: Using the 2D Histogram menu to create a histogram of Sulphur. 

 

Additional options and settings can be set in the Options, X-Axis, Y-Axis and Frame tabs. 

Help documentation is provided for each tab. To access the help, click the help icon ( ) 

located in the bottom left corner of each tab. We’ll provide a title for the histogram by 

entering Sulphur pollution into the Graph Title: field of the Options tab (Figure 1.6).  
 

 
Figure 1.6: Options tab of the 2D Histogram menu. 
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Clicking the Run button produces the 

histogram shown in Figure 1.7, giving the 

number of observations in successive equal-

width categories of the Sulphur scale. 

Clearly Sulphur has a skewed distribution: 

there are many days with little or no sulphur 

in the air, and then decreasing numbers in 

successive categories with more and more 

sulphur. 

Many statistical studies are concerned not 

just with a single variate, but with the 

relationships between variables. For example, 

with the sulphur air pollution data it is natural 

to investigate questions such as "Is there any 

effect of wind speed on the sulphur level?" 

Scatter plots are a useful tool for investigating the relationship between variates. To 

produce a scatter plot, from the menu select Graphics | Create Graph then select Two or 

more variates. In the Select the type of graph: field select 2D Scatter Plot. Clicking OK opens 

the 2D Scatter Plot menu on the Data tab, shown in Figure 1.8. As we wish to plot the 

sulphur levels against the wind speeds, select Sulphur as the Y variate: and Windsp as 

the X variate:. 
 

 
Figure 1.8: Using the 2D Scatter Plot menu to create a scatter plot of Sulphur against Windsp. 

Figure 1.7: Histogram of the variate Sulphur. 
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In the Options tab, shown in Figure 1.9, we’ll enter a title for the plot in the Graph title: 

field. Clicking on Run produces the graph shown in Figure 1.10. 

 
Figure 1.9: Options tab of the 2D Scatter Plot menu. 

 

 
Figure 1.10: Scatter plot of Sulphur against Windsp. 
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 Modifying axis attributes 

Many of the graphics menus contain axis tabs allowing you to modify the different axes 

(x, y, z). Here, you can set various axis attributes such as a title, a lower limit, an upper 

limit, tick mark positions and the origin position (i.e., values on the x-, y- or z-axis through 

which the axis is drawn).  

To illustrate the axis tabs, from the menu select Graphics | Create Graph and again select 

the Two or more variates option with 2D Scatter Plot as the type of graph. On the Data tab, 

select Sulphur as the Y variate: and Windsp as the X variate:, as before. 

The X-Axis tab is shown in Figure 1.11. Detailed help information on all options is 

available by clicking on the help icon ( ). To improve the plot (shown in Figure 1.10), 

we’ll change the x-axis title by selecting the Display title option and entering Wind speed 

m/s into the space provided. Furthermore, using the Lower bound and Upper bound panes 

we’ll set the lower and upper x-axis bounds to 0 and 25, respectively. 

Clicking on the Y-Axis tab produces an identical menu to the X-Axis tab. Select the 

Display title option and enter the title Sulphur microg/m~^{3}. The string ~^{3} is a 

special typesetting command to make 3 a superscript (for more information on 

typesetting, refer to Section 4.2.1).  

 

 
Figure 1.11: X-Axis tab of the 2D Scatter Plot menu. 
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 Modifying lines and/or symbols 

The Graphics menus for line, scatter and polar plots also contain a Lines and Symbols tab. 

This allows you to set the style and colour of the graph’s lines and/or symbols. The Lines 

and Symbols tab for a scatter plot is shown in Figure 1.12.  

In the Graph: field we specify the series for which the line and/or symbol attributes are 

to be set. If groups had been specified on the Data tab (see Figure 1.8), then these would 

be shown in the Graph: field list. For example, had we entered the factor Winddir in the 

Groups: field of the 2D Scatter Plot menu, then a list of 8 series (corresponding to the 8 

levels of Winddir) would appear under the Graph: field. The first series in the list 

corresponds to the first ordinal value of the grouping factor and so on (i.e. Plot 1 – Group 

1 = E, Plot 2 – Group 2 = N, Plot 3 – Group 3 = NE, …, Plot 8 – Group 8 = W). You can 

set line and symbol attributes for each different level of the group (i.e. series) by toggling 

through the list in the Graph: field.  

As there is only one series in our current example (scatter plot of Sulphur against 

Windsp) the Graph: list contains only Plot 1. To improve the plot (shown in Figure 1.10), 

we’ll change the symbols to dark blue circles with light blue fill: choose  Circle in the 

Symbols: field, and use the Colour: and Fill colour list boxes to specify the desired colours 

(see Figure 1.12).  

 
Figure 1.12: Using the Lines and Symbols tab to change the symbols to dark blue circles with light blue fill. 
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Clicking on Run produces the 

graph shown in Figure 1.13, 

where the points are now 

represented by filled circles and 

the axes are titled. Modifications 

to this graph, for example adding 

a forgotten title, can still be made 

using Editor mode of the Graphics 

Viewer (see Section 1.2.2). 

 

 Modifying the frame 

The Frame tab (Figure 1.14) 

allows you to control the position 

of the plot within the graphics 

frame (see Section 2.1.5 for 

further information). Each graph is plotted into one of the windows in the frame. Here, 

we are plotting into window 1 using its default position. This is defined to use the top 3/4 

of the frame. (Window 2, which is used if you include a key on the graph, uses the lower 

1/4 of the frame.). The Draw radio buttons allow you to put extra graphs onto an existing 

frame (i.e. superimpose a new plot onto the current graph)  
 

 
Figure 1.14: The Frame tab of the 2D Scatter Plot menu. 

Figure 1.13: Improved scatter plot of Sulphur against Windsp. 
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1.2 Genstat Graphics Viewer 

 

By default the graphical output is drawn in the Graphics Viewer, a program that runs 

independently of Genstat (see Figure 1.15). This starts automatically when a graph is 

generated, and you can switch between Genstat and the Graphics Viewer at any time. To 

bring the Graphics Viewer to the front of the display click the Graphics button ( ) on the 

toolbar:  

 
 

Figure 1.15: Genstat (left window) and Graphics Viewer (right window). 

 

Images in the Graphics Viewer are produced in a vector format which is scaled to fit 

the current size of the Graphics Viewer window. This means that the full resolution of the 

image can be maintained if the window is resized or printed. Genstat’s graphics format 

also includes extensive meta-information about the graph and the data contained within 

it, allowing many aspects to be edited interactively on the screen.  

The Graphics Viewer operates in three modes – Viewer, Editor and Child. We describe 

each of these modes in turn. 

 

 Viewer mode 

The Viewer mode is the default display for the Graphics Viewer (see Figure 1.16). When 

graphs are received from Genstat or opened via the File menu they will be displayed in 

Viewer mode. In this mode you can zoom the graph, view data information on different 
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points, add a title and save the graph to other graphics formats, such as Enhanced 

Windows Metafile, Bitmap, JPEG, PostScript, or PNG.  

 

 
Figure 1.16: Graphics Viewer in Viewer mode. 

 

The Graphics Viewer displays a single graph (or a single composite plot, such as a 

trellis plot) at any one time. However, it also maintains a list of graphs as they are 

generated within Genstat. It is easy to switch the display between the current graph and 

another by selecting the name of the desired graph from the Window menu; or, by using 

the Previous ( ) or Next ( ) arrows on the toolbar.  

The Viewer mode has its own bars, as you can see in Figure 1.16 and reproduced below: 

 

Title bar  

Menu bar  

Toolbar 

 

If the graph has been given a title, this will appear in the title bar. Since Figure 1.16 is 

untitled a default name, Unnamed 1, appears on the title bar. You can readily add a title 

in Viewer mode using the Edit | Main Title… menu. 
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Hovering the mouse over a button on the toolbar will cause a tooltip containing the 

button’s name to appear. We briefly describe the function of each button below: 

Buttons on the standard toolbar 

 Open Opens a previously saved Genstat Meta File (extension .gmf), a 

private file format that enables Genstat graphs to be re-loaded into 

the Graphics Viewer (see Section 1.2.4.1). 

 Save Saves the active graph (see Section 1.2.4). 

 Save All Saves all graphs listed in the Graphics Viewer (see Section 1.2.4). 

 Copy Copies the active graph to the Clipboard. 

 
Undo Undoes changes made to the graph in Editor mode (see Section 

1.2.2). 

 
Redo Redoes an undone change that was made to the graph in Editor 

mode (see Section 1.2.2). 

 
Print Prints the graph to your selected device. 

 
Close Closes the graph, removing it from the Graphics Viewer. 

 
Previous Switches the display to the previous graph listed in the Graphics 

Viewer. 

 
Next Switches the display to the next graph listed in the Graphics 

Viewer. 

 
List Opens a menu window that lists the graphs available for display 

by the Graphics Viewer. Using this menu, you can select which 

graph to display using the Activate button, or close one or more 

graphs using the Close Window(s) button. 

 

Buttons on the graphics toolbar 

 
Home Returns the graph to the home position. Scroll bars on the bottom 

and right-hand side of the Graphics Viewer window (see Figure 

1.16) allow you to alter the horizontal and vertical position of the 

graph on your screen. The zoom slider on the toolbar, 

, enables you to alter its size. Clicking on the 

Home button returns the graph to its “home” position and size. 

 
Set Home Resets the home position to the currently displayed position and 

size of the graph. 

 
Show All Changes the zoom to make the entire graph visible. 

 
Data Info Provides information about a plotted data point. Clicking on the 

Data Info button changes the cursor to an arrow with a question 
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mark. Hovering this cursor over a point in the graph makes 

information about that point appear. See Figure 1.17.  

 
Figure 1.17: Using the Data Info button to elicit information on a data point. 

 

You can change what information is displayed on the screen using 

the Tools | Options… | Data Information… menu. By default the label, 

unit number, description and coordinates of the selected point are 

displayed. 

 
Point 

Selection 
Selects a data point. Clicking on a data point selects that point. 

Clicking a second time will remove it from the selection. Each 

selected point is highlighted (see Figure 1.18, where five data 

points have been selected). Information on the selected data points 

can be copied to the Clipboard using the Copy Data button. The 

Point Selection button becomes available only when the Data Info 

button is activated. 
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Figure 1.18: Five data points (outlined in red) selected using Point Selection. 
 

 
Rectangle 

Selection 
Selects points within a rectangular region on the graph. To define 

the region, click on a corner of your desired rectangular region, 

hold down the left mouse button and drag to draw a rectangle. 

Release the mouse button to complete the rectangle. Points falling 

inside this region are selected. The Rectangle Selection button 

becomes available only when the Data Info button is activated. 

 
Polygon 

Selection 
Selects points within a polygon on the graph. To define, 

sequentially click on the corners of your desired polygon, using a 

right-click to specify the last corner. The Polygon Selection button 

becomes available only when the Data Info button is activated.  

 
Copy Data Copies information on data points selected using the Point 

Selection, Rectangle Selection and/or Polygon Selection buttons to 

the Clipboard. You can change what information is copied using 

the Tools | Options… | Data Information… menu. 

 Clear 

Selection 
Clears the selection of data points. 

 
Hot Choice A special button that allows you to toggle the visibility of “hot 

components” in a graph. See Section 4.2.13. 
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 Editor mode 

Modifications to a graph, for example adding a forgotten title, can be made by invoking 

Editor mode. To do this either: 

• double-click on the graph; or, 

• select Edit Graph from the Edit menu.  

The window title and background colour will change to indicate the new mode, as shown 

in Figure 1.19. 
 

 
Figure 1.19: Graphics Viewer in Editor mode. 

 

When you change to Editor mode, the Options menu automatically opens (If closed, the 

Options menu can be re-opened by double-clicking on the graph or by selecting one of the 

options under Edit on the menu bar.) This menu consists of several tabs where graphical 

settings can be changed The fields within each tab are customized to each graph type. 

Full documentation on all Options can be found within the Genstat Help System (accessed 

via the Help button). 

The Options menu for the scatter plot of Sulphur against Windsp is shown in Figure 

1.20. Changes to the layout of the graph can be made via the Layout tab. For example, 

mk:@MSITStore:C:/Program%20Files%20(x86)/Gen15ed/Doc/genstat.chm::/html/graphviewer/Layout.htm
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here you can edit (or disable) the graph’s title and control the background colours. You 

can edit the appearance (e.g. font and position) of the key or legend via the Key tab. The 

axis tabs (here X Axis and Y Axis) enable you to alter the settings of the axes attributes, 

such as the lower and upper bounds. Additional options to control the display (e.g. the 

colour of the plotted points) are accessed via the last tab, Graph Options. (This tab is 

labelled Histogram Options for Histograms, Pie Chart Options for pie charts, and so on.) 
 

 
Figure 1.20: Options menu within Editor mode of the Graphics Viewer for a scatter plot. 

 

In the upper right corner of the Editor mode window 

you’ll find the buttons shown in Figure 1.21. The 

functions of these buttons are: 

• Select/Pick button: enables you to select an object in 

the graph to manipulate (by double-clicking on the 

chosen object). For example, clicking on a point in the 

graph (of Figure 1.19) launches the Graph Options, in 

which you can edit the appearance of the plotted 

points. When the Select/Pick button is active, the cursor 

is an arrow ( ). 

 

Select/Pick 

View 

Show All 

Seek 

Set Home 

Figure 1.21: Buttons in Editor mode. 

Home 

mk:@MSITStore:C:/Program%20Files%20(x86)/Gen15ed/Doc/genstat.chm::/html/graphviewer/Key.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Gen15ed/Doc/genstat.chm::/html/graphviewer/Graph.htm
mk:@MSITStore:C:/Program%20Files%20(x86)/Gen15ed/Doc/genstat.chm::/html/graphviewer/Graph.htm
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• View button: enables you to alter the position and size of the graph on your screen. For 

two-dimensional graphs, such as scatter plots, hold the left mouse button and drag to 

zoom. For three-dimensional graphs, hold the left mouse button and drag to rotate. To 

change the position of the graph hold the scroll-wheel and drag the plot. When the View 

button is active, the cursor will change to an upright arrow ( ).  

You can also use the thumbwheels to adjust the position and size of the graph. For 

two-dimensional graphs, the thumbwheels (V Scroll, H Scroll) in the lower left-hand 

corner (see Figure 1.19) can be used to move the graph horizontally (H Scroll) or 

vertically (V Scroll). For three-dimensional plots these are replaced by RotX and RotY, 

which rotate the graph around the x- and y-axes, respectively (see Section 2.3). The 

Zoom thumbwheel in the lower right-hand corner (see Figure 1.19) enlarges/shrinks 

the graph. To move a thumbwheel, click down on the thumbwheel button and drag 

your mouse left/right or up/down as appropriate. 

• Home button: returns the graph to its home position. 
 

• Set Home button: resets the home position to the current position and size of the graph. 
 

• Show All button: changes the zoom to make the entire graph visible. 
 

• Seek button: “centres” the graph. When the Seek button is activated, the cursor changes 

to a crosshair ( ). Clicking on the graph will move that point to the centre of the 

display. For three-dimensional plots, this also sets the centre point for rotation.  

For three-dimensional graphs, a further 3 buttons become available: the projection 

buttons  (see Section 2.3). The Z button rotates the graph to align the view to the 

z-axis, providing a top-down view along the z-axis. Clicking the Z button again will toggle 

the view between aligning the view with the z-axis in the positive and negative directions. 

The X and Y buttons perform the same function relative to the x- and y-axes, respectively.  

For composite graphs containing two or more individual components within a single 

display, such as trellis plots, the position/zoom controls operate on the entire display, 

whilst the built-in editor operates on individual component plots (for further details, see 

Section 2.4).  

Once you’ve made the desired changes to the graph, return to Viewer mode either by: 

• selecting File | Save and Close on the menu bar; or, 

• by clicking the  button on the toolbar.  

(The Undo ( ) and Redo ( ) buttons on the Graphics Viewer toolbar will enable you to 

undo, then redo, any changes.) 
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Alternatively, if you wish to discard your 

changes before returning to Viewer mode, select 

File | Close on the menu bar (or click the  

button on the toolbar). A prompt (see Figure 1.22) 

will appear asking you whether you want to keep 

the changes you’ve made to the graph. To discard 

the changes, click the No button. Selecting Yes will 

retain the changes. Clicking Cancel will return you 

to Editor mode.  

 

 Child mode  

The Graphics Viewer displays only a single 

graph (or single composite plot) at a time. 

The Child mode allows you to view several 

plots at once. From the Graphics Viewer, 

you can open any graph in a new instance 

of the Child Viewer by right-clicking on the 

graph and selecting Display in Child Viewer 

from the pop-up menu (Figure 1.23). The 

window title and background colour will 

change to indicate the new mode. 

In the Child Viewer you cannot edit the 

graph or open other graphs. However, you 

can still print, save and interact with the 

graph as in the main Graphics Viewer.  

 

 Saving Genstat graphics 

 

1.2.4.1 Genstat Meta Files 

Individual displays can be saved as a Genstat Meta File (extension .gmf). This is a private 

file format that saves the graph and additional information, so that the graph can be 

redisplayed or edited on another occasion using the Graphics Viewer. In Viewer mode, to 

save a graph as a Genstat Meta File either: 

• select File | Save (or File | Save As…) on the menu bar; or, 

• click the Save button on the toolbar ( ), 

and then choose Genstat Meta Files (*gmf) in the Save as type: field.  

Figure 1.22: Options for retaining or discarding 

changes made to a graph in Editor mode. 

Figure 1.23: Opening a graph in a new instance of the Child 

Viewer. 
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Multiple graphs can be easily saved via File | Save All, or the Save All button ( ).  

Previously saved .gmf files can be opened in the Graphics Viewer (from Genstat or the 

Graphics Viewer) via: 

• File | Open … on the menu bar; or, 

• the Open button on the toolbar ( ). 

Note, it is not possible for graphics saved in other formats to be (re)opened in the 

Graphics Viewer.  

 

1.2.4.2 Other formats 

The contents of the Graphics Window can also be saved to files in standard graphics 

formats: Encapsulated PostScript (.ps), Windows Enhanced Meta Files (.emf), JPEG 

(.jpg), TIFF (.tif), Portable Network Graphics (.png), Bitmaps (.bmp) and Portable 

Document Format (.pdf). Simply select your desired format in the Save as type: field. 

When saving a graph as points, the.png file format is recommended (as opposed to .jpg, 

.tif or .bmp) since the file size is smaller and .png files don’t suffer from information loss 

as.jpg files do. 

When saving a graph to a .jpg, .tif .png or.bmp file, the resolution and amount of 

white space bordering the graph can be controlled using the Graphics Viewer options 

(Tools | Options | Saving Files, see Section 1.2.5). The resolution and orientation of .pdf 

files can also be specified. 

 

1.2.4.3 Saving Genstat commands 

In this chapter we’ve used Genstat menus to create graphs. However, the menus 

themselves operate by generating Genstat commands which you can see recorded in the 

Input Log window. (In Genstat, to bring the Input Log window to the top select Window | 

Input Log.) Genstat commands can be saved as .gen files that can be used to re-generate 

the graph at a later date, or edited to modify the graph if desired. Within the Graphics 

Viewer, you can save the Genstat commands that produce the active graph by: 

• choosing File | Save (or File | Save As…) on the menu bar; or, 

• clicking the Save button on the toolbar ( ), 

and then selecting Genstat Command Files (*.gen) in the Save as type: field.  

Using Genstat’s command language unlocks the full power of the Genstat graphics. 

We illustrate the use of commands in Chapter 3. 
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 Global Graphics Viewer options  

From Viewer (and Child) mode, you can set global options for the Graphics Viewer. Select 

Tools | Options… to launch the Options menu for the Graphics Viewer (Figure 1.24). The 

menu comprises six tabs with the following functions: 

• Workspace tab (Figure 1.24): controls the appearance and settings of the Graphics 

Viewer. For example, from the Workspace tab you can specify the toolbars to display 

and the background colours used for distinguishing between the Viewer, Editor and 

Child modes. 

 
Figure 1.24: Options menu of the Graphics Viewer. 

 

• Saving Files tab: provides options and settings to control how graphics are saved (see 

Section 1.2.4). 

• Fonts tab: enables you to set the default font used by Genstat for textual output, 

including titles and axes labels.  

• Data Information tab: controls the type of information on a data point that is displayed 

on the screen (by ) or copied to the Clipboard (by ).  

• Printing tab: provides options and settings to control how graphics are printed.  

• Advanced tab (Figure 1.25): provides options to override certain default settings in 

cases where problems arise because of incompatibilities with Windows, other software 

or device drivers. Note that the Use automatic text boxes for axis labels option is 
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automatically selected by default. This option forces the axis labels to fit into non-

overlapping text boxes, the width of which are determined by the distance between 

tick marks. Axis labels therefore may not appear in the size specified when this option 

is selected. You may wish to deselect the Use automatic text boxes for axis labels option 

in order to freely resize the labels (see Section 2.1.1.1 and Figure 2.8 for an example), 

however this often results in overlapping axis labels. Likewise, the Use automatic text 

boxes for plot titles option is automatically selected by default. This forces the plot’s title 

to fit into a text box based on the width of the plot. Therefore, when this option is 

selected, the plot title may not appear in the size specified.  

 

 

Figure 1.25: Advanced tab of the Options menu for the Graphics Viewer. 

 

At the bottom of each tab are three buttons: OK accepts the changes made to the 

options, Cancel discards the changes made to the options and Help launches the help 

documentation.  
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1.2.5.1 Resetting options to higher resolution settings 

Versions of Genstat prior to the 17th edition used lower resolution settings that optimised 

the output from standard printers available at the time. More modern printers are capable 

of higher resolution output, typically 600 dpi or greater. If you have successively 

upgraded Genstat from earlier versions you will have imported your old print and save 

file settings from those versions; to increase the resolution of your saved or printed 

graphs, follow these steps. 

1. In the Graphics Viewer select Tools | Options then click the Advanced tab (Figure 

1.25).  

2. Click Optimize settings to let Genstat choose recommended settings for text 

quality, rendering quality, printing and saving image files. 
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1.3 Graphics Environment 

 

The appearance of graphical output in Genstat is controlled by the Graphics Environment. 

The Graphics Environment specifies how graphs are to be produced, controlling aspects 

such as whether the graph is enclosed in a box, how the key is displayed, and the colours 

used for plotting. Genstat provides Graphics Environments to suit different tastes and 

situations. Alternatively, you can design your own (see Sections 1.3.1 and 1.3.2). 

Graphics Environments are saved in a special file format with extension .ggd (see Section 

1.3.3). 

To see the choices of Graphics 

Environments available, from the 

menu select Tools | Graphics 

environments…. This opens the 

Graphics Environment menu shown in 

Figure 1.26. Your currently selected 

environment will be highlighted.  

The Graphics environments: pane 

lists all of the available Graphics 

Environments (i.e. .ggd files stored in 

the graphics subfolder of the Genstat 

add-ins folder; see Section 1.3.3). 

Genstat provides several built-in 

Graphics Environments, including the 

Genstat Default Environment, designed to be appropriate for many different types of graph. 

The default environment was used to create the graphs presented earlier in this chapter. 

Environments for creating graphs in the style of Excel and R are also provided. 

To activate a different Graphics Environment, highlight the desired environment in the 

Graphics environments: pane then click the Set as current button. This will not only activate 

the selected Graphics Environment in the current session but will continue to use it each 

time Genstat is re-started (until another environment is activated). 

To show how the appearance of the graph changes according to which built-in 

Graphics Environment is currently active, let’s re-create the two graphs in Section 1.1 

(Figure 1.27: histogram of Sulphur and Figure 1.28: scatter plot of Sulphur against 

Windsp) under the six built-in Graphics Environments.  

Figure 1.26: Graphics Environment menu accessed via Tools | 

Graphics environments…. 
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a) b) 

c) d) 

e) f) 

 

Figure 1.27: Histogram of Sulphur created under the six built-in Graphics Environments; a) Genstat Default 

Environment (cf Figure 1.7 of Section 1.1), b) Grayscale graphics, c) Bold symbols and lines, d) Microsoft Excel 2003 

style graphics, e) Microsoft Excel 2010 style graphics, f) R style graphics. 
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a) b) 

c) d) 

e) f) 

 

Figure 1.28: Scatter plot of Sulphur against Windsp created under the six built-in Graphics Environments; a) Genstat 

Default Environment (cf Figure 1.10 of Section 1.1) , b) Grayscale graphics, c) Bold symbols and lines, d) Microsoft Excel 

2003 style graphics, e) Microsoft Excel 2010 style graphics, f) R style graphics. 
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 Editing an existing Graphics Environment 

You can modify an existing Graphics Environment (but not the Genstat Default Environment) 

by clicking on the Edit… button in the Graphics Environment menu (Figure 1.26). This 

opens the Graphics Environment Attributes menu, shown in Figure 1.29, comprising six tabs 

used to control: 

• Grid tab: aspects of grid lines, such as their colours and presence; 

• Key tab: aspects of the key such as the font and colour; 

• Outlines tab: outlines of graphs such as histograms, bar charts and pie charts; 

• Axis tab: aspects of axes such as fonts and colours for titles and labels; 

• Frame tab: aspects of the frame such as the title font and colour; 

• Symbols tab: aspects of the pens used to display the symbol, such as colours and symbol 

size. 

The Grid tab, populated with the 

settings of the built-in Graphics 

Environment Microsoft Excel 2010 style 

graphics, is shown in Figure 1.29. The 

options in the Grid lines in 2D and 3D plots 

and Grid lines in 3D plots panes control 

whether or not grid lines are drawn in a 

particular direction. For example, the 

selection of yx plane draws grid lines in the 

yx plane running from the y-axis (i.e., 

parallel to the x-axis). Here you can also 

control the colour, line style and thickness 

of the grid lines used by the Graphics 

Environment. 

 

 

 

 

 

 

 

 

Figure 1.29: Grid tab of the Graphics Environment Attributes 

menu, launch by clicking on the Edit button on the Graphics 

Environment menu. The tab is populated with the settings 

of the built-in Graphics Environment Microsoft Excel 2010 

style graphics. 
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Figure 1.30 shows the Key tab 

populated with the settings of the built-in 

Graphics Environment Microsoft Excel 2010 

style graphics. Here you can set the font 

style, colour and size (relative to the 

default font size) of the key used by 

Graphics Environment. Options are also 

provided for displaying a border around 

the key. If Border the full key region is 

selected, the box around the key is drawn 

using the full region that the key is placed 

in. For example, if the key is placed in 

Window 2, then the box will be drawn 

around the border of Window 2. 

 

 

 

The Outlines tab, populated with the 

Microsoft Excel 2010 style graphics settings, 

is shown in Figure 1.31. It comprises three 

panes where you can set the outline colour 

and thickness for histograms, bar charts 

and pie charts. 

 

 

 

 

 

 

 

 

 

Figure 1.30: Key tab populated with the settings of the 

Graphics Environment Microsoft Excel 2010 style graphics. 

Figure 1.31: Outlines tab populated with the settings of the 

Graphics Environment Microsoft Excel 2010 style graphics. 
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The Axis tab (populated with the 

Microsoft Excel 2010 style graphics settings) 

is shown in Figure 1.32. Here you can set 

the font style, colour and size (relative to 

the default font size) of the axes titles and 

labels, used by Graphics Environment. 

You can also set the colour, style and 

thickness of the axes lines.  

 

 

 

 

 

 

 

 

The Frame tab (populated with the 

Microsoft Excel 2010 style graphics settings) 

is shown in Figure 1.33. Here you can set 

the font style, colour and size (relative to 

the default font size) of the graph title. 

You can also control whether or not the 

Graphics Environment draws a bounding 

box around the graphs. For surface plots, 

when Border the full graph region is selected 

a box is drawn around the full region the 

surface plot is drawn in. For example, if 

the surface plot is drawn in Window 5, 

then the box will be drawn around the 

border of Window 5. 

 

 

 

 

Figure 1.32: Axis tab populated with the settings of the 

Graphics Environment Microsoft Excel 2010 style graphics. 

Figure 1.33: Frame tab populated with the settings of the 

Graphics Environment Microsoft Excel 2010 style graphics. 
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Figure 1.34 shows the Symbols tab 

populated with the settings of the 

Graphics Environment Microsoft Excel 

2010 style graphics. The Pens: pane lists 

the available pens within Genstat and 

their associated symbol attributes. You 

can select a pen in the Pens: pane and 

alter its attributes (colour, symbol, 

symbol size, and fill colour) by 

changing the various settings in the Pen 

attributes pane. Click Apply to apply the 

changes to the selected pen. To change 

several pens simultaneously, simply 

select multiple pens in the Pens: pane 

(hold the Ctrl button down whilst 

selecting the pens), make the desired 

changes in the Pen attributes pane and 

click Apply to selection. This opens a 

dialog box asking you to confirm what settings in the selection to change. 

After editing the tabs, click the OK button. This will permanently save your changes to 

the Graphics Environment.  

 

 Creating a new Graphics Environment 

Rather than modifying an existing built-in 

Graphics Environment, it might be preferable to 

create a new one. You can design your own 

Graphics Environment by clicking on the 

New… button on the Graphics Environment 

menu (Figure 1.26). This opens the Create New 

Graphics Environment menu (Figure 1.35).  

New Graphics Environments are saved as 

.ggd files in the Genstat add-ins folder (see 

Section 1.3.3). The two options of the Create 

environment file in pane specify whether the 

Graphics Environment file will be saved within 

the system or user add-in folder. To make the 

Figure 1.34: Symbols tab populated with the settings of the 

Graphics Environment Microsoft Excel 2010 style graphics. 

Figure 1.35: Menu for creating a new Graphics 

Environment. 
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Graphics Environment file available system wide, i.e. to all users with access to Genstat 

on a network server or on a local machine, the file must be placed in the system add-in 

folder. Alternatively, to make the Graphics Environment file available only to the current 

user, the file must be placed within the user add-in folder. (The location of the user add-

in folder is set on the Tools | Option | General tab.) 

The Filename: field lets you specify a filename. Save the file using the extension .ggd. 

In the Description: field you can specify a description of your new Graphics Environment. 

This description will be displayed in the list of Graphics Environments on the Graphics 

Environment menu (see Figure 1.26). 

The Create using graphics environment: pane lists all of the available Graphics 

Environments. You must select one of these to initially create your new Graphics 

Environment.  

Clicking the Create button launches the Graphics Environment Attributes menu (see 

Figure 1.29). The tabs of this menu will be populated with the settings of the Graphics 

Environment you chose in the Create using graphics environment: pane. Modify these 

settings then click OK to create your new Graphics Environments (see Section 1.3.1). The 

description of your newly created Graphics Environment will now appear in the list of 

Graphics Environments on the Graphics Environment menu (see Figure 1.26). (Note, you 

can delete a selected Graphics Environment and its associated file from the add-ins folder 

by clicking on the Remove button in the Graphics Environment menu.) 

 

 Graphics Environment files  

A Graphics Environment is created by a .ggd file that contains commands specifying 

exactly how a graph is to be produced. It controls aspects like whether or not boxes are 

drawn around the plots, how the key is displayed, and the styles and the colours of outlines 

for graphs such as histograms or shade plots. The Graphics Environment files (.ggd) are 

located in a subfolder of the add-ins folder called “graphics”. There are two types of add-

in folders: system and user. Graphics Environment files that are available system wide, i.e. 

to all users that have access to Genstat on a network server or on a local machine, are 

located in the graphics subfolder of the system add-in folder called “AddIns within the 

Genstat installation”. Alternatively, Graphics Environment files available only to the 

current user are located in the user add-in folder. The location of the user add-in folder is 

controlled via the General tab within the Tool | Options menu: the default file path is 

C:\Program Files\Gen19Ed\AddIns. 

 

mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/GraphicsEnvironment.htm
mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/GraphicsEnvironment.htm
mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/GraphicsEnvironment.htm
mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/GraphicsEnvironment.htm
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2 Genstat Graphics menu 

 

Many different types of graph can be accessed directly as options of the Graphics menu 

found on the menu bar (see Figure 1.3). Selecting a graph will launch a window 

containing its menu, designed to guide you through the creation of your chosen graphic. 

The menus of all graphs have a similar structure comprising a Data tab and an Options tab, 

and where relevant tabs for Error bars, Lines and Symbols, Key, Axis, X-Axis, Y-Axis, Z-Axis 

and Frame. To demonstrate how to generate and customize a graph using the Graphics 

menu, this chapter presents four case-studies: a bar chart (Section 2.1), a line plot (Section 

2.2), a 3D scatter plot (Section 2.3) and a trellis plot (Section 2.4). For each case study, 

the menu options are described in detail. We also explore how to use Editor mode in the 

Graphics Viewer to modify the graph. 

The Graphics menu also provides functionality to add text, reference lines and arrows 

to an existing graph open in the Graphics Viewer. In Section 2.5, we illustrate how to add 

these additional features to a graph. 

Comprehensive help for all of the graphics menus is readily available by clicking on 

the help icon, , located at the bottom left-hand corner of the menu window. 

All graphs illustrated in this chapter are generated using the Genstat Default 

Environment. 

 

In this chapter you will learn: 

• how to create a graph using the Graphics menu 

• how to add text, reference lines and arrows to a graph  

• the functionality of the Data, Options, Error bars, Lines and Symbols, Key, Axis, X-Axis, 

Y-Axis, Z-Axis and Frame tabs 
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2.1 Case study: bar chart 

 

A bar chart provides a graphical representation of a table. For example, a bar chart might 

present product sales in different cities, or sales of different types of products. Bar charts 

differ from histograms in that the x-axis is not divided into a set of contiguous intervals 

(as in Figure 1.7), but rather the bars are located at equal intervals along the x-axis. Also, 

the table need not contain counts, but may contain any numerical values, for example 

profits (and losses), or yields of a crop.  

Bar charts with either one or two classifying factors can be plotted using the Graphics 

| Bar Chart… menu. In the following subsections, we’ll describe the functionality of the 

Bar Chart menu’s six tabs using the example data set Toysales.xls for illustration. 

The excel file Toysales.xls contains yearly sale data on toy dogs and toy kittens 

from a business with shops in four cities. The worksheet, Dog and Kitten Sales, 

contains the number of toy dogs and kittens sold (SoldDog and SoldKitten, 

respectively), and the price of these per unit (CostDog and CostKitten, respectively) 

for each shop (City) over three years (Year). To load the worksheet, click on File | Open 

Example Data Sets…, then select Toysales.xls. Clicking the Open data button launches 

the Select Excel Worksheet for Import menu where we select the worksheet Dog and 

Kitten Sales  Figure 2.2. Click Finish and the spreadsheet shown in Figure 2.2 will be 

loaded.  

 

 Data tab 

The Graphics | Bar Chart… menu opens in the Data tab, used for specifying the data to plot 

(Figure 2.3). The data can be supplied as a Variate(s) defining heights or as a Summary 

  Figure 2.2: Selecting the worksheet Dog and Kitten 

Sales of Excel file Toysales.xls to import. 

Figure 2.2: Spreadsheet of the toy dog and toy kitten 

yearly sale data (Toysales.xls). 
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table(s). A single bar chart is plotted when a one-way table of data or a variate defining 

the bar heights is supplied. Alternatively, several bar charts are plotted on the same graph 

if a list of one-way tables (classified by the same factor), a list of variates, or a two-way 

table is supplied. Examples of these different scenarios are provided below.  

 

2.1.1.1 Data supplied as a variate(s) 

To form a bar chart from data supplied as a variate(s), select Variate(s) defining heights in 

the Data arrangement pane (Figure 2.3). The variates available for plotting are listed in the 

Available data: field. The toy data contains four variates (CostDog, CostKitten, 

SoldDog and SoldKitten). We’ll begin by plotting the number of toy dogs sold 

(SoldDog) in each year at the four cities in a single bar chart. Select SoldDog and click 

on the arrow (or alternatively double-click on SoldDog) to move it into the input field, 

Variates of heights:, where the variates for plotting are specified. The Labels for bars: field 

lets you specify a text structure for labelling the bars. As no text structures have yet been 

defined, the Available data: field is empty when the Labels for bars: field is selected. 
 

 
Figure 2.3: Data tab settings for drawing a bar chart of the number of toy dogs sold (SoldDog). 

 

Once the data have been supplied, you can draw the bar chart graph by clicking the 

Run button. The resulting bar chart is shown in Figure 2.4. Alternatively, additional 

options and axes settings can be set in the other tabs (as described in the subsections that 

follow).  
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The bar chart comprises 12 bars, labelled 1, 

2, …, 12 corresponding to the rows of data in 

Figure 2.2. Note, that although the data is 

ordered by Year, the ordering of City within 

Year is inconsistent. To aid interpretation of 

the bar chart, we shall label the bars and order 

them by Year and City within Year. 

To create a text structure for labelling the 

bars, click on the Spreadsheet window (Figure 

2.2) then select Spread | Calculate | Combine 

Text…. This opens the Combine/Concatenate 

Text Columns menu where we’ll combine the 

Year and City columns to create a new text 

structure, RowLabels (refer to Figure 2.5). 
 

 

Figure 2.5: Combine/Concatenate Text Columns menu settings used to create a new text structure, from the Year and 

City columns of Figure 2.2, to label the bars of Figure 2.4. 

 

Next, to ensure the bars are consistently ordered, click on the Spreadsheet window then 

select Spread | Sort…. This opens the Sort on Column values menu where we select 

RowLabels in the Sort on column: field. Click OK and the rows of data are now ordered 

by RowLabels (i.e. Year and City within Year) (see Figure 2.6). 

Figure 2.4: Bar chart of the number of toy dogs sold 

(SoldDog). 
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Figure 2.6: Spreadsheet of the toy dog and toy kitten yearly sale data (Toysales.xls), with text column RowLabels 

added and data ordered by Year and City within Year. 

 

We will now redraw the bar chart in 

Figure 2.4 but include bar labels by 

entering RowLabels into the Labels for 

bars: field (see Figure 2.3). The resulting 

bar chart is shown in Figure 2.7.  

The bar labels are illegibly small as 

the axis labels are forced to fit into non-

overlapping text boxes by default. The 

width of these text boxes are determined 

by the distance between tick marks (see 

Section 1.2.5, Advanced options). To 

make them legible, we will edit their 

settings in the Graphics Viewer (see 

Section 1.2). Invoke Editor mode, for 

example by double-clicking on the graph. Once in Editor mode, open the X Axis tab of the 

Options window, for example by choosing the X Axis option under Edit on the menu bar. 

In the Display labels pane, we set the Direction: to Perpendicular, so that the labels are 

orientated to run perpendicular to the x-axis. To increase the font size, click on the Label 

font… button and increase the Size: to 10 in the Font window. Click OK to close the Font 

window. Click Apply to apply the changes to the bar labels. (In order to freely resize the 

font, ensure that Use automatic text boxes for axis labels is unselected in the Advanced tab of 

the global Graphics Viewer Options menu (see Section 1.2.5).) 

Figure 2.7: Bar chart of the number of toy dogs sold 

(SoldDog) with bar labels (RowLabels). 
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To further enhance the bar chart, we’ll also add a title to the y-axis. In the Y Axis tab, 

select Display title and enter the text “Number of Toy Dogs Sold”. Click Apply to add 

the y-axis title. 

Finally, we’ll colour the individual bars according to the city: green = Belfast, red 

= Cardiff, blue = Glasgow and white = London. Open the Barchart Options tab of the 

Options menu. Select a bar using the Bar: field (bars are labelled numerically by row 

number, i.e. bar 1 = 1998 Belfast, bar 2 = 1998 Cardiff, …, bar 12 = 2000 

London) and pick the required colour in the Bar Colour: dropdown menu. Ensure sure 

Apply colour to all bars is not selected then click Apply to change the colour of the selected 

bar. Repeat to appropriately colour all bars.  

Click OK then Save and Close, to make the requested changes and exit Editor mode. 

The resulting graph is shown in Figure 2.8. 

 
Figure 2.8: Bar chart of the number of toy dogs sold (SoldDog) having edited the bar labels (RowLabels) to make 

them legible, added a y-axis title and coloured the bars according to the City. 

 

We can also plot several bar charts on the same graph, for example both the number 

of toy dogs and toy kittens sold (SoldDog and SoldKitten, respectively), by entering 

multiple variates into the Variates of heights: field of the Data tab (see Figure 2.9). 

However, if several variates are supplied they must contain the same number of values.  
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Figure 2.9: Data tab settings for drawing a bar chart with two variates: the number of toy dogs sold (SoldDog) and the 

number of toy kittens sold (SoldKitten). 

 

A bar chart of both the SoldDog and 

SoldKitten variates is shown in Figure 

2.10. As above, the bar labels have been 

edited in the Graphics Viewer to make 

them legible. Furthermore, to avoid 

overlap with the bar labels, the key has 

been moved to the top left by opening the 

Key tab on the Options menu (when in 

Editor mode) and setting the X Position: to 

0.5 and the Y Position: to 1 in the Key 

Region pane (see Figure 2.11). We’ve also 

opted to remove the box around the key 

by deselecting Display Border:. 

 

Figure 2.10: Bar chart with two variates defining bar 

heights: SoldDog and SoldKitten. The bar labels 

(RowLabels) have been edited to make them legible, 

and the key moved to avoid overlap. 
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Figure 2.11: Settings of the Key tab of the Options menu used to change the position of the key (in Editor mode). 

 

2.1.1.2 Data supplied as a summary table(s) 

One-way and two-way summary tables, whose entries contains the heights for each bar, 

can also be used to generate bar charts. To form a bar chart from data supplied as a table, 

select Summary tables(s) in the Data arrangement pane (Figure 2.12).  
 

 
Figure 2.12: Fields of the Data tab when Summary table(s) is selected. 
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All summary tables available for plotting will be 

listed in the Available data: field. As our session 

doesn’t yet contain any one- or two-way tables we 

click the Create summary table… button to form one. 

This opens a dialog box (Figure 2.13) offering two 

options for creating tables with 1 or 2 classifying 

factors: Entering the data values into a spreadsheet or 

Forming a summary table using grouping factors. We 

can use the grouping factors Year and/or City to 

form a summary table. 

Select Forming a summary table using 

grouping factors and click OK to open the 

Create Table using Groups menu (Figure 

2.14) First, let’s create a summary table 

giving the average number of toy dogs sold 

per year in each of the four cities. To do 

this, form a One-way table of the Variate: 

SoldDog by the Groups factor: City. The 

Create table using: dropdown provides a list 

of the statistics that can be used to 

summarize the groups. Here, we select the 

statistic Means, so that the summary table 

contains the average number of toy dogs 

sold per year for each city. Finally, the Save 

table in: field lets us specify a name for our table. We save the table as 

SoldDog_AveragePerCity. Clicking OK will form the table and return us to the Data 

tab of the Bar Chart menu (Figure 2.12). Our table, SoldDog_AveragePerCity, now 

appears in the Available data: field. 

Repeat using the Variate: SoldKitten to create a summary table giving the average 

number of toy kittens sold per year in each city. Save this table as 

SoldKitten_AveragePerCity. 

In the input field, Summary tables:, the tables for plotting are specified. You can supply 

one or more one-way tables or a single two-way table. If several one-way tables are 

supplied, they must all be classified by the same factor. Here, we select our newly created 

one-way tables, SoldDog_AveragePerCity and SoldKitten_AveragePerCity, 

Figure 2.13: Create Table dialog box with the 

two options for creating a one- or a two-way 

summary table. 

Figure 2.14: Settings of the Create Table using Groups 

menu used to create SoldDog_AveragePerCity, a one-

way table containing the average number of toy dogs sold 

per year in each city. 



2 Genstat Graphics menu 

44 

 

both of which are classified by the factor City (Figure 2.15). Click Run to produce the 

graph shown in Figure 2.16. 

 

 
Figure 2.15: Data tab settings for creating a bar chart from two one-way tables (SoldDog_AveragePerCity and 

SoldKitten_AveragePerCity), which respectively describe the average number of toy dogs and toy kittens sold per 

year in each of the four cities. 

 

 
Figure 2.16: Bar chart describing the average number of toy dogs and toy kittens sold per year in four cities. 
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Finally, we demonstrate the creation of a bar-chart from a two-way table. After 

selecting Summary tables(s) in the Data arrangement pane of the Bar Chart menu (Figure 

2.15), click the Create summary table… button. In the dialog box choose Forming a summary 

table using grouping factors and click OK to open the Create Table using Groups menu (Figure 

2.13). We will use the grouping factors Year and City to rearrange the toy dog sales 

data (see Figure 2.6) into a two-way table. (As in this example there is no replication at 

the Year by City level, setting the Create table using: field to Totals or Means simply 

rearranges the original data from long-format into a two-way table). The factor supplied 

in the Groups factor 1: field defines the colour of the bars, whereas the factor supplied in 

the Groups factor 2: field defines the grouping of bars on the x-axis. The bar charts 

produced with Groups factor 1: City and Groups factor 2: Year, and vice versa, are given 

in Figure 2.17a and b, respectively. 

a) b) 

Figure 2.17: Bar chart of the SoldDog variable rearranged into a two-way table. a) Groups factor 1: City and Groups 

factor 2: Year, b) Groups factor 1: Year and Groups factor 2: City. 

 

 Error bars tab 

The Error bars tab, which can be used to include error bars on the bar chart, becomes 

available after the data has been supplied within the Data tab (Section 2.1.1). Each error 

bar takes the form of a horizontal line joined by a vertical line at the specified height both 

above and below the bar. The heights for the error bars must be supplied using the same 

type of data structures that were used in the Data tab menu. For example, if the data were 

mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/WizardDataBarchart.htm
mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/WizardDataBarchart.htm
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supplied in variates defining the heights (as in Section 2.1.1.1) then the heights of the 

error bars must also be supplied using variates.  

We will add standard error of the mean (SEM) error bars to Figure 2.16 – a bar chart 

describing the average number of toy dogs and toy kittens sold per year in each of the 

four cities. However, in order to do so we must first calculate the SEMs of the plotted 

means. In Genstat, this is readily achieved using the Stats | Summary Statistics | Summary 

tables… menu (Figure 2.18a). To calculate the SEM of the average number of toy dogs 

sold per year, set the Variate: field to SoldDog and the Groups: field to City. Click the 

Store… button to open the Summary Tables Store Options menu (Figure 2.18b), enabling us 

to save the SEMs in a table. Select Standard Error of Mean. The In: field provides a space 

to name the table of SEMs. We’ll store them in semDog. Repeat for SoldKitten, and 

save the SEMs in a table named semKitten. 

a) 

 

b) 

 

Figure 2.18: Using the Summary Table menu to a) calculate and b) save a table, semDog, containing the standard error 

of the average number of toy dogs sold per year for each of the four cities.  

 

In the Error bars tab (Figure 2.19), the height of the lower and upper error bars are 

specified in the Lower error bars: and Upper error bars: fields, respectively. Using the 

settings shown in Figure 2.19, +/- SEM bars are added to Figure 2.16. The resulting graph 

is shown in Figure 2.20. Note, if Lower error bars: are not specified, the error bars are 

assumed to have the same heights below and above the bars (for our example, once again 

resulting in Figure 2.20). 
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Figure 2.19: Error bars tab: adding +/- SEM bars to Figure 2.16. 

 

 

Figure 2.20: Bar chart describing the average number of toy dogs and toy kittens sold per year in the four cities. 

Errors bars denote +/-SEM. 
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 Options tab 

The Options tab allows you to set attributes that control the appearance of a bar chart 

(Figure 2.21). The Graph Title: field lets you enter a title for your graph. If Enclose bar chart 

in box is selected, a box is drawn around the graph. You can control the gap between bars 

using the X scale (proportion of space allocated to bars): setting. Here, the proportion of the 

space along the x-axis that each bar occupies is specified (default = 0.8). Increase this 

value to reduce the gap (a setting 1 forces the bars to be contiguous); decrease this value 

to increase the gap. The Orientation pane allows you to specify the orientation of the bars 

as either Vertical (the default) or Horizontal. For multiple bar charts, such as Figure 2.20, 

the Position of bars pane allows you to select between Parallel (the default) or Stacked bars.  

The Title font… button opens a menu where you can change the font attributes (style, 

colour and size) of the graph’s title. Alternatively, the Edit all fonts as list… button opens 

the Font attributes menu in which you can specify the font attributes of all titles and labels 

(Figure 2.21). 

For illustration, we’ll re-plot the graph of Figure 2.20, using the Options tab to add a 

title, remove the enclosing box, draw horizontally stacked bars and, using the Edit all fonts 

as list…| Font attributes menu, increase the size of the x-axis labels. See Figure 2.21. The 

resulting bar chart is shown in Figure 2.22. 

 

 
Figure 2.21: Settings of the Options tab used for adding a title, removing the enclosing box, and re-plotting Figure 2.20 

with horizontally stacked bars. 
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Figure 2.22: Re-plotting Figure 2.20 using the Options tab settings given in Figure 2.21. 

 

 X-Axis and Y-Axis tabs 

The X-Axis and Y-Axis tabs provide control over the appearance of the bar chart’s x- and 

y-axes, respectively. The Y-Axis tab of the Bar Chart menu is shown in Figure 2.23. The X-

Axis tab is similar, albeit with a subset of the fields, since not all the functionality is 

required to control a bar chart’s x-axis (i.e. there is no need to set lower and upper bounds 

on a bar chart’s x-axis). 

The visibility of the axis is controlled using Display axis. Deselecting Display axis will 

hide the axis. Selecting Reverse axis direction will reverse the direction the axis runs (i.e. 

from upper to lower, instead of the default lower to upper). 

The Display title field lets you enter an axis title. You can control the appearance of the 

title using the Position: and Orientation: radio buttons, and using the font menu launched 

by clicking on the Title font… button. 

The lower bound of the axis is set within the Lower bound pane. You can either supply 

a lower bound, by selecting Use value: and entering a number into the space provided, or 

request that a bound based on the minimum data value is used, by selecting Minimum data 

value. In the latter case, by selecting Include margin and entering a value into the % of range 

field, you can control the size of margin between the lower value of the axis and the 

minimum data value. Similarly, the upper bound can be set using the fields within the 

Upper bound pane. 
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The X origin pane is used to specify the position of the origin on the x-axis. By default, 

the lower bound of the x-axis is used, so that the axis is drawn at the bottom of the plot. 

However, you can use the radio buttons to put the origin at either the Upper, Lower, Centre, 

or Zero value on the x-axis, or at a specified value by selecting Use X origin: and entering 

a number. Note, if the origin specified is outside the axis bounds, then the upper or lower 

bound is automatically adjusted to include it.  

The Display labels option controls whether or not the axis labels are displayed. If 

selected, the appearance of the labels can be controlled using the Position: radio buttons, 

the Orientation: radio buttons, the Edit font for y-axis label menu (launched by clicking Label 

font…) and the Format Label Options menu (launched by clicking Format labels…). 

The Display tick marks option controls whether or not tick marks are displayed. If 

selected, you can control the positioning and type of tick marks using the options 

provided. If Minor tick marks is selected, you can specify the number of minor tick marks 

to draw between each of the (major) tick marks. 

In the Display pane you can select whether an arrowhead will appear at the end of the 

axis and whether grid lines are drawn. 

 

 
Figure 2.23: Y-Axis tab of the Bar Chart menu. 
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 Frame tab 

The Frame tab sets the attributes of the frame that the bar chart is displayed within. The 

graph is plotted into one of the numbered windows in the frame (by default, Window 1). 

Each window is a rectangular area of the screen which is defined using normalized device 

coordinates (NDC). The Graph region pane is used to define the area of the window, along 

with margins for titles, axis labels, etc. The default settings of the Graph region, 

corresponding to Window 1, are shown in Figure 2.24. 

 
Figure 2.24: Frame tab of the Bar Chart menu. 

 

Alternatively, the Window pane allows you to define the window in which the bar chart 

is plotted. You can either select a window Number: or a position within the frame using 

the list provided in the Area: dropdown menu. When a window Number: or Area: is selected 

the positions and margins will change within the Graph region pane corresponding to the 

position of the selected window within the frame. You can change these settings to alter 

the size and position of the region.  

The Draw radio buttons control whether a new plot is created in the Graphics Viewer, 

or whether the bar chart is superimposed onto the last plot drawn. 

In the General pane you can specify colours for the window: either a global Background 

colour:, or separate colours for the interior of the window (where the data is plotted), the 

frame of the window (the region outside the interior) and the title bar of the window. 
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2.2 Case study: 2D line plot 

 

Line plots (also known as line charts) are used to graph two variables as a series of data 

points connected by line segments. This allows the local change from point to point to be 

seen, in addition to the global trend. Line plots are very similar to scatter plots, the key 

differences being: i) lines connect adjacent data points, and ii) the independent variable 

can be ordinal as well as continuous.  

Line plots, with either single or multiple X and Y variables, can be created using the 

Graphics | 2D Line Plot… menu. In the following subsections, the functionality of the 2D 

Line Plot menu is described. The example data set DiptonWeather.xls is used for 

illustration.  

The Excel file DiptonWeather.xls contains monthly meteorological data from 

Dipton, New Zealand, collect from January 1997 to December 2012 (Figure 2.25). The 

data set comprises three continuous variables; the monthly mean of the daily maximum 

temperatures (Mean_Temperature), the total monthly rainfall (Rainfall) and the 

maximum wind speed for the month (MaxGust). The time of the day the maximum wind 

gust was recorded is stored as a time variate, GustTime (the suffix :T in the column title 

marks this column as time). The year and month the meteorological information was 

collected is stored in factors Year and Month (marked by the suffix !), respectively. The 

date of collection is stored in the date variate, Date (the suffix :D marks this column as 

a date). 

 
Figure 2.25: Segment of the Excel file DiptonWeather.xls. 
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To load the Dipton weather data, click on File | Open Example Data Sets…, and then 

select DiptonWeather.xls. 

 

 Data tab 

The Graphics | 2D Line Plot… menu opens in the Data tab, used to supply the data to plot 

(Figure 2.26). The menu accommodates four types of plot, listed in the Type of plot: field; 

• Single XY – used for plotting a single Y variable against a single X variable. For 

example, Mean_Temperature against Date (see Figure 2.27). 

• Multiple X – used for plotting a single Y variable against multiple X variables in the 

same graph. For example, we might be interested in plotting Mean_Temperature 

against both Rainfall and MaxGust in a single graph. 

• Multiple Y – used for plotting multiple Y variables against the same X variable in a 

single graph. For example, Mean_Temperature and Rainfall against Date. 

• Paired XY – used when plotting multiple X and Y variables in the same graph. Here, 

each Y variate is paired with an X variate. For example, suppose we also had monthly 

rainfall data recorded in the nearby towns of Tuatapere and Gore. For each town, the 

pair of X (date) and Y (rainfall) variables can be plotted, as a separate line, in a single 

graph. 

For all plot types, there are three input fields: the Y variate: and X variate: fields, where 

the Y and X variate(s) for plotting are specified, and the Groups: field where a factor(s) 

can be specified so that different groups are plotted as separate lines (on the same graph). 

The Available data: field lists all the available data structures appropriate to the current 

input field. The contents will change as you move from one field to the next. Double-

click on a name (or click on the arrow button) to copy it into the current input field. 

We’ll begin by plotting Mean_Temperature against Date (see Figure 2.26). Click 

Run to create the plot using the default Options, Lines and Symbols, Key, X-Axis, Y-Axis and 

Frame settings (Figure 2.27a). 
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Figure 2.26: Data tab of the 2D Line Plot menu, for a Single XY line plot of Mean_Temperature against Date. 

 

a) 

 

b) 

 

Figure 2.27: Line plot of Mean_Temperature against Date, with a) default settings and b) formatted date labels. 

 

The x-axis labels for Date (a variate stored as a date) are given as the number of days 

since 1 January 1900 (refer to A Guide to the Genstat Spreadsheet for more information). 

We can change the format of these labels, say to mmm-yy, in Editor mode of the Graphics 

Viewer (see Section 1.2). Invoke Editor mode by double-clicking on the plot, then open 
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the X-Axis tab. Click the Format Labels… button to launch the Format Label Options menu 

(Figure 2.28). In this menu select Date Representation:. This allows you to choose your 

desired format for Date in the dropdown list. The modified graph is shown in Figure 

2.27b. 
 

 
Figure 2.28: Using Editor mode to change the format of the x-axis Date labels. 

 

To better visualize the annual trend, next 

we’ll plot Mean_Temperature against 

Month separately for each Year. To do this 

we set the Y variate: to Mean_Temperature, 

the X variate: to Month, and in the Groups: field 

we enter Year. The resulting graph is shown 

in Figure 2.29. Each year of data is 

represented by a differently coloured line. By 

default a key is displayed, in which the factor 

labels for Year have been used to describe the 

different data series. Notice though how the 

key has been truncated at 2007, such that the 

labels for 2008 to 2012 are missing. This has 

occurred because the key, at its current 

location, cannot fit onto an A4 page. In the 

next section, Section 2.2.2, we demonstrate Figure 2.29: Annual trend in Mean_Temperature 

for 1997 to 2012. 
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how to alter the position of the key, using the Key tab menu, to avoid this truncation.  

 

 Key tab 

The Key tab menu (Figure 2.30) controls the display and contents of the key. To include 

a key, select Display key. This will activate the other fields in the tab in which you can 

define the appearance and contents of the key.  

 
Figure 2.30: Key tab of the 2D Line Plot menu. 

 

The text displayed by key, to describe each series plotted, can be changed using the 

fields in the right-hand pane of the Key tab (see Figure 2.30). Under Data set descriptions 

a list giving the key descriptions for each data series is shown. In our example, this 

corresponds to the 16 years of Dipton Weather data. By default, Genstat automatically 

generates the key from the variates plotted and/or the group labels (as in the current 

example). You can change the text displayed in the key by double-clicking on an item in 

the list then typing into the field. Alternatively, right clicking on an item allows it to be 

edited, cleared, set to its default value, set to its factor label, or set to its factor level. To 

simultaneously edit multiple items, select them using the keyboard Shift or Ctrl keys. 

(Selected items are highlighted.) The right mouse menu or the buttons (Use factor label, 
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Use factor level, or Use factor level as date:) can then be used to simultaneously edit the 

selected items. If groups have been provided (in the Groups: field of the Data tab) clicking 

the Use factor label button sets the key descriptions of the currently selected items to use 

the factor labels. (If the factor does not have labels, then the levels will be used). Similarly, 

clicking Use factor level sets the key descriptions to use the factor levels. The Use factor 

level as date button sets the currently selected items to use the factor level displayed as a 

date. The date format used is specified in the dropdown list to the right of this button. The 

size of the font used for displaying the descriptions in the key is set in the Font size: field. 

You can remove items from the key by unselecting the check boxes in the list.  

You can change the appearance of the key using the fields in the left-hand pane of the 

Key tab. Using the Display border: tick box and dropdown list you can control whether a 

border is drawn around the key in the specified colour. Likewise you can control whether 

the background of the key is filled, with a specified colour using Display background:. The 

Text colour: and Text font: dropdowns enable you to set the colour and style of the key’s 

font, respectively.  

To display a title above the key, select Display title: and enter text into the space 

provided. The key's title will be displayed using the font specified in the Title font: 

dropdown list, with the colour selected in the Colour: field. The size of the font is 

controlled by the Title size: field. This is a positive number (smaller than 100), specifying 

a value by which the default font size is multiplied. 

The position and size of the key is set in the Key region pane. Using the Position: 

dropdown list you can select the location of the key on the plot. By default the key is 

displayed below the graph. The Specify height: and Specify width: fields, controlling the size 

of the key in device coordinates, are activated when a non-default position is selected. 

These default to values large enough to accommodate the descriptions in the key. 

However, if values are provided and i) insufficient height is allowed for, the description 

list will be truncated, or ii) insufficient width is allowed for, the key descriptions will be 

shrunk. When Position is set to Given, the Y (top) and X (left) fields are enabled. These fields 

define the position of the top left corner of the key in device coordinates. The Number of 

columns dropdown list specifies how many columns the key is displayed in. (Note: the 

options available in the Position: dropdown list are determined by whether the key is 

displayed in one or more columns) 

We redraw the plot in Figure 2.29 such that a key with 2 columns is displayed, without 

a border, to the right of the main graph, using the settings given in Figure 2.30. See Figure 

2.31for the resulting graph. 
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Figure 2.31: Annual trend in Mean_Temperature for 1997 to 2012. Key position modified using the Key tab settings 

shown in Figure 2.30. 
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 Options tab 

The Options tab allows you to set attributes that control the appearance of the line plot 

(Figure 2.32).  

 

A title for the line plot can be specified in the Graph title: field. Set the title position by 

selecting either the Centre, Left or Right radio buttons. To set the font for the title, click on 

the Title font… button to launch the Edit font for plot title menu, or, alternatively, click the 

Edit all fonts as list… button to open the Font attributes menu (see Figure 2.21). 

You can choose whether or not to draw a box around the graph using the Enclose graph 

in box option.  

For a Single XY line plot, the Display marginal distribution for pane is available. This 

provides the option of plotting a Histogram, Rug plot or Boxplot of the X variable and/or Y 

variable along their respective axes (see Figure 2.33). By default, no marginal 

distributions are plotted. To illustrate, in Figure 2.33 the marginal distribution of 

Mean_Temperature is displayed as a a) Histogram, b) Rug plot and c) Boxplot on the line 

plot against Date. 

Figure 2.32: Options tab of the 2D Line Plot menu. 
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a)   b) 

c)   

Figure 2.33: Line plot of Mean_Temperature against Date, displaying marginal distribution of Mean_Temperature 

as a a) Histogram, b) Rug plot and c) Boxplot. 

 

The line plot and the graph of the 

marginal distribution are plotted in 

separate frames: the line plot, by default, 

in Frame 1 and the marginal distribution 

in Frame 2. You can modify the features 

of either graph by invoking Editor mode 

and selecting the appropriate frame in the 

Select frame dialog box (Figure 2.34).  Figure 2.34: Selecting frame of Figure 2.33a to edit in 

Editor mode. 
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 Lines and Symbols tab 

The Lines and Symbols tab allows you to control the appearance of the plotted data points 

(Figure 2.35). This tab becomes available after the data has been supplied within the Data 

tab. By default, for a line plot the data points are connected using solid lines, and symbols 

aren’t displayed.  

 

Figure 2.35: Lines and Symbols tab of the 2D Line Plot menu. 

 

In the Graph: field we specify the series for which the line and/or symbol attributes are 

to be set. Note: if groups have been specified on the Data tab menu, these will be listed in 

the Graph: field. The “plot” for each group (i.e. series on the graph) is represented by its 

ordinal value. For more information, refer to Section 1.1.2. 

Within the Line styles pane you can set the style, thickness and colour of the plotted 

line. In addition, using the Method: dropdown list, you can specify how the lines 

connecting the data points are drawn. The default method, Line, connects the data points 

using straight lines. The methods Monotonic, Closed Curve or Open Curve connect the data 

points using smooth curves. (For more information on these methods, refer to the help 

documentation accessible by clicking on the help icon, .) The Smoothing Spline setting 

plots a spline fitted through the data points. By default four degrees of freedom are used, 

however, you can change this by supplying another value in the Degrees of freedom: field. 

mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/WizardDataBarchart.htm
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To add a smoothing spline to Figure 2.27b we could either:  

• first create the plot of Figure 2.27b, then use the Add to last plot option of the Frame tab 

to superimpose a plot of Mean_Temperature against Date with the Smoothing Spline 

setting, or; 

• set Type of plot: to Multiple Y (or PairedXY) in the Data tab, then request two plots of 

Mean_Temperature against Date (see Figure 2.36a). The Graph: field in the Lines 

and Symbols tab will now list two plots (Plot 1 and Plot 2). For one, set the method to 

Line, and for the other to Smoothing Spline. For example, using the settings shown in 

Figure 2.36b, series Plot 2 is plotted as a smoothing spline, with four degrees of 

freedom, using a solid red line. The resulting plot is shown in Figure 2.37. 

a) 

 

b) 

 

Figure 2.36: Adding a red smoothing spline to a line plot of Mean_Temperature against Date; a) Data tab and b) 

Lines and Symbols tab. 
 

 
Figure 2.37: Line plot of Mean_Temperature against Date. Superimposed in red is the fitted smoothing spline (with 

4 degrees of freedom). 
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Also within the Line styles pane is the option to Sort points in X order. When selected 

(the default), the data will be sorted so the x-variates are in ascending order prior to 

plotting. This may be necessary to ensure the correct appearance of the plotted line, for 

example a fitted regression line, regardless of the order in which data are recorded or 

stored.  

For line plots, by default symbols aren’t displayed. However, checking Symbols will 

activate the fields in the Symbols pane, to plot symbols in the style, size and colour 

specified. Also activated is the Labels pane. If selected, this allows points to be labelled 

within the graph. The attributes of the labels can be specified in the Label Font, Size and 

Position Options menu launched by clicking on Font, size and position… (For more 

information on this menu, refer to the help documentation accessible by clicking on the 

help icon, .) To illustrate, symbols (blue unfilled circles) labelled by Month are added 

to Figure 2.37 using the settings shown in Figure 2.38. The resulting graph is shown in 

Figure 2.39. 

 

 
Figure 2.38: Adding symbols with Month labels to Figure 2.37. 
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Figure 2.39: Addition of symbols, labelled by Month, to Figure 2.37 using the settings shown in Figure 2.38.  

 

Rather than editing each series listed in the Graph: field separately, multiple series can 

be edited at once by clicking on the Edit attributes as a list… button. This opens a Graphics 

Line and Symbol attributes spreadsheet, enabling you to edit the line and symbol attributes 

of all series simultaneously. To demonstrate, we’ll open the Graphics Line and Symbol 

attributes spreadsheet associated with Figure 2.31, a plot of Mean_Temperature against 

Month with separate series for each Year. (In the Data tab set the Y variate: to 

Mean_Temperature, the X variate: to Month, and the Groups: field to Year.) The 

Graphics Line and Symbol attributes spreadsheet for this graph comprises 15 rows, one for 

each series (Figure 2.40).  

 
Figure 2.40: Graphics Line and Symbol attributes spreadsheet populated with the settings of the 15 series in Figure 2.31. 
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The settings for each series are displayed within the rows of the Graphics Line and 

Symbol attributes spreadsheet. You can edit these by typing directly into the cell, or (where 

relevant) by launching a dialog. For example, the Line style column specifies the line 

styles used when plotting each series. 

The style is shown in the icon on the 

right of the cell. A new line style can 

be selected by clicking this icon or by 

double-clicking the cell. This will 

open a dialog where you can select a 

line style from a list (see Figure 2.41). 

Alternatively, line styles can be 

specified by typing the first few letters 

of the word that uniquely identifies 

the style or by using numerical values 

representing a line style in the Genstat 

command language. (For more 

information, refer to the help, .) 

Should you wish to impose the same change to all cells within a column, select Fill all 

cells within a column with changes prior to making the change. For example, to draw each 

series as a dashed line, select Fill all cells within a column with changes before changing the 

line style to Dash in one of the cells in the Line style column. This will populate the change 

down the entire column. 

Copying and pasting in the Graphics Line and Symbol attributes spreadsheet behaves as 

for any other Genstat spreadsheets. For example, if you have set the Line colour column 

and you want the symbols to be the same colour, you could click on the Line colour 

heading to select that column, press Ctrl+C to copy the colours to the clipboard, then click 

on the Symbol colour heading and press Ctrl+V to paste them into the column.  

In the bottom left-hand corner of the Graphics Line and Symbol attributes spreadsheet are 

five action buttons, plus the help icon. 

• OK saves the changes and closes the spreadsheet.  

• Cancel closes the spreadsheet without saving the changes.  

• Copy copies the selected spreadsheet cells to the clipboard.  

• Paste pastes the contents of the clipboard into the spreadsheet. 

• Clear key clears the contents in the Key description column. 

 

Figure 2.41: Line style dialog. 



2 Genstat Graphics menu 

66 

 

The three Apply to all plots… buttons (located on the Lines and Symbols tab, see Figure 

2.35) may also be used to simultaneously make changes to multiple series. These buttons 

launch a menu in which you can specify which Lines/Symbols/Labels attributes of the 

current series (i.e. that selected in the Graph: field) are applied to all series. For example, 

to draw each series as a dashed line, we could set the Line style: field to Dash for the first 

series (Plot 1 – Group 1) then click the Apply to all plots… button in the Line styles pane. 

This will launch the Apply attributes to all plots menu, where we select Line style to apply 

the dashed line style to all series (see Figure 2.42).  

 

Figure 2.42: Using the Apply attributes to all plots menu to set the line style for all series to that defined by Plot 1 – 

Group 1 (i.e. the series currently selected in the Graph: field). 

 

Note: The Apply to all plots… button within the Symbols pane launches an Apply attributes 

to all plots menu with fields specific to symbol attributes. Likewise, the Apply to all plots… 

button within the Labels pane launches an Apply attributes to all plots menu with fields 

specific to label attributes. 

 

 X-Axis and Y-Axis tabs 

The X-Axis and Y-Axis tabs allow you to control the appearance of the line plot’s x- and y-

axis, respectively. These tabs are largely the same as those previously described for the 

Bar Chart menu (Refer to Section 2.1.4). However, unlike the Bar Chart menu, the X-Axis 

tab for 2D line plots contains the same functionality as the Y-Axis tab. In addition, the X-

Axis and Y-Axis tabs offer the:  
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• Equal scaling option. When selected the x- and y-axes are scaled identically. 

• Transform axis: dropdown menu. This allows you to select a transformation to scale 

the axis. The tick marks are still defined and labelled according to the original scale, 

but their physical positions on the graph are transformed. For example, if you selected 

Log (base 10), the physical distance between 1 and 10 would be the same as the 

distance between 10 and 100.  

 

 Frame tab 

The Frame tab sets the attributes of the frame that the line plot is displayed in. This tab is 

the same as that previously described for the Bar Chart menu. Refer to Section 2.1.5.  

 

 2D scatter plots 

The menu used for creating 2D scatter plots is the same as that described for 2D line plots. 

However, by default the data points are plotted using symbols without connecting lines 

(for example, Figure 1.10).  

 

2.3 Case study: 3D scatter plot 

 

A 3D scatter plot can be used to visualize the relationship between three continuous 

variables. The data points are plotted on three axes (x, y, z): typically the predictor 

variables are plotted on the x- and y-axes and the response variable on the z-axis. 3D 

scatter plots with either one or more X, Y and/or Z variables can be plotted using the 

Graphics | 3D Scatter Plot… menu. In the following subsections, we’ll first illustrate the use 

of the 3D Scatter Plot menu and then we’ll demonstrate Editor mode of the Graphics Viewer, 

which looks slightly different for 3D graphs than for 2D graphs.   

Throughout this section, the 

classic Fisher’s iris data set is used 

for illustration. The data consists of 

measurements of sepal lengths and 

widths (Sepal_Length, 

Sepal_Width), and petal lengths 

and widths (Petal_Length, 

Petal_Width) from iris plants 

belonging to three different species 

(factor Species). The data are 

Figure 2.43: Segment of Fisher’s iris data set, Iris.gsh. 
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available in the Genstat spreadsheet Iris.gsh (Figure 2.43).  

 Menu 

The 3D Scatter Plot menu is very similar to the 2D line plot menu, previously described in 

Section 2.2, but with additional fields and options to accommodate the third axis.  

The 3D Scatter Plot… menu opens in the Data tab, where the data for plotting is supplied 

(Figure 2.44). In the Type of plot: field you can specify how the data is formatted. You can 

select a combination of single, multiple or paired X, Y and Z variables, or triplet X, Y, Z 

variables. When an item in the Type of plot: field is selected, the length of the four data 

input fields (Y variates:, X variates:, Z variates: and Groups:) will change accordingly. The 

Available data: field lists all the available data structures appropriate to the current input 

field. The contents will change as you move from one field to the next.  

Figure 2.44 gives the Data tab menu settings used to create a three-dimensional scatter 

plot of petal length, petal width and sepal length, in which the plotted points are coloured 

by iris species.  

 
Figure 2.44: Data tab of the 3D Scatter Plot menu. Field settings for creating a three-dimensional scatter plot of the 

petal length, petal width and sepal length data, where the data points are coloured by iris species. 

 

After selecting the data for plotting you can draw the graph by clicking on the Run 

button. Alternatively, additional options and axis settings can be set by clicking on the 

Options, Lines and Symbols, Key, X-Axis, Y-Axis, Z-Axis and Frame tabs. 

In Figure 2.45 the Options tab is shown. It contains a Viewpoint pane, where you can 

specify the position of the viewpoint (in terms of rotation, elevation and distance), and 

thus the orientation of the three-dimensional graph. Rotation and elevation are specified 

mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/WizardOptions2DGraph.htm
mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/WizardLineandSymbols.htm
mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/WizardAxisOptions.htm
mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/WizardAxisOptions.htm
mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/WizardAxisOptions.htm
mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/graphics/WizardFrameOptions.htm
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in degrees, and the distance in the same units as the y-axis. Altering the rotation value in 

the Rotation about horizontal plane: field will change the azimuth, in effect, rotating the plot 

in the horizontal plane about the z-axis. The setting of the Distance from the centre of grid: 

field determines the position of the viewpoint in the horizontal plane (by default, the 

distance is set to 25 times the number of y points in the grid). The elevation of the 

viewpoint can be altered in the Elevation relative to surface: field. In general the default 

Viewpoint pane settings, chosen to produce a reasonable display in most situations, will 

suffice. We’ll retain the viewpoint defaults, and in the Graph title: field enter a title, 

Fisher's Iris Data, for our graph. 

 
Figure 2.45: Options tab of the 3D Scatter Plot menu. 

 

The Lines and Symbols tab allows you to control the appearance of the plotted data 

points (refer to Section 2.2.4). By default, the data is plotted using the sphere symbol and 

will be coloured by group if a factor has been supplied in the Groups: field on the Data 

tab.  

The Key tab controls the display and contents of the key (refer to Section 2.2.2). The 

X-Axis, Y-Axis and Z-Axis tabs allow you to control the appearance of the plot’s x-, y- and 

z-axis, respectively (refer to Section 2.1.4). The Frame tab sets the attributes of the frame 

that the plot is displayed in (refer to Section 2.1.5). We’ll retain the default settings. 

Click Run to draw the three-dimensional scatter plot shown in Figure 2.46.  
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Figure 2.46: Three-dimensional scatter plot of the Iris data, coloured by species. 

 

 Graphics Viewer 

To accommodate the extra dimension, Editor mode of the Graphics Viewer is different for 

three-dimensional graphs than for two-dimensional graphs. Now, instead of moving the 

graph horizontally and vertically, the graph can be rotated about the x- and y-axes using 

the RotX and RotY rollers located in the lower left-hand corner (Figure 2.47; also see 

Section 1.2.2). The View button ( ) enables you to rotate the plot in a direction other than 

about the x- or y-axis. To use this, click the View button and left mouse-click on the figure 

without releasing the button. Move the mouse to rotate the plot. Should you release the 

left mouse button whilst still moving the mouse, the plot will keep rotating. To stop the 

rotation, click with the left mouse button. The arrows in the lower right corner depict the 

orientation and direction of the x-, y- and z-axes.  
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Figure 2.47: Editor mode of the Graphics Viewer for a three-dimensional plot. 

 

The projection buttons ( ) can be used to project the graph into the y-z plane, 

the x-z plane and the x-y plane, respectively (Figure 2.48; also see Section 1.2.2) 

a) 

 

b)

 

c)

 

Figure 2.48: Using projection buttons to project the graph into the a) y-z plane, b) x-z plane and c) x-y plane. 
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2.4 Case study: trellis plot 

 

A trellis plot is a rectangular array of graphs, each representing a particular subset of the 

data. In Genstat, you can draw a trellis of histograms, boxplots or scatter plots. Trellis 

plots provide a powerful tool for displaying a variable, or the relationship between 

variables, compactly in one graphic whilst distinguishing between different subsets of the 

data.  

Trellis plots can be created using the Graphics | Trellis Plot… menu. In the following 

sections, we’ll describe the functionality of the Trellis Plot menu and demonstrate how to 

modify features of a trellis plot using Editor mode of the Graphics Viewer. Throughout this 

section the Sulphur.gsh data set, previously described in Section 1.1, is used for 

illustration. 

 

 Menu 

The Graphics | Trellis Plot… menu comprises four tabs: Data, Options, X-Axis and Y-Axis. 

The menu opens in the Data tab, where the type of plot is specified and the data for plotting 

is supplied (Figure 2.49). The Method for plotting: field offers three options: Scatter Plot, 

Histogram, Boxplot. Here you can set, the type of plot to appear in each frame of the trellis 

i.e. the graph drawn for each subset of data. Depending on the choice of plotting method 

the fields within the Data tab become available or are greyed out.  

 

 
Figure 2.49: Data tab for creating a trellis plot of Sulphur histograms conditional on Rain. 
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We’ll demonstrate all three types of trellis, but to begin with let’s investigate the 

distribution of sulphur measurements (Sulphur) conditional on whether or not it had 

rained (Rain). To do so, we set the Method for plotting: to Histogram. Two input fields are 

active: Y-values: and Groups for frames: (see Figure 2.49). In the Y-values: field we specify 

the data for plotting, Sulphur. Entering more than one variate into this field will create 

a trellis plot containing jointly graphed histograms for each variate (cf Figure 2.10). The 

factor defining how the data is to be subsetted into the separate plots (or frames) is 

specified in the Groups for frames: field. In this example, Rain.  

In the Options tab we can enter a title for the graph, specify the fonts used for the titles 

and labels, control the arrangement of the plots (frames) within the trellis (Panel Layout 

pane), choose to hide or display the key and, for histograms, specify the number of groups 

used to define the boundaries of the histogram bars (Figure 2.50). Let’s provide the trellis 

plot with the title Distribution of Sulphur in the Air by Rain. 

By default, the graphs in a trellis plot are arranged so that the area of the page used for 

plotting is maximized, with up to 64 graphs per page (8 by 8). However, the number of 

Columns: and Rows: in the rectangular array of graphs can be explicitly set. The graphs 

corresponding to the subsets of data are drawn left to right, ordered according to their 

ordinal level, starting by default in the top-left corner. The Position of first picture radio 

buttons allow you to change this setting so that first graph appears in the bottom-left 

corner. For the current example, the subsetting factor, Rain, has two levels (1=No, 

2=Yes). By default the two histograms will be arranged in a 2 row by 1 column array, 

with the No rain histogram appearing at the top. To plot the histograms side-by-side, set 

the number in Columns: to 2 and the number in Rows: to 1 (see Figure 2.50). 

Genstat selects the number of groups defining the boundaries of the histogram bars 

automatically. However, you can use the Number of groups in histogram: option to specify 

a particular number of groups. The groups are then defined by intervals of equal width, 

spanning the range of values of the variate. We’ll retain the default.  

 



2 Genstat Graphics menu 

74 

 

 
Figure 2.50: Options tab for creating a trellis plot of Sulphur histograms conditional on Rain, with plots arranged in 

a single row. 

 

In the X-Axis and Y-Axis tabs 

you can set attributes to control 

the appearance of the x- and y-

axis, respectively (Figure 

2.51). The fields, which are the 

same in both of these tabs, can 

be used to specify an overall 

axis title, to transform or 

reverse the axis, and to set the 

axis bounds and tick marks for 

all the graphs in the trellis plot. 

Let’s provide the x-axis with 

the title Sulphur, and the y-

axis with the title Frequency.  

 

 

 

Figure 2.51: X-Axis tab of the Trellis Plot menu. 
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Click the Run button to produce 

the trellis plot shown in Figure 2.52. 

A separate histogram has been 

drawn for each of the two levels of 

Rain. From the histograms we 

observe that higher sulphur 

measurements in the air are recorded 

on days without rain compared to 

days with rain, as to be expected. 

 

 

 

 

 

 

Boxplots provide an alternative tool for examining the distribution of a variate. To 

create a trellis plot of boxplots, on the Data tab select Boxplot in the Method for plotting: 

field. In addition to the Y-values: and Groups for frames: input fields, the Groups for within 

frames: field is active (Figure 2.53). Like the Groups for frames: field, this field can be used 

to specify a factor for subsetting the data. However, whereas the Groups for frames: field 

determines the subsetting of data into separate graphs, the Groups for within frames: field 

controls the subsetting of data within a graph (i.e. frame). That is, for boxplots a separate 

box is drawn for each level of the factor within the frame.  

If multiple y-variates are supplied in the Y-values: field then boxplots are drawn for 

each y-variate within each frame. However, if you supply multiple y-variates you cannot 

then subset the data using the Groups for within frames: field. 

Using a boxplot trellis plot, let’s investigate the distribution of sulphur measurements 

(Sulphur) conditional on both rain (Rain) and wind direction (Winddir). In the Groups 

for frames: field enter Rain, to create separate graphs according to whether or not it rained. 

Within each graph, draw separate boxplots for each wind direction by entering Winddir 

into the Groups for within frames field (see Figure 2.53). As described above, the Options, 

X-Axis and Y-Axis tabs provide additional options for controlling the appearance of a trellis 

plot. On the Options tab we’ll enter a title for our graph, Distribution of Sulphur 

Figure 2.52: Trellis plot of sulphur measurement (Sulphur) 

histograms conditional on whether or not it had rained (Rain). 
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in the Air by Rain and Wind Direction. On the Y-Axis tab enter a y-axis title, 

Sulphur microg/m~^{3}. Click Run to create the trellis plot in Figure 2.54. 

 
Figure 2.53: Data tab for creating a trellis of Sulphur boxplots conditional on both Rain and Winddir. 

 

 
Figure 2.54: Trellis of sulphur measurement boxplots (Sulphur) conditional on both whether or not it had rained 

(Rain) and the wind direction (Winddir). 
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Trellis plots can also be used to explore the relationship between variables that are 

conditional on subsetting factors by setting the Method for plotting: field on the Data tab to 

Scatter Plot. This activates all input fields on the Data tab menu (see Figure 2.55). 

Genstat’s trellis accommodates both single and multiple y-variate scatter plots, 

enabling different series to be plotted within each graph. For each series, you can specify 

how the data points are to be drawn in the Scatter method: field. Using the dropdown list 

below the Scatter method: field, you can choose from Point, Line, Mean, Median or Spline. 

(You can change the Scatter method: field by double-clicking on the variate in this list and 

selecting a new method in the dropdown.) When either mean (or median) is selected, a 

line is drawn to connect the mean (or median) at each x-value. If spline is selected, then 

this will be drawn using 4 df.  

To examine the relationship between sulphur level and wind speed, separately for each 

wind direction and according to whether it had rained or not, create a trellis of scatter 

plots using the Data tab settings given in Figure 2.55. This draws separate Sulphur 

against Windsp scatter plots for each level of the factor Winddir, in which points are 

coloured according to the level of the Rain factor (Figure 2.56). For most wind direction 

by rain subsets, it is unclear what the relationship between sulphur level and wind speed 

is, in part because the data at this level is sparse.  

 
Figure 2.55 Trellis plot of Sulphur against Windsp, subsetted by Winddir. Points within each scatter plot are coloured 

according to the level of Rain. 
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Figure 2.56: Trellis of scatter plots created using the Data tab settings in Figure 2.55. The data points are coloured 

according to whether it had rained (red) or not (black). 

 

Let’s simplify the subsetting to only Rain. Use the Data tab settings shown in Figure 

2.57 to create separate scatter plots of Sulphur against Windsp according to whether it 

had rained or not. We’ll enter Sulphur into the Y-values: field twice so that within each 

scatter plot we can request that both points and a spline are drawn. 

The Sulphur.gsh data set contains a missing Windsp value on row 31. This will 

affect how the spline is drawn – separate splines will be fitted to the data before (rows 1 

to 30) and after (rows 32 to 114) this missing value. To overcome this, before fitting the 

trellis plot we restrict the data to exclude row 31. Select row 31, and from the menu select 

Spread | Restrict/Filter | Selected Rows | Set as Exclude rows. Alternatively, Spread | 

Restrict/Filter | Exclude rows with Missing values to exclude any data row containing a 

missing value.  

The resulting trellis plot (having restricted the data to exclude row 31 before plotting) 

is shown in Figure 2.58. 
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Figure 2.57: Data tab settings for drawing scatter plots of Sulphur against Windsp conditional on Rain. Data is drawn 

as both points and splines. Row 31, with missing Windsp, was restricted out before plotting. 
 

 

Figure 2.58: Trellis of scatter plots created using the Data tab settings in Figure 2.57, having first restricted the data 

set to exclude the row with the missing Windsp value (row 31). 
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 Graphics Viewer 

For graphs containing two or more individual frames within a single display, such as 

trellis plots, the zoom and scroll controls in Viewer mode operate on the entire display, 

whilst the built-in Editor operates on the individual component plots. To edit an individual 

plot, double-click on the plot to launch it in Editor mode.  

To demonstrate, let’s modify Figure 2.58 so that the points in the second plot (Rain= 

yes) are coloured blue. Double-click on the second scatter plot to open it in Editor mode 

(see left pane of Figure 2.59). Using Editor mode, this scatter plot can now be modified 

in the standard way (refer to Section 1.2.2). Open the Graph Options tab and change the 

colour of the symbols in the first series to blue (see right pane of Figure 2.59). Click Apply, 

OK, then Save and Close to accept the change. 

 
Figure 2.59: Using Editor mode to change the colour of the points in the second scatter plot of Figure 2.58 to blue. 

 

2.5 Adding additional features to a graph 

 

The Graphics | Add to Graph menu options 

(Figure 2.60) provide functionality to add 

additional features to an existing graph open 

in the Graphics Viewer, such as text, horizontal 

or vertical reference lines, arrows and error 

bars. In the following subsections, we Figure 2.60: Accessing the Add to Graph menu options. 
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demonstrate how to add features to the figures created previously.  

Note, if multiple graphs are open in the Graphics Viewer, the features will be added to 

the most recently created graph. Also note, features cannot be added to a previously saved 

Genstat Meta File. 

 

 Adding text to an existing graph 

To add some text to an existing graph open in the Graphics Viewer, from the menu bar 

select Graphics | Add to Graph | Text…. This opens the Add Text to Plot menu shown in Figure 

2.61.  

 
Figure 2.61: Add Text to Plot menu. The menu is populated with the settings for adding text labels to Figure 2.58 that 

produce Figure 2.62. 

 

The Y position: and X position: fields specify the position to place the text. This can be 

a number, a list of numbers separated by spaces or commas, or the name of a variate or 

scalar structure existing in Genstat. Note, the length of the variates or lists of numbers 

supplied in the Y position: and X position: fields must be the same. The Window Number: 

dropdown list specifies which window to add the text to. If the option Relative to frame is 

selected, the Y and X positions are relative to the frame (whose maximum X and Y limits 

are provided in the Y upper: and X upper: fields). For example, if the X and Y upper 

boundaries are 1, then a value of 0.5 for the X and Y positions will position the text at the 
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centre of the graph. If a window number is used, the Y and X positions are relative to the 

data currently displayed in that graph. 

The text is supplied in the Text: field. If more than one line of one text is to be inserted, 

you can specify a list of strings separated by spaces (e.g. ‘a’ ‘b’ ‘c’) or commas (e.g. 

‘a’,‘b’,‘c’), or a text structure containing several lines. The number of lines of text 

must be the same as the number of X (and Y) positions. Strings that contain spaces or 

commas must be contained in single quotes (e.g. 'Group 1','Group 2'). If you need 

to use a quote in a quoted text, this should be doubled (e.g. 'tomorrow''s 

location'). Typesetting commands (see Section 4.2.1) can be used to add special 

characters and formatting to the text. This is aided by the Insert Symbol… and Format… 

buttons. The Insert Symbol… button opens a dialog box allowing you to add Greek and 

mathematical symbols or line breaks, into the Text: field. The Format… button opens a 

dialog box allowing you to format the text (bold, italic, subscript, superscript) entered in 

the Text: field. If only part of the text is selected, only that selection will be formatted. 

The Colour: dropdown list allows you to select the colour of the text, and apply 

transparency using the Transparency: dropdown list. The larger the value of Transparency:, 

the more the existing graph will show through the text; selecting None means nothing on 

the graph will show through the text. In the Size: field, set the amount by which the 

standard text size is to be multiplied (e.g. a value of 2 will produce text double the 

standard size). In the Angle: field you can set the orientation of the text. An angle of 0 

places the text horizontally, 90 places the text vertically and 180 flips the text so that it 

appears upside down. The Y-justification: dropdown list determines how the text is to be 

placed relative to the values supplied in the Y position: field (below Y position, centred 

around Y position, or below Y position). Similarly, the X-justification: dropdown list 

determines how the text is to be placed relative to the values supplied in the X position: 

field (left of X position, centred around X position, or right of X position).  

To demonstrate, let’s add red text labels, ‘spline (4 d.f.)’, to each spline in 

Figure 2.58. In the Graphics Viewer it is easy to determine the X and Y positions of a point 

relative to either the frame or plot coordinates. In Viewer mode, hover the mouse cursor 

over the location where you wish to add the text. The coordinates of this point are 

displayed in the bottom right-hand corner of the Viewer window. The first set corresponds 

to the Y and X positions relative to the data displayed in the graph, and the second set 

relative to the frame. Using the settings shown in Figure 2.61, labels are added to the 

trellis in Figure 2.58 giving Figure 2.62. 
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Figure 2.62: Figure 2.58 with text labels added. 

 

 Adding a reference line to an existing graph 

The Add Reference Line to Plot menu, shown in Figure 2.63, is accessed by selecting 

Graphics | Add to Graph | Reference line… on the menu bar. This menu allows you to add a 

horizontal or vertical reference line, as specified by the Orientation radio buttons, to an 

existing graph open in the Graphics Viewer. Note, reference lines cannot be added to all 

plots; e.g. trellis plots, 3D plots, stem and leaf plots or scatter plot matrices. The position 

the reference line is to be plotted is specified in the Position: field. If the Orientation is 

Horizontal, this represents the Y value for the line. Conversely, if the Orientation is Vertical, 

this represents the X value for the line. 

The Line pane offers fields for specifying the colour, style and thickness of the plotted 

reference line. The value supplied in the Thickness: field sets the amount to multiply the 

standard thickness of the plotted line by (where 1 represents the standard thickness).  

You can enter a label for the reference line in the Label: field. As with adding text to a 

graph (Section 2.5.1), you can use typesetting commands (see Section 4.2.1) to add 

special characters and formatting to the label. Use the Insert Symbol… and Format… 
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buttons to add special characters and font formatting. The colour, size and justification of 

the label can be controlled using the fields in the Label pane. 

The Window number: dropdown list defines the window you are adding the reference 

line to.  

To demonstrate, we’ll add a 

horizontal reference line to the scatter 

plot of Sulphur against Windsp (cf 

Figure 1.13) to indicate when sulphur 

in the air exceeds 20 microg/m3. We’ll 

plot the reference line using a thick, 

green, dashed-line, and add a green 

label above it: “Sulphur in the 

air > 20 microg/m3”. The Add 

Reference Line to Plot menu settings are 

given in Figure 2.63, and the graph in 

Figure 2.64. 

 
Figure 2.64: Horizontal reference line, at 20 microg/m3, added to a scatter plot of Sulphur against Windsp. 

 

Figure 2.63: Add Reference Line to Plot menu. The menu is 

populated with the settings that provide the reference line in 

Figure 2.64. 
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 Adding an arrow to an existing graph 

The Add Arrow to Plot menu, shown in Figure 2.65, is accessed by selecting Graphics | Add 

to Graph | Arrow… on the menu bar. This menu allows you to add arrows (or lines if the 

Start and End styles are set to None) to an existing graph open in the Graphics Viewer. 

 

Figure 2.65: Add Arrow to Plot menu. The menu is populated with the settings to draw the reference line in Figure 2.66. 

 

The Start and End position of the arrow is defined using the Y position: and X position: 

fields. These can be either entered directly as a number, a list of numbers separated by 

spaces or commas, or as the name of a variate or scalar structure existing in Genstat. The 

list or variate lengths must all be the same. The Number: dropdown list in the Window pane 

specifies which window to add the arrow to. If the option Relative to frame is selected, the 

Start and End Y and X positions are relative to the frame (whose maximum X and Y limits 

are provided in the Y upper: and X upper: fields). If a window number is used, the Start and 

End Y and X positions are relative to the data currently displayed in that graph. 

In the Symbols pane you can set the style at the start and end of the arrow. In the Type: 

dropdown list you can choose between an Open arrowhead, Filled arrowhead, Circle or None. 

You can change the size of the arrow head, relative to the standard size by altering the 

value in the Symbol size: field (e.g. a value 2 will result in arrowheads twice the standard 

size). The angle (in degrees) of the arrow head is controlled using the Arrow angle: field. 
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Setting the angle to a value greater than 180 (e.g. 315) reverses the direction of the 

arrowhead. The angle must be between 0 and 360. 

The Attributes pane specifies the style, thickness, colour and transparency of the 

arrow’s line. Using the Layer: field you can control whether the arrows overlie the data 

points, and how different sets of arrows overlay each other. A large value will force the 

arrows to overlie previous layers in the plot, and a value less than the existing layers will 

display arrows underneath these in the plot. For example, if we were to plot a set of arrows 

in layer 1 and another set in layer 2, the second set would overlie the first set. 

We will use the Add Arrow to Plot menu to add a reference line at 20 microg/m3 to the 

trellis of scatter plots given in Figure 2.62. Using the Graphics Viewer to establish the 

required start and end positions relative to the frame, green arrow lines (without arrow 

heads) are added to both scatter plots using the menu settings shown in Figure 2.65. The 

trellis plot, with arrows added, is shown in Figure 2.66. 

 

Figure 2.66: Figure 2.62 with arrows, representing a reference line at 20 microg/m3, added. 
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 Adding error bars to an existing graph 

To open the Add Error Bar to Plot menu, shown in Figure 2.67, select Graphics | Add to Graph 

| Error bar… on the menu bar. This menu allows you to add error bars to an existing graph 

open in the Graphics Viewer.  

 

Figure 2.67: Add Error Bar to Plot menu. The menu is populated with the settings used to draw an error bar on Figure 

2.31 to produce Figure 2.68. 

 

You must specify the length of the error bars to be plotted in the Length: field. (All 

other menu fields are optional). The Window number: field specifies which window the 

error bars are to be added to. 

The error bars can be drawn either vertically (the default) or horizontally, and this is 

set in the Orientation pane. You can control where the error bars are plotted using the Mid 

point Y: and X: fields. 

The appearance of the error bars (line colour, style and thickness) can be changed in 

the Line pane, and the width of the bar cap in the Bar cap width: field. 

In the Key description: field you can supply annotation on the error bars for the graph’s 

key. The key’s window is specified in the Key window number: field. You can also supply 

labels to plot alongside the error bars in the In plot label: field. The Label pane controls the 

colour, size and position of the labels. Symbols can be inserted into these two text fields 



2 Genstat Graphics menu 

88 

 

using the Insert Symbol… button, and the text formatting controlled using the Format… 

button. 

To illustrate, we’ll add error bars to Figure 2.31. The standard deviations of 

Mean_Temperature for each month, Jan to Dec, are 1.9, 1.8, 1.8, 1.4, 1.5, 1.2, 0.8, 1.5, 

1.3, 1.3, 1.6, 2.5, respectively. (Note: you can use the Stats | Summary Statistics | Summary 

Tables… menu to calculate and save these.) The average of these monthly standard 

deviations is 1.5. Let’s add an error bar to Figure 2.31 representing this average standard 

deviation and label it “Avg. S.D.”. To plot the average standard deviation in the top 

right of the graph, set the Length: field to 1.5, the Mid point Y: field to 27, the X: field 9, and 

the In plot label: field to Avg. S.D. (see Figure 2.67). In addition, we’ll make the error 

bar slightly bolder in appearance by setting the Thickness: field to 2. The plot, with 

labelled error bar, is shown in Figure 2.68. 

 

 

Figure 2.68: Figure 2.31 with an error bar added. The Add Error Bar to Plot menu settings used to produce this plot are 

shown in Figure 2.67.  

 

Instead of adding a single average standard deviation, let’s add to Figure 2.31 a series 

of error bars representing the standard deviation of mean temperature for each month. 

You can use the Undo ( ) button on the Graphics Viewer toolbar to remove the error bar 
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we added previously. To plot the standard deviations for each month at the top of the 

graph enter the monthly standard deviations, separated by commas, into the Length: field 

(i.e. 1.9,1.8,1.8,1.4,1.5,1.2,0.8,1.5,1.3,1.3,1.6,2.5), set the Mid point Y: field to 27, and set 

the X: field to 1…12 (see Figure 2.69). The resulting plot is shown in Figure 2.70. 

 

Figure 2.69: Add Error Bar to Plot menu. The menu is populated with the settings used to draw standard deviation bars 

on Figure 2.31 to produce Figure 2.70. 

 

 

Figure 2.70: Figure 2.31 with error bars representing the standard deviation of monthly mean temperature added.  
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3 Genstat commands for high-resolution graphics 

 

In the previous chapters we demonstrated the use of the menu interface to generate high-

resolution graphics. However, graphs can also be created using commands in the Genstat 

language. (Note, use of the menus will generate commands in the Input Log window that 

can be used to reproduce the graph at a later date, or edited to modify the graph. See 

Section 1.2.4.3.) The command language accommodates greater functionality than the 

menu interface enabling more advanced and complex graphics to be created. We begin 

this chapter with a brief guide on how to write and run commands in Genstat (Section 

3.1). To learn more about unlocking the full power of the Genstat command language, 

refer to An Introduction to the Genstat Command Language, which you can access from 

the menu bar by selecting Help | Genstat Guides. A list of Genstat’s graphical directives 

and procedures is provided in Appendix 5.1.  

In this chapter, we use the DGRAPH directive to introduce the generation of high-

resolution graphics via the command language. We illustrate the use of the FRAME 

directive for defining the position and appearance of the plotting window, the PEN 

directive for specifying the colours, fonts and symbols used to draw the plot, the XAXIS, 

YAXIS and ZAXIS directives for determining how the axes are drawn, and the DEVICE 

directive for selecting what graphical device is used to generate the output. We also show 

how the current settings of the graphics environment can be saved using DSAVE and later 

reloaded using DLOAD. 

Fisher’s iris data set is used for illustration throughout this chapter. The data, available 

in the Genstat spreadsheet Iris.gsh, consists of sepal lengths (Sepal_Length), sepal 

widths (Sepal_Width), petal lengths (Petal_Length) and petal widths 

(Petal_Width) of iris plants belonging to three different species (factor Species). 

Fisher’s iris data set can be loaded by running the command: 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

 

In this chapter you will learn how to: 

• execute commands in Genstat (Section 3.1) 

• produce a high-resolution scatter plot or line graph using the DGRAPH directive 

(Section 3.2) 

• specify the position and appearance of the plotting window using the FRAME directive 

(Section 3.3) 
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• specify the attributes of the graphical pens (such as colour, font and symbol) used for 

plotting using the PEN directive (Section 3.4) 

• specify how the x-, y- and z-axes are drawn using the XAXIS, YAXIS and ZAXIS 

directives, respectively (Section 3.5) 

• switch between graphical devices using the DEVICE directive (Section 3.6)  

• load and save a Graphics Environment using the directives DSAVE and DLOAD, 

respectively (Section 3.7)  
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3.1 Writing and running Genstat commands 

 

This section provides a basic introduction on how to write and run commands (or 

‘statements’) in Genstat. For a more detailed explanation refer to An Introduction to the 

Genstat Command Language, which you can access from the menu bar by selecting Help 

| Genstat Guides. 

Genstat offers a comprehensive system of menus providing all the standard (and many 

non-standard) analyses and graphs. The menus define analyses and graphs by writing 

programs in Genstat’s command language. These commands are then written to the Input 

Log, providing a complete audit trail. However, you can write your own programs to do 

something new or non-standard, to save time and/or to automate repetitive tasks. Genstat 

programs can be typed into any text window and then executed using the Run menu bar 

(or appropriate shortcut key). The output generated by the program will then appear in 

the Output window, and any high-resolution graphics in the Graphics Viewer. 

There are two types of commands in Genstat: directives are the basic commands of the 

Genstat language while procedures are extensions of the language, using programs 

written in the Genstat language itself. All Genstat commands have a common form of 

syntax: 
 

statement-name [ option-settings ] parameter-settings : 

where the statement-name gives the name of the directive or procedure that is to be used, 

the parameters specify parallel lists of arguments for the directive or procedure, and the 

options specify settings that apply to all the (parallel) sets of parameters. Parameter 

settings are separated from one another by semicolons (;). Option settings are enclosed 

in square brackets, and are also separated from one another by semicolons. (If no option 

settings are given, the square brackets can be omitted.) For example, the command below 

calls the DGRAPH directive, with parameters Y and X set to Sepal_Length and 

Sepal_Width, respectively, and the WINDOW option set to 1. 

DGRAPH [WINDOW=1] Y=Sepal_Length; X=Sepal_Width 

Nearly all options, and some parameters, have default values, chosen to be those 

required most often. Therefore, all of the options and parameters don’t always need to be 

set. Furthermore, the names of directives, procedures, options and parameters can be 

given in lower- or upper-case (or a mixture of both), and can always be abbreviated to 

four characters. (Names of options and parameters can often be abbreviated to fewer than 

four characters. See An Introduction to the Genstat Command Language to learn more.) 

For example, the command above could be written as: 
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DGRAPH [Wind=1] y=Sepal_Length; x=Sepal_Width 

Throughout this guide, each command is written on a separate line. However, if you 

wish to provide several commands on the same line, you must use the terminating colon 

(:). For example: 

PEN NUMBER=1; COLOUR='red': DGRAPH Y=Sepal_Length; X=Sepal_Width 

Conversely, to continue a command onto the next line, you must end the line with a 

continuation symbol \. For example: 

DGRAPH [KEYWINDOW=12; KEYDESCRIPTION='Iris species'] \ 

  Y=Sepal_Length; X=Sepal_Width; PEN=Species; \ 

  DESCRIPTION=!T(Setosa,Versicolour,Virginica) 

Notice that in the examples above different colours have been used to identify the 

various components of the command. For example, the names of the commands are in 

blue. This is syntax highlighting, which can be turned on or off by checking or unchecking 

Syntax Highlighting in the Tools menu bar. 

To write a program in Genstat, open a new text window. This is done by clicking File 

| New in the menu bar then selecting Text Window. Click OK to open a new text window. 

You can then write the commands in this text window using the usual keys for typing and 

deleting characters.  

The Run menu bar (or the appropriate shortcut 

key) is used to execute commands (see Figure 

3.1). For example, to run the entire program, 

select Submit Window, or alternatively you can use 

the shortcut key Ctrl+W. A single line of the 

program can be executed by placing the cursor on 

the line then selecting Run | Submit Line, or 

alternatively by using the shortcut key Ctrl+L. 

You can save the contents of a text window 

using Save or Save As in the File menu. Existing 

Genstat programs can be loaded into a new text 

window using the File | Open menu. 

Note: The Run and File menu always operate 

on the currently active window, so ensure that the 

desired window is active by clicking on the title 

bar before using these menus.  

Figure 3.1:The Run menu bar. 
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3.2 DGRAPH directive 

 

The DGRAPH directive draws high-resolution scatter plots and line graphs. The options 

and parameters controlling DGRAPH are briefly described in Table 3-1. Full 

documentation, containing a more detailed explanation, is provided within the Genstat 

Help System ( ) – also see in Genstat Reference Manual (Part 2 for Directives) 

accessible via Help | Reference Manual | Directives….  

 

Table 3-1: Options and parameters of DGRAPH. 

Options  

TITLE = text Provides a title for the graph. Default *. 

WINDOW = scalar 

Defines the window, within the plotting area, in which 

the graph is drawn. By default this is window 1. Note, 

the position and appearance of the plotting windows can 

be set using the FRAME directive (see Section 3.3). 

KEYWINDOW = scalar 

Specifies the window in which the key appears. By 

default this is window 2. Setting KEYWINDOW=0 

suppresses the key.  

SCREEN = string token 

Specifies whether to clear the screen before plotting 

(the default) or to continue plotting on the old screen 

(keep, resize). 

KEYDESCRIPTION = text Provides a title for the key. Default *. 

ENDACTION = string token 
Controls whether Genstat pauses (pause) or continues 

(continue) after completing the plot. 

HOTMENU = matrices 
Defines sets of "hot" components for the user to select 

as shown or hidden by a menu in the Graphics Viewer. 

(see Section 4.2.13). 

HOTCHOICE = string token 
Specifies whether one or several "hot" components 

can be displayed at a time. By default this is several. 

Parameters  

Y = identifiers Y coordinates of the points to be plotted. 

X = identifiers X coordinates of the points to be plotted. 

PEN = scalars, variates or 

factors 

Pen associated with each pair of Y and X. By default, 

pen 1 is used for the first pair, pen 2 for the second, and 

so on. Pen attributes, such as colour, font, symbols and 

labels, can be set using the PEN directive (see Section 

3.4). 

DESCRIPTION = texts Provides labels for the key. 
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YLOWER = identifiers 
Enables vertical bars to be included in the plot by setting 

the YLOWER and YUPPER parameters to variates 

defining the lower and upper values for the error bar to 

be drawn at each point. 
YUPPER = identifiers 

XLOWER = identifiers 
Enables horizontal bars to be included in the plot by 

setting the XLOWER and XUPPER parameters to variates 

defining the lower and upper values for the error bar to 

be drawn at each point. 
XUPPER = identifiers 

YBARPEN = scalars, 

variates or factors 

Specifies the pen to be used for the vertical bars, with 

the default pen set to -11. 

XBARPEN = scalars, 

variates or factors 

Specifies the pen to be used for the horizontal bars, with 

the default pen set to -11. 

LAYER = scalars Defines the “layer” on which the data are plotted.  

UNITNUMBERS = identifiers Specifies the unit numbers to be used when points are 

selected in the Graphics Viewer (see Section 1.2.1). By 

default the actual unit numbers of the values in the X 

and Y structures are used. 

DISPLAY = string tokens Specifies whether components of the graph (specified 

by pairs of Y and X) should be shown (show) or hidden 

(hide) in the initial graph displayed by the Graphics 

Viewer. Default show. 

HOTCOMPONENT = scalars Allows components of the graph (specified by pairs of 

Y and X settings) to be defined as "hot" components 

that can be shown or hidden through their association 

with "hot" points or using a menu in the Graphics 

Viewer. 

HOTDEFINITION = 

matrices 

Supplies a matrix with a row for each "hot" point, and a 

column for each type of "hot" component. The elements 

of the matrix specify the "hot" components to be 

associated with each "hot" point, using the numbers 

defined by the HOTCOMPONENT parameter.  
 

In the simplest use of DGRAPH you just need to specify the y and x coordinates of the 

points to be plotted using the Y and X parameters, respectively. For example, the command 

DGRAPH Y=Sepal_Length; X=Sepal_Width 

will plot the values of Sepal_Length against the values of Sepal_Width to generate 

the graph shown in Figure 3.2a (see Section 3.1 for more information on how to execute 

commands in Genstat). Multiple pairs of Y and X structures may also be supplied. These 

are processed in parallel. For example, the command 

DGRAPH Y=Sepal_Length,Petal_Length; X=Sepal_Width,Petal_Width 



3 Genstat commands for high-resolution graphics 

96 

 

generates a graph containing plots of Sepal_Length against Sepal_Width and 

Petal_Length against Petal_Width (see Figure 3.2b).  

a) 

 

b) 

 

Figure 3.2: High-resolution graphs generated using DGRAPH. a) Scatter plot with a single pair of Y and X structures, 
b) Scatter plot with two pairs of Y and X structures. 

 

Each pair of Y and X structures has an associated graphical pen, specified by the PEN 

parameter. By default pen 1 is used for the first pair, pen 2 for the second, and so on. The 

type of graph that is produced (scatter or line) and the appearance of the plotted data 

(colour, font, symbol-type, labels, etc.,) are determined by the pens. In Section 3.4 we 

demonstrate how to change the appearance of the graph by modifying the attributes of the 

pens (using the PEN directive). The default pens and pen attributes (under the Genstat 

Default Graphics Environment, see Section 1.3) were used to produce the plots in Figure 

3.2. Here, pen 1 plots black crosses and pen 2 plots red crosses. We can, for example, 

reproduce Figure 3.2a but with the data plotted as red crosses by setting the PEN parameter 

to 2, i.e.  

DGRAPH Y=Sepal_Length; X=Sepal_Width; PEN=2 

produces Figure 3.3a.  

The PEN parameter can also be set to a variate or factor, allowing different pens to be 

used to plot different subsets of the data. For example, the statement  
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DGRAPH Y=Sepal_Length; X=Sepal_Width; PEN=Species 

will plot the data corresponding to each level of Species using a different pen (as shown 

in Figure 3.3b).  
 

a) 

 

b) 

 

Figure 3.3: Using the PEN parameter to modify the appearance of the plotted data. a) PEN set to a scalar: data plotted as 

red crosses by setting PEN=2, b) PEN set to a factor: data for each iris species plotted using a different pen by setting 

PEN=Species. 

 

By default, a key is printed. The key contains a line of information for each pair of Y 

and X structures, written with the associated pen. The labels for the key are formed 

automatically, however you can provide your own using the DESCRIPTION parameter. 

You can also specify a title for the key using the KEYDESCRIPTION option. The window 

in which the key is plotted can be specified the KEYWINDOW option. By default the key is 

plotted in window 2, the lower 1/4 of the graphics frame. Setting KEYWINDOW=0 

suppresses the key. The following command modifies the default key of Figure 3.3b to 

plot it in window 12, display a title, and use supplied labels. The resulting graph is shown 

in Figure 3.4.  

DGRAPH [KEYWINDOW=12; KEYDESCRIPTION='Iris species'] \ 

  Y=Sepal_Length; X=Sepal_Width; PEN=Species; \ 

  DESCRIPTION=!T(Setosa,Versicolour,Virginica) 



3 Genstat commands for high-resolution graphics 

98 

 

 
Figure 3.4: Modification of the key in Figure 3.3b using the KEYWINDOW option, KEYDESCRIPTION option and 

DESCRIPTION parameter of DGRAPH. 

 

The TITLE option can be used to provide a title for the graph. Typesetting commands 

can be used to include Greek, mathematical or special symbols in the title and to control 

the text formatting. Further information on typesetting is provided in Section 4.2.1.  

The appearance, including titles, of the x- and y-axes are controlled by the XAXIS and 

YAXIS directives, respectively (refer to Section 3.5).  

Additional DGRAPH options and parameters enable the plotting window to be changed, 

error bars to be added, graphs to be superimposed, hot components to be defined and unit 

numbers to be supplied. Refer to Table 3-1 for more information. 

There are many aspects to producing a graph that we may wish to control. However, 

it is not feasible to allow all of these to be specified via the options or parameters of 

DGRAPH (or likewise, other graphical directives and procedures): the syntax would 

become very complicated, and you’d need to specify all the relevant settings every time 

DGRAPH was called. Instead Genstat provides additional directives that define the 

Graphics Environment. Each time DGRAPH is called, it accesses the relevant information 

in the Graphics Environment to determine how to construct the graph. In the following 

sections we examine four directives that define the Graphics Environment: 
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• FRAME: defines the position and appearance of the plotting window (Section 3.3) 

• PEN: defines the attributes of the graphical pens (Section 3.4) 

• XAXIS, YAXIS and ZAXIS: defines how the x-, y- and z-axes are drawn, respectively 

(Section 3.5) 

• DEVICE: specifies graphics device (Section 3.6). 

 

3.3 FRAME directive 

 

All graphical output is drawn in individual graphics windows. A window is a rectangular 

area of the screen. The position and size of the window is defined in terms of its lower 

and upper bounds in the vertical (y) and horizontal (x) directions using a data-independent 

coordinate system that ranges from 0.0 to 1.0 in each direction. Altogether there are 256 

windows, numbered from 1 up to 256. Windows are independent of one another, and on 

most devices they are allowed to overlap or contain other windows, enabling complex 

graphical displays to be generated.  

When producing a graphic you can either use the default windows defined by Genstat, 

or you can use the FRAME directive to define the position and appearance of your own 

windows. The options and parameters controlling FRAME are briefly described in Table 

3-2. For a more comprehensive description, refer to the Genstat Help ( ). A suite of 

example graphs demonstrating the various option and parameter settings of FRAME is 

provided in Section 3.3.1. 

 

Table 3-2: Options and parameters of FRAME. 

Options  

GRID= string tokens 

Specifies what grid lines are to be drawn (xy, xz, yx, 

yz, zx, zy). For example, the setting xy requests lines 

in the xy plane running from the x-axis (that is, parallel 

to the y-axis). Default *. 

BOXFRAME = string tokens 
Specifies whether or not a box is drawn around the 

entire frame (include, omit). Default omit. 

BACKGROUND = scalars or 

texts 

Specifies the colour to be used for the background of 

the whole frame. 

RESET = string token 
Specifies whether to reset the window definition to the 

default values (yes, no). Default no. 

Parameters  

WINDOW = scalars 
Numbers of the windows to be redefined. You can 

define up to 256 windows, numbered from 1 to 256. 
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YLOWER = scalars Lower y device coordinate for each window. 

YUPPER = scalars Upper y device coordinate for each window. 

XLOWER = scalars Lower x device coordinate for each window. 

XUPPER = scalars Upper x device coordinate for each window. 

YMLOWER = scalars Size of bottom margin (for x-axis labels). 

YMUPPER = scalars Size of upper margin (for overall title). 

XMLOWER = scalars Size of left-hand margin (for y-axis labels). 

XMUPPER = scalars Size of right-hand margin. 

BACKGROUND = scalars or 

texts 

Specifies the colour to be used for the background in 

each window. 

BOX = string tokens Specifies whether or not a box is drawn around the 

plotted graphic (include, omit). Default include. 

BOXSURFACE = string 

tokens 

For a surface plot, specifies whether a full box 

enclosing the whole graph, a bounded box enclosing 

just the surface, or no box is drawn. Default omit.  

BOXKEY = string tokens Specifies whether a full box, a bounded box, or no 

box be drawn around each key. Default omit.  

PENTITLE= scalars Pen to use to write the overall title. Default -5. 

PENKEY = scalars Pen to use for the key. Default -6. 

PENGRID = scalars Pen to use to draw the grid lines. Default -4. 

SCALING = string tokens Specifies how to scale the axis in each window 

(xyequal, xzequal, yzequal, xyzequal). For 

example, the xyequal setting ensures that the x and y 

axes are scaled identically, 

TPOSITION = string tokens Position of title (right, left, center, centre). 

Default centre. 

CINTERIOR = scalars or 

texts 

Specifies the colour to be used for the interior of each 

window. 

CFRAME = scalars or texts Specifies the colour to be used for the frame of each 

window. 

CTITLE = scalars or texts Specifies the colour to be used for the title bar of each 

window. 

AXES = identifiers or 

pointers 

Additional oblique axes, defined by the AXIS directive 

(see Section 4.2.7), to include in each window. 

SAVE = pointers Saves the current FRAME settings.  

 

When you use the FRAME directive, any aspects of the windows that you do not specify 

explicitly retain the values that they had immediately before the FRAME statement. 

Alternatively, specifying the option RESET=yes will reset all these aspects to the default 
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values. In the example below, we redefine the plotting window of the graphic in Figure 

3.4, window 1, such that: 

• the x and y grid lines are displayed, using the GRID option 

• the box enclosing the graphic is omitted, using the BOX parameter 

• interior of the plot is coloured light yellow, using the CINTERIOR parameter 

using the commands: 

FRAME [GRID=xy,yx] WINDOW=1; BOX=omit; CINTERIOR='lightyellow' 

DGRAPH [KEYWINDOW=12; KEYDESCRIPTION='Sepal Length v Width'] \ 

  Y=Sepal_Length; X=Sepal_Width; PEN=Species; \ 

  DESCRIPTION=!T(Setosa,Versicolour,Virginica) 

The resulting graph is shown in Figure 3.5.  

 

 

Figure 3.5: Graph plotted in redefined window 1, using the FRAME directive. 

 

The default settings of window 1 can be restored using the command:  

FRAME [RESET=yes] WINDOW=1 

Further examples, in which the FRAME directive is used to modify the appearance of 

the graph, are provided in the next section. 
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 Illustrative examples 

In this section we provide a series of examples to demonstrate the effect that different 

option and parameter settings of FRAME have on the graphical output.  

Recall that the WINDOW parameter specifies the window whose definition is to be 

altered. After changes have been made, the option RESET=yes may be used to revert all 

options and parameters back to their default values. If not, their current values are 

retained.  

Note, in the commands that follow, the XAXIS and YAXIS directives have been used 

to add titles to the axes. Refer to Section 3.5 for more information. 

 

3.3.1.1 Position and size of the window 

A graph (or key) is plotted into a rectangular window on the screen/device. The position 

and size of the window is defined using the parameters YLOWER, YUPPER, XLOWER and 

XUPPER (using normalized device coordinates). Below we demonstrate how to move the 

window used for the key (window 2) from its default position (Example 1) to a new 

location on the right of the graph (Example 2). 
 

JOB 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 1" 

DGRAPH [KEYWINDOW=2; \ 

       TITLE='Default key location (in window 2)'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 2" 

FRAME WINDOW=2; XLOWER=0.7; XUPPER=1; YLOWER=0.5; YUPPER=0.7 

DGRAPH [WINDOW=1; KEYWINDOW=2; \ 

       TITLE='FRAME 2; XLOWER=0.7; XUPPER=1; YLOWER=0.5; \ 

YUPPER=0.7'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

ENDJOB 
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Example 1 

 

Example 2 

 

 

3.3.1.2 Size of the margins 

In the following set of examples, Examples 3-5, we are adjusting the parameters that 

control the size of the margins for the x-axis labels (YMLOWER), the title (YMUPPER), the 

y-axis labels (XMLOWER) and the right-hand side (XUPPER).  

Notice how in Example 3 the size of the font used for the title is automatically 

decreased to accommodate the much longer title. 

 

JOB 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE= 'Petal Length' 

YAXIS WINDOW=1; TITLE= 'Sepal Length' 

 

"Example 3: default margins" 

FRAME WINDOW=1; \ 

      XMLOWER=0.12; XMUPPER=0.05; YMLOWER=0.10; YMUPPER=0.07         

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Default margins: XMLOWER=0.12; XMUPPER=0.05; \ 

YMLOWER=0.10; YMUPPER=0.07']\ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 4" 

FRAME WINDOW=1; \ 

      XMLOWER=0.08; XMUPPER=0.08; YMLOWER=0.08; YMUPPER=0.08           

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='FRAME 1; all margins 0.08'] \ 

       Y=Sepal_Length; X=Petal_Length 
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"Example 5" 

FRAME WINDOW=1; \ 

      XMLOWER=0; XMUPPER=0; YMLOWER=0; YMUPPER=0          

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='FRAME 1; all margins 0'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

ENDJOB 

 

Example 3 

 

Example 4 

 

Example 5 
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3.3.1.3 Colour of the window 

Examples 6 and 7 illustrate how to alter the colour of the plotting window using the 

parameter BACKGROUND, or the parameters CINTERIOR, CTITLE and CFRAME. The 

BACKGROUND parameter defines the colour of the entire plotting window, whereas 

CINTERIOR, CTITLE and CFRAME define specific aspects of it (overriding the setting of 

BACKGROUND). CINTERIOR defines the interior colour of the plot (i.e. where the data is 

plotted), CTITLE the colour of the title bar, and CFRAME the colour of the outer frame.  

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 6" 

FRAME WINDOW=1; BACKGROUND='Gold' 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='FRAME 1; BACKGROUND=''Gold'''] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 7" 

FRAME WINDOW=1; CINTERIOR='Aqua'; CTITLE='Orange'; CFRAME='Lime' 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='FRAME 1; CINTERIOR=''Aqua''; CTITLE=''Orange''; \ 

CFRAME=''Lime'''] \ 

       Y=Sepal_Length; X=Petal_Length 

 

ENDJOB 

Example 6

 

Example 7 
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3.3.1.4 Visibility of boxes surrounding frame, graph and key 

Examples 8-10 demonstrate the different settings of the BOXFRAME option, and the BOX 

and BOXKEY parameters of FRAME. These control the visibility of the boxes surrounding 

the frame, graph and key, respectively.  

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 8" 

FRAME [BOXFRAME=include] WINDOW=1; BOX=omit 

FRAME [RESET=yes] WINDOW=2; BOXKEY=omit 

DGRAPH [WINDOW=1; KEYWINDOW=2; \ 

       TITLE='FRAME [BOXFRAME=include] 1; BOX=omit'] \ 

       Y=Sepal_Length; X=Petal_Length; \ 

       DESCRIPTION='FRAME 2; BOXKEY=omit' 

 

"Example 9" 

FRAME [BOXFRAME=omit] WINDOW=1; BOX=include 

FRAME [RESET=yes] WINDOW=2; BOXKEY=full 

DGRAPH [WINDOW=1; KEYWINDOW=2; \ 

       TITLE='FRAME [BOXFRAME=omit] 1; BOX=include'] \ 

       Y=Sepal_Length; X=Petal_Length; \ 

       DESCRIPTION='FRAME 2; BOXKEY=full' 

 

"Example 10" 

FRAME [BOXFRAME=include] WINDOW=1; BOX=include 

FRAME [RESET=yes] WINDOW=2; BOXKEY=bounded 

DGRAPH [WINDOW=1; KEYWINDOW=2; \ 

       TITLE='FRAME [BOXFRAME=include] 1; BOX=include'] \ 

       Y=Sepal_Length; X=Petal_Length; \ 

       DESCRIPTION='FRAME 2; BOXKEY=bounded' 

 

ENDJOB 
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Example 8 

 

Example 9 

 

Example 10 

 

 

 

Note: the PENKEY parameter allows you to select the pen used to write the key. In the 

above examples the default pen, -6, has been used. Refer to Section 3.4 to learn about 

defining the attributes of a pen using the PEN directive. 
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3.3.1.5 Drawing grid lines 

Next we illustrate the settings of the GRID option that specifies which grid lines to draw 

(Examples 11-14). In the first example, Example 11, grid lines are drawn parallel to the 

y-axis (i.e. in the xy plane running from the x-axis) using the setting GRID=xy. In the 

second example (Example 12) grid lines are drawn parallel to the x-axis (i.e. in the xy 

plane running from the y-axis) using the setting GRID=yx. 

Note: The colour and style of the grid lines can be specified using the PENGRID 

parameter. In these examples the default pen, -4, is used. Refer to Section 3.4 to learn 

how to define the colour and style of a pen using the PEN directive. 

 

JOB 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 11" 

FRAME [GRID=xy] WINDOW=1 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='FRAME [GRID=xy]'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 12" 

FRAME [GRID=yx] WINDOW=1 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='FRAME [GRID=yx]'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 13" 

FRAME [GRID=xy,yx] WINDOW=1 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='FRAME [GRID=xy,yx]'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 14" 

FRAME [GRID=*] WINDOW=1 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='FRAME [GRID=*]'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

ENDJOB 
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Example 11 

 

Example 12 

 

Example 13 

 

Example 14 

 

 

3.3.1.6 Position of the title 

The TPOSITION parameter is used to control the position of the title. This is illustrated 

in Examples 15-17.  

The style, colour and size of the font used to display the title can be specified with the 

PENTITLE parameter. In the following examples the default pen, -5, is used. Refer to 

Section 3.4 to learn how to define the font of a pen using the PEN directive. 
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JOB 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 15" 

FRAME WINDOW=1; TPOSITION=left 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

        TITLE='FRAME 1; TPOSITION=left'] \ 

        Y=Sepal_Length; X=Petal_Length 

 

"Example 16" 

FRAME WINDOW=1; TPOSITION=right 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='FRAME 1; TPOSITION=right'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 17" 

FRAME  WINDOW=1; TPOSITION=center 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='FRAME 1; TPOSITION=center'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

ENDJOB 

 

Example 15 

 

Example 16 

 

Example 17 
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3.3.1.7 Scaling of the axes 

Finally, Example 18 illustrates the use of the SCALING parameter that specifies which 

axes are to be equally scaled. Compare Example 18 with the earlier examples in which 

the y- and x-axes are scaled differently. 

 
JOB 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 18" 

FRAME WINDOW=1; SCALING=xyequal 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='FRAME 1; SCALING=xyequal'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

ENDJOB 

 

Example 18 
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3.4 PEN directive 

 

All the elements of graphical output, such as symbols, lines, axes, titles, labels, annotation 

and filled polygons are drawn by pens, which have associated definitions covering 

various attributes, like colour and symbol type. The pen also indicates the plotting method 

(e.g. scatter, line, spline, etc.).  

Pens for plotting are available with numbers 1 up to 256, each with its own attribute 

settings. The default settings for each pen are designed so that they will differ in 

appearance, for example by using different colours or line styles, depending on the output 

device. Thus, if you specify several data structures to appear in the same plot, the different 

sets of points or lines will be clearly distinguished by their different pens.  

Negatively-numbered pens (-1 to -12) have specific roles in certain directives, and they 

cannot be used for any other purpose. The roles of the negatively-numbered pens are 

described in Table 3-3 below.  

 

Table 3-3: Roles of the negatively-numbered pens. 

Pen Role 

-1 default for PENTITLE parameter of XAXIS, YAXIS and ZAXIS 
-2 default for PENAXIS parameter of XAXIS, YAXIS and ZAXIS 
-3 default for PENLABEL parameter of XAXIS, YAXIS and ZAXIS 
-4 default for PENGRID parameter of FRAME 
-5 default for PENTITLE parameter of FRAME 
-6 default for PENKEY parameter of FRAME 

-7 
default for PENGRID option of DSHADE 
default for PENGRID option of DBITMAP 

-8 default for PENOUTLINE option of DHISTOGRAM 
-9 default for PENOUTLINE option of BARCHART 
-10 default for PENOUTLINE option of DPIE 

-11 
default for XBARPEN and YBARPEN parameter of DGRAPH 
default for PENERRORBARS parameter of BARCHART 

-12 pen for title in DSTART 
 

The PEN directive is used to change the attributes of the pens, modifying the 

appearance of the resulting graph. The options and parameters controlling PEN are briefly 

described in Table 3-4. A more comprehensive description is provided within the Genstat 

Help System ( ). In addition, a suite of example graphs demonstrating the various option 

and parameter settings of PEN is provided in Section 3.4.1. 
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Table 3-4: Options and parameters of PEN. 

Options  

RESET = string token 
Specifies whether to reset the pen definition to the 

default values (yes, no). Default no. 

BOXUNITS = string tokens 

Units to use when defining the sizes and positions of the 

text boxes (characters, distance). The default is to 

retain the existing setting. 

Parameters  

NUMBER = scalars 

Numbers associated with the pens to be redefined (in 

the range 1 to 256 or -1 to -12). Pens 1 to 256 are used 

for the information that is plotted in a graph (points, 

lines, and so on). Pens -1 to -12 have specific roles in 

some directives: e.g. pen -11 is the default pen used to 

draw the vertical and horizontal error bars in DGRAPH 

(see Table 3-1). The roles of negatively-numbered pens 

are listed in Table 3-3. 

COLOUR = scalars or texts 

Colour to use with each pen unless otherwise specified 

by the CSYMBOL, CLINE, CFILL or CAREA parameters. 

See Appendix 5.2 for the list of pre-defined colours. 

LINESTYLE = scalars or 

texts 

Style for line used by each pen when joining points. The 

exact appearance of the different line styles is device-

specific, but line style 1 should always produce a solid 

line. See Appendix 5.3 for the list of pre-defined line 

styles. 

METHOD = string tokens 

Method used for plotting (point, line, monotonic, 

closed, open, fill, spline, polygon). Default 

point. 

SYMBOLS = scalars, texts, 

pointers or matrices 

Defines the plotting symbol for each pen, by a text or 

scalar for a pre-defined symbol, a pointer for a user-

defined symbol, or a matrix to supply a bitmap. If you 

don’t want to plot symbols, set SYMBOL='none' or 

SYMBOL=0. See Appendix 5.3 for the list of pre-defined 

symbols. 

LABELS = texts or factors 
Provides labels that will be printed alongside the 

plotting symbols.  

ROTATION = scalars or 

variates 

Controls the angle (in degrees) at which to plot symbols 

and labels. 

JOIN = string tokens 
Controls the order in which points are to be joined by 

each pen (ascending, given). 
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BRUSH= scalars 

Not yet available in Genstat for Windows. Controls how 

areas are shaded when METHOD=fill, or when plotting 

histograms and pie charts. There are 16 available 

patterns indicated by the integers 1 to 16. In general, the 

higher the number, the denser the hatching. 

FONT = scalars or texts 
Font to use for any text written by each pen. This can be 

set to a text containing the name of a font family, or to 

a scalar containing an integer between 1 and 25. 

THICKNESS = scalars Controls the thickness of any lines drawn. 

SIZEMULTIPLIER = 

scalars or variates 

Multiplier used in the calculation of the size in which to 

draw symbols and labels by each pen unless otherwise 

specified by SMSYMBOL or SMLABEL. 

CSYMBOL = scalars or texts Defines the colour to use for drawing symbols. 

CLINE = scalars or texts Defines the colour to use for drawing lines. 

CFILL = scalars or texts Defines the colour to use when filling areas inside 

hollow symbols. 

CAREA = scalars or texts Defines the colour to use when filling areas inside 

polygons and bars of histograms. 

SMSYMBOL = scalars or 

variates 

Multiplier used in the calculation of the size in which to 

draw symbols by each pen. 

SMLABEL = scalars or 

variates 

Multiplier used in the calculation of the size in which to 

draw labels by each pen. 

DFSPLINE = scalars Number of degrees of freedom to use when 

METHOD=spline. 

YMISSING = string token How to treat missing y-values when METHOD=spline 

(break, interpolate). 

XMISSING = string token How to treat missing x-values when METHOD=spline 

(break, interpolate). 

YLPOSITION = string 

token 

Controls the y-direction position of the labels with 

respect to the points (above, centre, below, 

automatic). 

XLPOSITION = string 

token 

Controls the x-direction position of the labels with 

respect to the points (left, centre, below, 

automatic). 

YLSIZE = scalars or 

variates 

Defines the width in the y-direction of the text boxes 

into which the labels are plotted in. 

XLSIZE = scalars or 

variates 

Defines the width in the x-direction of the text boxes 

into which the labels are plotted in. 

YLOFFSET = scalars or 

variates 

Defines the amount the text boxes (into which the labels 

are plotted in) are offset in the y-direction. 
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XLOFFSET = scalars or 

variates 

Defines the amount the text boxes (into which the labels 

are plotted in) are offset in the x-direction. 

BARTHICKNESS = scalars Controls the thickness with which error bars are drawn. 

BARCAPWIDTH = scalars Controls the width of the cap drawn at the top and 

bottom of any error bars. 

DESCRIPTION = texts Description for points plotted by the pen, to be used by 

the Data Information tool in the Graphics Viewer (see 

Section 1.2). 

TSYMBOL = scalars Defines the transparency of symbols on a scale of 0 

(opaque) to 255 (completely transparent). 

TLINE = scalars Defines the transparency of lines. 

TFILL = scalars Defines the transparency to use when filling areas inside 

hollow symbols. 

TAREA = scalars Defines the transparency to use when filling areas inside 

polygons and bars of histograms. 

SAVE = pointers Saves the current pen settings.  

 

The type of graph that is produced is determined by the METHOD parameter. This can 

be point, to produce a point plot or scatterplot; line to join the points with straight 

lines; monotonic, open or closed to plot various types of curve through the points; 

spline to plot a smoothing spline fitted to the points; or fill to produce shaded 

polygons (see the example in Section 3.4.1.6). 

To illustrate the PEN directive, we’ll modify Figure 3.4 so that: 

• different plotting symbols denote the three iris species, using the SYMBOLS parameter 

• smoothing splines (with 2 degrees of freedom) for each iris species are added, using 

the parameters METHOD and DFSPLINE 

using the commands: 

PEN NUMBER=1,2,3; SYMBOLS=1,2,3; METHOD=spline; DFSPLINE=2 

DGRAPH [KEYWINDOW=12; KEYDESCRIPTION='Sepal Length v Width'] \ 

  Y=Sepal_Length; X=Sepal_Width; PEN=Species; \ 

  DESCRIPTION=!T(Setosa,Versicolour,Virginica) 

The resulting graph is shown in Figure 3.6. Note that default settings of pens 1, 2 and 3 

can be redefined using the command:  

PEN [RESET=yes] NUMBER=1,2,3 
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Figure 3.6: Graph plotted with redefined pens, 1,2,3, using the PEN directive. 

 

More example graphs, in which the PEN directive is used to modify the appearance of 

the graph, are given in the following section. 

 

 Illustrative examples 

In this section, a suite of examples is given to demonstrate the effect different option and 

parameter settings of PEN have on the graphical output.  

Recall that the NUMBER parameter specifies the pen whose attributes are to be altered. 

After changes have been made, the option RESET=yes may be used to revert all attributes 

back to their default values. Otherwise, any previous modifications to the parameter and 

option settings of PEN are retained throughout the Genstat job.  

Note, in the commands that follow, the XAXIS and YAXIS directives have been used 

to add axes titles. Refer to Section 3.5 for more information. 
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3.4.1.1 Changing the appearance of plotted data  

The first set of examples (Examples 1-7) showcases the changing appearance of the 

plotted data according to various settings of the SYMBOLS, SIZEMULTIPLIER and 

LABELS parameters. Note, these examples make use of the TXCONSTRUCT directive (to 

form a text structure), the CONCATENATE directive (to join text structures together) and 

the GETRGB procedure (to get the RGB values and names of the initial default colours of 

the pens). For more information on these commands, refer to the Genstat Help ( ). 

Additional parameters of PEN enable finer control over the appearance of specific 

elements in a plot. For example, SMSYMBOL, CAREA, CFILL, CSYMBOL, TSYMBOL and 

TFILL can be used to set the size, colour and transparency of plotted symbols. This is 

illustrated in subsequent sections. 

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 1" 

PEN NUMBER=1; SYMBOLS=4; SIZE=1 

DGRAPH [WINDOW=1; KEYWINDOW=0; TITLE='SYMBOLS=4; SIZE=1'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 2" 

PEN [RESET=yes] NUMBER=1; SYMBOLS='circleplus'; SIZE=2 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='SYMBOLS=''circleplus''; SIZE=2'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 3" 

PEN [RESET=yes] NUMBER=1; SYMBOLS=0; LABELS=Species 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

 TITLE='SYMBOLS=0; LABELS=Factor with labels'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 4" 

FACTOR [LEVELS=3] SpeciesLev 

CALCULATE SpeciesLev = Species 

PEN [RESET=yes] NUMBER=1; SYMBOLS=0; LABELS=SpeciesLev 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='SYMBOLS=0; LABELS=Factor with levels'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 5" 

TXCONSTRUCT [TEXT=tSpecies] Species 
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CONCATENATE tSpecies; WIDTH=4 

PEN [RESET=yes] NUMBER=1; SYMBOLS=0; LABELS=tSpecies 

DGRAPH [WINDOW=1; KEYWINDOW=0; TITLE='SYMBOLS=0; LABELS=text'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 6" 

GETRGB !(2...5); RGB=rgb 

MATRIX [ROWS=2; COLUMNS=2] mat; VALUES=rgb 

PEN [RESET=yes] NUMBER=1; SYMBOLS=mat; SIZE=2 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='SYMBOLS=matrix to supply a bitmap'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 7" 

VARIATE [VALUES= -1, 1,  1, -1, -1] square[1] 

VARIATE [VALUES= -1, -1, 1, 1, -1] square[2] 

VARIATE [VALUES= 3(-1, -.5 ... 1), (-1, 1, *)2] vert[1] 

VARIATE [VALUES= (-1, 1, *)5, (-1, -1, *), (1, 1, *)] vert[2] 

CALCULATE vert[1]$[3, 6...15] = 0/0 

VARIATE [VALUES= (-1, 1, *)5, (-1, -1, *), (1, 1, *)] hori[1] 

VARIATE [VALUES= 3(-1, -.5 ... 1), (-1, 1, *)2] hori[2] 

CALCULATE hori[1]$[3, 6...15] = 0/0 

VARIATE [VALUES= #vert[1], #hori[1]] verthori[1] 

VARIATE [VALUES= #vert[2], #hori[2]] verthori[2] 

PEN [RESET=y] NUMBER=1...3; SYMBOLS=square,vert,verthori; SIZE=2 

DGRAPH [WINDOW=1; TITLE='SYMBOLS=self made'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species; \ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

           

ENDJOB 

 

Example 1 

 

Example 2 
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Example 3 

 

Example 4 

 

Example 5 

 

Example 6 

 
Example 7 
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3.4.1.2 Colour of the pen 

The COLOUR, CSYMBOL, CLINE, CFILL and CAREA parameters is used to specify the 

colours used by the pen. Unless otherwise specified by CSYMBOL, CLINE, CFILL or 

CAREA, the COLOUR parameter defines the colour used for everything plotted by the pen. 

CSYMBOL explicitly defines the colour used for drawing symbols, CLINE the colour for 

lines, CFILL the colour for filling areas inside hollow symbols (setting CFILL='match' 

provides a simple way to create filled symbols), and CAREA the colour for filling areas 

inside polygons and bars of histograms.  

The first set of examples of this section, Examples 8-10, illustrates how to modify the 

colour of the plotted data using the COLOUR and CFILL parameters.  

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 8" 

PEN NUMBER=1...3; SYMBOLS=2; COLOUR='red','green','blue'; SIZE=3 

DGRAPH [WINDOW=1; TITLE='Specifying COLOUR with colour names'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species; \ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

 

"Example 9" 

PEN NUMBER=1...3; SYMBOLS=2; COLOUR='red','green','blue'; \ 

   CFILL='pink','lightgreen','lightblue'; SIZE=3 

DGRAPH [WINDOW=1; \ 

       TITLE='Specifying COLOUR and CFILL with colour names'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species; \ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

 

"Example 10" 

PEN NUMBER=1...3; SYMBOLS=2; \ 

    COLOUR=RGB(255,0,0; 0,128,0; 0,0,255); SIZE=3 

DGRAPH [WINDOW=1; TITLE='Specifying COLOUR with RGB values'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species; \ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

 

ENDJOB 

 

 

 
 



3.4 PEN directive 

121 

 

Example 8 

 

Example 9 

 

Example 10 

 

 

 

As illustrated above, colours in Genstat can be specified using either names of pre-defined 

colours or in terms of RGB values (see Appendix 5.2). In this second set of examples 

(Examples 11-14), we demonstrate how to modify the colours of a pen using RGB values. 

Here, we make use of the GETRGB procedure (to obtain RGB values of the default pen 

colours) and the RGB function (to obtain RGB values for pre-defined colours).  
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JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 11: Specifying colours by RGB values from GETRGB" 

"GETRGB gets the RGB values of the initial colours of the pens" 

GETRGB 2...4; RGB=pen2default,pen3default,pen4default 

PEN [RESET=yes] NUMBER=1...3; SYMBOLS=6; \ 

    COLOUR=pen2default,pen3default,pen4default; \ 

    CFILL=pen2default,pen3default,pen4default 

DGRAPH [WINDOW=1; TITLE='Specifying colours with RGB values \  

(from GETRGB)'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species; \ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

    

"Example 12: Specifying colours by RGB values calculated by RGB" 

"The RGB function gets the RGB values of named colours " 

CALCULATE cred,cgreen,cblue,cpink,cpalegreen,caqua = \ 

          RGB('red','green','blue','pink','palegreen','aqua') 

PEN [RESET=yes] NUMBER=1...3; SYMBOLS=6; \ 

    COLOUR=cred,cgreen,cblue; CFILL=cpink,cpalegreen,caqua 

DGRAPH [WINDOW=1; \ 

       TITLE='Specifying colours with RGB values (from RGB)'] \    

       Y=Sepal_Length; X=Petal_Length; PEN=Species; \ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

        

"Example 13: Specifying colours using the RGB values directly" 

PEN [RESET=yes] NUMBER=1...3; SYMBOLS=6; \ 

    COLOUR=16711680,3329330,255 "red,limegreen,blue" 

DGRAPH [WINDOW=1; \ 

       TITLE='Specifying colours with RGB values (directly)']\ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species; \ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

 

"Example 14: Specifying colours using red, green & blue values" 

PEN [RESET=yes] NUMBER=1...3; SYMBOLS=6; \ 

    COLOUR=RGB(255;2152;0); \ "gold" 

    CFILL=RGB(139,46,65; \ "darkred" 

               0,139,105; \ "seagreen" 

               0,87,225)    "royalblue" 

DGRAPH [WINDOW=1; TITLE='Specifying colours with red, blue & \  

green values (using RGB)'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species; \ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

        

ENDJOB   
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Example 11 

 

Example 12 

 

Example 13 

 

Example 14 

 

 

3.4.1.3 Font of the pen 

To select different fonts for text appearing as titles, axis annotation, plotting symbols and 

key information the FONT parameter can be set to an integer between 1 and 25, or to a 

text containing the name of a font family. The initial default for each pen is font 1, the 

default graphics font. When Genstat is first installed, the default graphics font is set 

automatically to Arial, however it can be changed in the Graphics tab of the Tools | 
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Options… menu, in the Fonts tab of the Options menu in the Graphics Viewer (Section 

1.2.5), or using the DFONT directive (see Section 4.2.2).  

A list of the 1…25 font assignments used by the PEN directive can be obtained by 

running the command: 

DHELP TOPIC=possible 

Examples 15 and 18 below illustrate how to change the fonts appearing in axis titles 

(pen -1, see Table 3-3), axis labels (pen -2), plot titles (pen -5) and in keys (pen -6). 

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 15"  

PEN NUMBER=-1,-3,-5,-6; FONT=18 

DGRAPH [WINDOW=1; TITLE='Font 6'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species;\ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

 

"Example 16"  

PEN [RESET=y] NUMBER=-1,-3,-5,-6; FONT=6,14,20,8 

DGRAPH [WINDOW=1; TITLE='Axis titles = font 6, \ 

Axis labels = font 14, Title = font 20, Key = font 8'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species;\ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

 

"Example 17"  

PEN [RESET=y] NUMBER=-1,-3,-5,-6; FONT='Times New Roman' 

DGRAPH [WINDOW=1; TITLE='Font = Times New Roman'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species;\ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

 

"Example 18"  

PEN [RESET=y] NUMBER=-1,-3,-5,-6; \ 

    FONT='Garamond','Courier New','Arial','Trebuchet MS'; 

DGRAPH [WINDOW=1; TITLE='Axis titles = Garamond, \ 

Axis labels = Courier New, Title = Arial, Key = Trebuchet MS'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species;\ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

 

ENDJOB 
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Example 15 

 

Example 16 

 

Example 17 

 

Example 18 

 
 

Note: you can view a list of the available Windows fonts in the Graphics tab of 

Genstat’s Tools | Options… menu, or in the Fonts tab of the Graphics Viewer’s Tools | 

Options… menu (see Section 1.2.5). 

 

3.4.1.4 Symbol type, colour, size and transparency 

In Sections 3.4.1.1 and 3.4.1.2, we demonstrated how to modify the colour and size of the 

pen used for plotting using the COLOUR and SIZEMULTIPLIER parameters, respectively. 

However, the colour used for drawing symbols and the colour used for filling hollow 

symbols can be explicitly set using the parameters CSYMBOL and CFILL, respectively 
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(overriding any setting of COLOUR). Similarly, the size of the plotted symbol can be 

explicitly set using the SMSYMBOL parameter (overriding any setting of 

SIZEMULTIPLIER). We can also set the transparency of the symbols and their fill colour 

using the parameters TSYMBOL and TFILL, respectively. Transparency values can range 

from 0 (opaque) to 255 (completely transparent). 

The following examples (Examples 19-22) showcase symbols of different type, 

colour, size and transparency. Recall that the type of symbol plotted is set using the 

SYMBOL parameter, and setting CFILL='match' provides a simple way to plot filled 

symbols. See Appendix 5.3 for the list of pre-defined symbols. 

 

JOB  

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 19"  

PEN NUMBER=1,2,3; SYMBOL=2,6,7; SMSYMBOL=2; \ 

    CSYMBOL='blue','orangered','slategray' 

DGRAPH [WINDOW=1; TITLE='Large hollow symbols'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species;\ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

 

"Example 20"  

PEN NUMBER=1,2,3; SYMBOL=2,6,7; SMSYMBOL=0.75; \ 

    CSYMBOL='blue','orangered','slategray'; CFILL='match' 

DGRAPH [WINDOW=1; TITLE='Small filled symbols'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species; \ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

 

"Example 21"  

PEN NUMBER=1,2,3; SYMBOL=2,6,7; SMSYMBOL=3; \ 

    CSYMBOL='blue','orangered','slategray'; CFILL='match'; \  

    TFILL=150 

DGRAPH [WINDOW=1; TITLE='Very large symbols with transparent \ 

 fill'] Y=Sepal_Length; X=Petal_Length; PEN=Species; \ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 

 

"Example 22" 

PEN NUMBER=1,2,3; SYMBOL=2,6,7; SMSYMBOL=3; \ 

    CSYMBOL='blue','orangered','slategray'; TSYMBOL=150; \ 

    CFILL='match'; TFILL=150 

DGRAPH [WINDOW=1; TITLE='Very large transparent symbols'] \ 

       Y=Sepal_Length; X=Petal_Length; PEN=Species; \ 

       DESCRIPTION=!t('Setosa','Versicolor','Virginica') 
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ENDJOB  

 

Example 19 

 

Example 20 

 

Example 21 

 

Example 22 

 

 

In the examples above, three series have been plotted by DGRAPH, defined by 

PEN=Species (i.e. one for each level of Species). The attributes of series 1 

(corresponding to the first ordinal value of Species, Setosa) are defined by pen 1, series 
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2 (corresponding to the second ordinal value of Species, Versicolor) by pen 2, and series 

3 (corresponding to the third ordinal value of Species, Virginica) by pen 3.  

The ROTATION parameter can be used to rotate the symbols (and the labels). See 

Section 3.4.1.7. 

 

3.4.1.5 Line style, colour, transparency and thickness  

The initial default for every pen, METHOD=point, results in points being plotted. 

However, a line plot can be requested by setting METHOD=line. (SYMBOLS=0 prevents 

symbols from being plotted.) 

As for symbols, the attributes of plotted lines can be explicitly set. The colour used for 

drawing lines is specified using the parameter CLINE, overriding any setting of COLOUR. 

In addition, the transparency of lines can be modified using the TLINE parameter (with 

values ranging from 0 (opaque) to 255 (completely transparent)), the thickness of lines 

using the THICKNESS parameter, and the style of the lines (e.g. solid, dotted or dashed 

line) using the LINESTYLE parameter. Note, the line style can be specified by either a 

name (see Appendix 5.3 for the list of pre-defined line styles) or a number in the range of 

1 to 10. The exact appearance of the different line styles is device-specific, but line style 

1 (solid) should always produce a solid line. 

Examples 23 and 24 demonstrate how to create a line graph and how to modify the 

appearance of its plotted lines.  

Note, in the examples that follow, first we calculate the means of the four 

measurements for each species. Then we construct two variates (Means and xSpecies) 

and a factor (Measurement) to enable these means to be plotted against species in 

DGRAPH. Furthermore, we use the MARKS and LABELS parameters of the XAXIS directive 

to label the x-axis by iris species (see Section 3.5 for more information). 

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

YAXIS WINDOW=1; TITLE='Mean' 

 

"Calculate mean values for each species" 

DESCRIBE [PRINT=*; SELECTION=mean; GROUPS=Species] \ 

         Petal_Length,Petal_Width,Sepal_Length,Sepal_Width; \ 

         SUMMARIES=M_Petal_Length,M_Petal_Width, \ 

         M_Sepal_Length,M_Sepal_Width 

"Store all means in a single variate" 

VARIATE [VALUES=#M_Petal_Length,#M_Petal_Width,\ 
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                #M_Sepal_Length,#M_Sepal_Width] Means 

"Set up a factor to identify the mean by measurement type" 

FACTOR [LABELS=!t('Petal length','Petal width',\ 

                  'Sepal length','Sepal width')] Measurement; \ 

        VALUES=!t(3('Petal length'),3('Petal width'),\ 

                  3('Sepal length'),3('Sepal width'))\         

"Set up variate to identify the mean by species  

(i.e. 1 = Setosa, 2 = Versicolor, 3 = Virginica)" 

VARIATE [VALUES=(1...3)4] xSpecies  

"Set up x-axis labels" 

XAXIS WINDOW=1; MARKS=!(1,2,3); \ 

      LABELS=!t('Setosa','Versicolor','Virginica') 

 

"Example 23" 

PEN NUMBER=1,2,3,4; METHOD=line; SYMBOLS=0; THICKNESS=10; \ 

    CLINE='teal','maroon','indigo','gold' 

DGRAPH [WINDOW=1; TITLE='Line plot with very thick lines'] \ 

       Y=Means; X=xSpecies; PEN=Measurement; \ 

       DESCRIPTION=!t('Petal Length','Petal Width', \ 

       'Sepal Length','Sepal Width') 

 

"Example 24" 

PEN NUMBER=1,2,3,4; THICKNESS=2; LINESTYLE=3 

DGRAPH [WINDOW=1; TITLE='Line plot with dashed lines'] \ 

       Y=Means; X=xSpecies; PEN=Measurement; \ 

       DESCRIPTION=!t('Petal Length','Petal Width', \ 

       'Sepal Length','Sepal Width') 

        

ENDJOB 
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Example 23 

 

Example 24 

 

 

3.4.1.6 Type of object plotted 

The METHOD parameter determines whether points, lines or filled polygons are plotted. 

Different types of line can be drawn; either straight lines (line and polygon) or smooth 

curves (monotonic, open, closed and spline). The line setting connects the points 

using straight lines (by default in ascending order of the x-values). The polygon setting 

draws lines to connect points in ascending order of x-values, and then draws a line 

connecting the first and last data points. The monotonic setting specifies that a smooth 

single-valued curve is drawn through the data points. The open and closed settings 

specify that a smooth curve, possibly multi-valued, is drawn through the data points (by 

default in ascending order of the x-values). With the closed setting, the first and last 

data points are also connected. The spline setting plots a smoothing spline fitted through 

the data points using the degrees of freedom set by the DFSPLINE parameter. (Additional 

parameters YMISSING and XMISSING determine how missing values are dealt with when 

fitting a spline. Refer to Genstat’s help documentation for more details.) The fill setting 

joins the data points by straight lines to produce one or more polygons. (Additional 

parameters BRUSH and CAREA control how the polygon(s) is filled. Refer to Genstat’s 

help documentation for more details. In Example 30, the CAREA parameter is used to fill 

the polygon lime green.) 
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Examples 25 to 32 demonstrate the different methods of plotting. To help visualise 

how the different lines are drawn, the points are labelled according to the order in which 

they are stored.  

 

JOB 

VARIATE [VALUES=3,2,1,3,4,5] y 

VARIATE [VALUES=1,3,5,6,4,2] x 

 

"Example 25" 

PEN NUMBER=1; METHOD=point; SYMBOLS=1; LABELS=!(1...6);  

DGRAPH [WINDOW=1; TITLE='METHOD=point'; KEYWINDOW=0] \ 

       Y=y; X=x; PEN=1 

         

"Example 26" 

PEN NUMBER=1; METHOD=line; CLINE='red'  

DGRAPH [WINDOW=1; TITLE='METHOD=line'; KEYWINDOW=0] \ 

       Y=y; X=x; PEN=1 

 

"Example 27" 

PEN NUMBER=1; METHOD=monotonic  

DGRAPH [WINDOW=1; TITLE='METHOD=monotonic'; KEYWINDOW=0] \ 

       Y=y; X=x; PEN=1 

         

"Example 28" 

PEN NUMBER=1; METHOD=open  

DGRAPH [WINDOW=1; TITLE='METHOD=open'; KEYWINDOW=0] \ 

       Y=y; X=x; PEN=1 

 

"Example 29" 

PEN NUMBER=1; METHOD=closed 

DGRAPH [WINDOW=1; TITLE='METHOD=closed'; KEYWINDOW=0] \ 

       Y=y; X=x; PEN=1 

 

"Example 30" 

PEN NUMBER=1; METHOD=fill; CAREA='limegreen' 

DGRAPH [WINDOW=1; TITLE='METHOD=fill; CAREA=''limegreen'''; \ 

       KEYWINDOW=0] Y=y; X=x; PEN=1  

 

"Example 31" 

PEN NUMBER=1; METHOD=spline; DFSPLINE=3 

DGRAPH [WINDOW=1; TITLE='METHOD=spline; DFSPLINE=3'; \ 

       KEYWINDOW=0] Y=y; X=x; PEN=1  

         

"Example 32" 

PEN NUMBER=1; METHOD=polygon 

DGRAPH [WINDOW=1; TITLE='METHOD=polygon'; KEYWINDOW=0] \ 

       Y=y; X=x; PEN=1  
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ENDJOB 

 

Example 25 

 

Example 26 

 

Example 27 

 

Example 28 
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Example 29 

 

Example 30 

 

Example 31 

 

Example 32 

 

In Examples 26 (METHOD=line), 28 (METHOD=open) and 29 (METHOD=closed) the 

points have been connected in ascending order of the x-values. However, we can specify 

that the points are connected in the order they are stored by setting the JOIN parameter 

to given. See Examples 33-35. (Note, for all other methods the JOIN parameter is 

ignored.) 

 

JOB 

VARIATE [VALUES=3,2,1,3,4,5] y 

VARIATE [VALUES=1,3,5,6,4,2] x 

         

"Example 33" 

PEN NUMBER=1; METHOD=line; CLINE='red'; LABELS=!(1...6); \ 

    JOIN=given 

DGRAPH [WINDOW=1; TITLE='METHOD=line; JOIN=given'; \ 
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       KEYWINDOW=0] Y=y; X=x; PEN=1 

  

"Example 34" 

PEN NUMBER=1; METHOD=open; JOIN=given  

DGRAPH [WINDOW=1; TITLE='METHOD=open; JOIN=given'; \ 

       KEYWINDOW=0] Y=y; X=x; PEN=1 

         

"Example 35" 

PEN NUMBER=1; METHOD=closed; JOIN=given  

DGRAPH [WINDOW=1; TITLE='METHOD=closed; JOIN=given'; \ 

       KEYWINDOW=0] Y=y; X=x; PEN=1 

                

ENDJOB 

 

Example 33 

 

Example 34 

 

Example 35 
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3.4.1.7 Label size, colour and position 

In Examples 3-5 we plotted labels in place of symbols. In Examples 36-39 of this section, 

we demonstrate the parameters of PEN for changing the size (SMLABEL), position 

(YLPOSITION, XLPOSITION) and orientation (ROTATION) of the labels.  

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

XAXIS WINDOW=1; TITLE='Petal Length' 

YAXIS WINDOW=1; TITLE='Sepal Length' 

 

"Example 36" 

PEN [RESET=yes] NUMBER=1; SYMBOLS=2; LABELS=Species; \   

    SMLABEL=0.5; YLPOSITION=centre; XLPOSITION=left 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Small label on left of symbol'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 37" 

PEN NUMBER=1; YLPOSITION=above; XLPOSITION=centre 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Small label above symbol'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 38" 

PEN NUMBER=1; ROTATION=90; YLPOSITION=automatic; \ 

    XLPOSITION=automatic; SYMBOLS=1 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Small label above symbol, rotated 90 degrees'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 39" 

PEN NUMBER=1; ROTATION=45; SMLABEL=0.8; SYMBOLS=1 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Larger label above symbol, rotated 45 degrees'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

ENDJOB 
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Example 36 

 

Example 37 

 

Example 38 

 

Example 39 

 

Note, the ROTATION parameter causes both the labels and symbols to rotate. Compare 

Example 38 with Example 39. 

The labels are plotted into text boxes. The widths of the text boxes in the x- and y-

directions are set using the YLSIZE and XLSIZE parameters, respectively (see Example 

40). If these are not set, the labels are plotted as a single line of characters. The amounts 

by which the boxes are offset from the data point in the x- and y-directions can be set 

using by the YLOFFSET and XLOFFSET parameters, respectively (see Example 41). If an 

offset is not specified the positions of the text boxes are defined automatically according 

to the position specified by the YLPOSITION and XLPOSITION parameters. 
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JOB 

VARIATE [VALUES=1...6] y 

VARIATE [VALUES=1...6] x 

FRAME WINDOW=1; BOX='omit' 

         

"Example 40" 

PEN NUMBER=1; LABELS=!t('Label 1','Label 2','Label 3', \ 

                       'Label 4','Label 5','Label 6'); \ 

    YLSIZE=!(1...6); XLSIZE=!(7...2); SMLABEL=1.5 

DGRAPH [WINDOW=1; TITLE='Altering YLSIZE and XLSIZE'; \ 

       KEYWINDOW=0] Y=y; X=x; PEN=1 

  

"Example 41" 

PEN NUMBER=1; YLOFFSET=!(1,2,3,-1,-2,-3); \ 

              XLOFFSET=!(-1,-2,-3,1,2,3) 

DGRAPH [WINDOW=1; TITLE='Altering YLOFFSET and XLOFFSET'; \ 

       KEYWINDOW=0] Y=y; X=x; PEN=1 

                

ENDJOB 

 

Example 40 

 

Example 41 

 

 

3.4.1.8 Appearance of error bars 

The thickness of the line used to draw error bars is set using the BARTHICKNESS 

parameter. Here we supply a multiplier which is used to adjust the standard thickness (as 

with THICKNESS). The width of the lines at the top and bottom of the error bars is set 

using the BARCAPWIDTH parameter, again by suppling a multiplier.  
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With DGRAPH (see Section 3.2), to plot vertical error bars we set the YLOWER and 

YUPPER parameters to variates defining the lower and upper values of the error bar for 

each point. Similarly, parameters XLOWER and XUPPER allow horizontal bars to be 

plotted. The YBARPEN and XBARPEN parameters set the pens used for drawing the vertical 

and horizontal bars, respectively.  

In Examples 42 and 43 we plot the mean petal length for each species together with 

their 95% confidence intervals. In the first example, we modify the settings of 

BARTHICKNESS and BARCAPWIDTH of the default pen for error bars, pen -11. In the 

second example, we use pen 1 to draw the error bars. 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

YAXIS WINDOW=1; TITLE='Mean Petal Length with 95% C.I.' 

GETATTRIBUTE [ATTRIBUTE=labels] Species; SAVE=SpeciesLabels 

XAXIS WINDOW=1; TITLE='Species'; LABELS=#SpeciesLabels; \ 

      MARKS=!(1...3) 

 

"Calculate the mean petal length for each species" 

DESCRIBE [PRINT=*; SELECTION=mean; GROUPS=Species] \ 

         Petal_Length; SUMMARIES=M_Petal_Length 

"Store means in a variate" 

VARIATE [VALUES=#M_Petal_Length] Mean_Petal_Length 

 

"Calculate the standard error of the mean for each species" 

DESCRIBE [PRINT=*; SELECTION=sem; GROUPS=Species] \ 

         Petal_Length; SUMMARIES=S_Petal_Length 

"Store standard errors in a variate" 

VARIATE [VALUES=#S_Petal_Length] SEM_Petal_Length 

 

"Example 42" 

PEN NUMBER=-11; BARTHICKNESS=3; BARCAPWIDTH=4 

PEN NUMBER=1; SYMBOLS=2; COLOUR='blue'; CFILL='blue' 

DGRAPH [WINDOW=1; TITLE='Thick error bars with wide caps'; \ 

       KEYWINDOW=0] Y=Mean_Petal_Length; X=!(1...3); PEN=1; \ 

       YUPPER=Mean_Petal_Length+1.96*SEM_Petal_Length; \ 

       YLOWER=Mean_Petal_Length-1.96*SEM_Petal_Length 

        

"Example 43" 

PEN NUMBER=1; BARTHICKNESS=2; BARCAPWIDTH=2; \ 

    SYMBOLS=2; CFILL='blue'; COLOUR='blue' 

DGRAPH [WINDOW=1; TITLE='Defining own pen for error bars'; \ 

       KEYWINDOW=0] Y=Mean_Petal_Length; X=!(1...3); PEN=1; \ 

       YUPPER=Mean_Petal_Length+1.96*SEM_Petal_Length; \ 

       YLOWER=Mean_Petal_Length-1.96*SEM_Petal_Length; \ 

       YBARPEN=1 
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ENDJOB 

 

Example 42 

 

Example 43 

 

In the code above, the GETATTRIBUTE directive was used as a convenient method for 

extracting the species names (i.e. labels of the SPECIES factor) with which the x-axis was 

labelled. 

 

3.5 XAXIS, YAXIS and ZAXIS directives 

 

The XAXIS, YAXIS and ZAXIS directives allow you to control various aspects of the axes 

within each window, for example the titles, spacing of tick marks and the position of 

labels. The options and parameters controlling these directives are briefly described in 

Table 3-5. For a more comprehensive description, refer to the Genstat Help ( ). In 

addition, a suite of examples is provided in Section 3.5.1 

 

Table 3-5: Options and parameters of XAXIS, YAXIS and ZAXIS. 

Options Directive  

RESET = string token  
Specifies whether to reset the axis definition 

to the default values (yes, no). Default no. 

Parameters   

WINDOW = scalars  
Specifies the window whose axis definition 

is to be altered. 



3 Genstat commands for high-resolution graphics 

140 

 

TITLE = texts  Title for the axis. 

TPOSITION = string 

tokens 
 

Controls whether the title is placed in the 

middle or at the end of the axis. 

TDIRECTION = string 

tokens 
 

Controls whether the title is written 

parallel or perpendicular to the axis. 

LOWER = scalars  Lower bound for axis. 

UPPER = scalars  Upper bound for axis. 

MARKS = scalars or 

variates 
 

Distance between each tick mark (scalar) or 

positions of the marks along the axis 

(variate). 

MPOSITION = string 

tokens 
 

Controls the positioning of the tick marks, 

which can be drawn on the inside or the 

outside of the axis, or can be drawn 

across the axis. Setting MPOSITION=* 

will switch off any tick marks. 

LABELS= texts or 

variates 
 

Supplies labels to print at each major tick 

mark. Setting LABELS=* will switch off any 

labels previously specified. 

LPOSITION = string 

tokens 
 

Position of the axis labels (inside, 

outside). Setting LPOSITION=* will 

switch off any labels. 

LDIRECTION = string 

tokens  

Direction of the axis labels (parallel, 

perpendicular). Setting LDIRECTION=* 

will switch off any labels. 

LROTATION = scalars 

or variates 

 

Specifies the direction of the labels, as a 

rotation in degrees from the horizontal (i.e. 

parallel) direction. If LROTATION is 

specified, any setting of LDIRECTION is 

ignored. 

NSUBTICKS = scalars 
 

Number of subticks per interval (ignored if 

MARKS is a variate). 

XORIGIN = scalars YAXIS, 

ZAXIS only 

Position on x-axis at which the axis is drawn. 

YORIGIN = scalars XAXIS, 

ZAXIS only 

Position on y-axis at which the axis is drawn. 

ZORIGIN = scalars XAXIS, 

YAXIS only 

Position on z-axis at which the axis is drawn. 

PENTITLE = scalars   Pen to use to write the axis title. 

PENLABELS = scalars   Pen to use to draw the axis. 
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ARROWHEAD = string 

tokens 
 

Specifies whether the axis should have an 

arrowhead (include, omit). 

ACTION = string 

tokens 
 

Specifies whether to display or hide the axis 

(display, hide). 

TRANSFORM = string 

token 

 

Transformed scale for the axis (identity, 

log, log10, logit, probit, cloglog, 

square, exp, exp10, ilogit, iprobit, 

icloglog, root). The tick marks are still 

defined and labelled according to the 

original scale, but their physical positions on 

the graph are transformed. Default 

identity. 

LINKED = scalars 
 

Linked axis whose definitions should be 

used for this axis in 2-dimensional graphs. 

MLOWER% = scalars 

 

Controls the size of the lower margin, 

expressed as a percentage of the range of 

data values. For example, for XAXIS, 

MLOWER% controls the size of margin 

(expressed as a percentage of the range of the 

x-values) that is provided between the lower 

value of the axis and the smallest x-value, if 

the lower axis value is not set explicitly by 
LOWER.  

MUPPER% = scalars 

 

Controls the size of the upper margin, 

expressed as a percentage of the range of 

data values. 

DECIMALS = scalars 

or variates 
 

Controls the number of decimal places to use 

for numbers printed at the marks. 

DREPRESENTATION = 

scalars or variates  

Controls the format to use for dates and 

times printed at the marks. (See the PRINT 

directive for details). 

VREPRESENTATION = 

scalars or variates  

Format to use for numbers printed at the 

marks (decimal, engineering, 

scientific). Default decimal. 

XOMETHOD = string 

tokens 

YAXIS, 

ZAXIS only 

Method to set the position of the origin on 

the x-axis if not set explicitly by XORIGIN 

(upper, lower, center, centre). 

YOMETHOD = string 

tokens 

XAXIS, 

ZAXIS only 

Method to set the position of the origin on 

the y-axis if not set explicitly by YORIGIN 

(upper, lower, center, centre). 

mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/server/PRINT.htm
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ZOMETHOD = string 

tokens 

XAXIS, 

YAXIS only 

Method to set the position of the origin on 

the z-axis if not set explicitly by ZORIGIN 

(upper, lower, center, centre). 

REVERSE = string 

tokens  

Specifies whether to reverse the axis 

direction to run from upper to lower (yes, 

no). Default no. 

SAVE = pointers 
 

Saves details of the current settings for the 

axis concerned 

 

Using the XAXIS and YAXIS directives, we’ll modify Figure 3.4 to  

• include axes titles (TITLE parameter) 

• adjust the lower and upper axes limits (LOWER and UPPER parameters) 

• place tick marks at 1mm intervals (MARKS parameter) 

• place subticks at 0.25mm intervals (NSUBTICKS parameter) 

using the commands: 

XAXIS WINDOW=1; Title='Sepal Width (mm)'; LOWER=1; UPPER=5; \ 

  MARKS=1; NSUBTICKS=3 

YAXIS WINDOW=1; Title='Sepal Length (mm)'; LOWER=4; UPPER=8; \ 

  MARKS=1; NSUBTICKS=3 

DGRAPH [KEYWINDOW=12; KEYDESCRIPTION='Iris species'] \ 

  Y=Sepal_Length; X=Sepal_Width; PEN=Species; \ 

  DESCRIPTION=!T(Setosa,Versicolour,Virginica) 

Note, as the graph produced by DGRAPH is to be plotted in window 1 (the default), the 

WINDOW parameter of both XAXIS and YAXIS is set to 1. The resulting graph is shown 

in Figure 3.6.  
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Figure 3.7: Graph plotted with redefined x- and y-axes attributes, using the XAXIS and YAXIS directives, respectively. 

 

The default x- and y-axes settings can be restored using the commands:  

XAXIS [RESET=yes] WINDOW=1 

YAXIS [RESET=yes] WINDOW=1 

The AXIS directive may also be used to specify how the x-, y- and z-axes are to be 

drawn, using similar options and parameters to those described above. In addition, the 

AXIS directive can be used to include additional axes which run in oblique directions. An 

example is provided in Section 4.2.7. 

More example graphs, in which the XAXIS and YAXIS directives are used to modify 

the appearance of the axes, are given in the following section. 

 

 Illustrative examples 

In this section we provide some examples to demonstrate the effect that different option 

and parameter settings of XAXIS and YAXIS have on the graphical output.  

Recall that the WINDOW parameter specifies the window whose axis definition is to be 

altered. After changes have been made, the option RESET=yes may be used to revert all 

options and parameters back to their default values.  
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3.5.1.1 Position of the axis title 

In the first three examples (Examples 1-3) we demonstrate how the position and 

orientation of the axis title can be changed using the TPOSITION and TDIRECTION 

parameters. To accommodate the axis titles, it may be necessary to alter the margins of 

the plotting window using the FRAME directive (as in Examples 2 and 3).  

Notice that by not specifying the option RESET=yes in the calls to XAXIS, YAXIS and 

FRAME, any modifications to their parameter and option settings are retained throughout 

the Genstat job.  

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

 

"Example 1" 

XAXIS WINDOW=1; TITLE='Petal Length'; TPOSITION=end 

YAXIS WINDOW=1; TITLE='Sepal Length'; TPOSITION=end 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Titles at end of axes’] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 2" 

"Margins altered to accommodate the axis titles" 

FRAME WINDOW=1; XMUPPER=0.20; YMUPPER=0.20; BOX=omit; \ 

      TPOSITION=right 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Window altered to accommodate axis titles'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 3" 

"Margins altered to accommodate the axis titles" 

FRAME WINDOW=1; YMUPPER=0.06; TPOSITION=right 

YAXIS WINDOW=1; TDIRECTION=perpendicular 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='y-axis title printed perpendicular to axis'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

ENDJOB 
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Example 1 

 

Example 2 

 

Example 3 

 

 

The style, colour and size of the font used to display the title can be modified using 

the PENTITLE parameter (examples are given in Section 3.5.1.7). In the above examples 

the default pen has been used.  

 

3.5.1.2 Positioning and labelling of tick marks 

In the next set of examples, Examples 4-10, we alter the appearance (including number, 

position and orientation) of the axis tick marks and labels using MARKS, NSUBTICKS, 

DECIMALS, LABELS, LPOSITION, MPOSITION, LDIRECTION and LROTATION. 
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JOB 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

 

"Example 4" 

XAXIS 1; TITLE='Petal Length'; MARKS=2; DECIMALS=1 

YAXIS 1; TITLE='Sepal Length'; MARKS=!(4.5,5,6,8); DECIMALS=1 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='y-axis MARKS=variate, DECIMALS=1; \ 

x-axis MARKS=scalar, DECIMALS=1'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 5" 

XAXIS 1; DECIMALS=0 

YAXIS WINDOW=1; MARKS=!(5,6,8); LABELS=!t(five,six,eight) 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='y-axis LABELS set'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 6" 

YAXIS WINDOW=1; MARKS=!(4,5,6,8); LDIRECTION=parallel; \ 

      LABELS=!t(four,five,six,eight)      

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='y-axis LDIRECTION=parallel'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 7" 

YAXIS WINDOW=1; LROTATION=45       

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='y-axis LROTATION=45'] \ 

       Y=Sepal_Length; X=Petal_Length 

               

"Example 8" 

XAXIS WINDOW=1; MARKS=2; MPOSITION=across 

YAXIS [RESET=yes] WINDOW=1; TITLE='Sepal Length'; \ 

      MARKS=!(4,5,6,8); MPOSITION=inside; \ 

      LABELS=!t(four,five,six,eight)     

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='y-axis MPOSITION=inside; \ 

x-axis MPOSITION=across'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 9" 

XAXIS WINDOW=1; LPOSITION=inside 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='x-axis MPOSITION=inside'] \ 

       Y=Sepal_Length; X=Petal_Length 
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"Example 10" 

XAXIS [RESET=yes] WINDOW=1; TITLE='Petal Length'; \ 

      MARKS=2; NSUBTICKS=1 

YAXIS [RESET=yes] WINDOW=1; TITLE='Sepal Length';\ 

      NSUBTICKS=4 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='y-axis NSUBTICKS=4; x-axis NSUBTICKS=1'] \ 

       Y=Sepal_Length; X=Petal_Length   

 

ENDJOB 

Example 4 

 

Example 5 

 

Example 6 

 

Example 7 
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Example 8 

 

Example 9 

 

Example 10 

 

 

The style, colour and size of the font used for the labels can be modified by the 

PENLABELS parameter (examples are given in Section 3.5.1.7). In the above examples, 

the default pen has been used.  

By default, numbers at the tick marks are printed in decimal form (as in the above 

examples). However, you can specify that these are printed in scientific or engineering 

format using the VREPRESENTATION parameter. Furthermore, if the numbers represent 

dates or times, you can specify their formats using the DREPRESENTATION parameter.  

 



3.5 XAXIS, YAXIS and ZAXIS directives 

149 

 

3.5.1.3 Axis bounds 

The lower and upper bounds for the axis can be set using the LOWER and UPPER 

parameters, respectively. Compare Examples 11 and 12 to Example 1, in which the 

default axis bounds have been used. 

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

 

"Example l1" 

XAXIS WINDOW=1; TITLE='Petal Length'; LOWER=0; UPPER=8 

YAXIS WINDOW=1; TITLE='Sepal Length'; LOWER=0; UPPER=8 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Bounds set at 0 (lower) and 8 (upper)'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 12" 

YAXIS WINDOW=1; LOWER=4  

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Lower bound of y-axis changed to 4'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

ENDJOB 

 

Example 11  

 

Example 12 
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If the lower and upper bounds haven’t already been explicitly set by the LOWER and 

UPPER parameters, they may instead be defined using the MLOWER% and MUPPER% 

parameters. The MLOWER% parameter, expressed as a percentage of the data range, 

controls the size of margin between the lower bound and the smallest data value. Similarly 

the MUPPER% parameter controls the size of the upper margin. 

In Example 13 below, the lower bound of the y-axis is defined using MLOWER%=25. 

As the data on the y-axis ranges from 4.3-7.9 (range = 3.6), this sets the lower bound to 

3.4 (i.e. 4.3 - 0.25 × 3.6). A smaller value for the lower bound (of 2.5) has been set for 

Example 14 by setting MLOWER%=50 (i.e. 4.3 - 0.5 × 3.6). 

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

 

"Example 13" 

XAXIS WINDOW=1; TITLE='Petal Length'; 

YAXIS WINDOW=1; TITLE='Sepal Length'; MLOWER%=25 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='y-axis lower bound set using MLOWER%=25'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 14" 

YAXIS WINDOW=1; MLOWER%=50;  

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='y-axis lower bound set using MLOWER%=50'] \ 

       Y=Sepal_Length; X=Petal_Length  

 

ENDJOB 

Example 13  

 

Example 14 
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3.5.1.4 Position of the origin 

In Examples 15-17 we move the origin (i.e. position on the plot where the axes intersect) 

using the XORIGIN parameter of YAXIS and the YORIGIN parameter of XAXIS. (Note, in 

Example 17, the UPPER parameter is used to set the upper bound of the axis to 

accommodate the position of the origin.) 

Alternatively, if YORIGIN has not been set, the YOMETHOD parameter of the XAXIS 

directive can be used to set the position of the origin at either the upper, the lower, or the 

centre value on the y-axis. Likewise, the XOMETHOD parameter of the YAXIS directive can 

be used to set the position of the origin on the x-axis. See Example 18. 

 

JOB 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

      

"Example 15" 

FRAME [RESET=yes] WINDOW=1; YMLOWER=0.08; YMUPPER=0.05; \ 

      XMLOWER=0.09; XMUPPER=0; BOX=omit 

YAXIS WINDOW=1; XORIGIN=0; TITLE='Sepal Length' 

XAXIS WINDOW=1; YORIGIN=0; TITLE='Petal Length' 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Origin in (0, 0)'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 16" 

YAXIS WINDOW=1; XORIGIN=4 

XAXIS WINDOW=1; YORIGIN=6 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Origin in (4, 6)'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 17" 

FRAME [RESET=yes] WINDOW=1; XMLOWER=0.05; XMUPPER=0.10; BOX=omit 

YAXIS [RESET=yes] WINDOW=1; XORIGIN=0; TITLE='Sepal Length'; \ 

      UPPER=9 

XAXIS [RESET=yes] WINDOW=1; YORIGIN=9; TITLE='Petal Length'; \ 

       MPOSITION=inside; LPOSITION=inside; UPPER=8 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Origin in (0, 9)'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 18" 

FRAME [RESET=yes] WINDOW=1; XMLOWER=0.05; XMUPPER=0.10; \ 

      YMLOWER=0.05; YMUPPER=0.20; BOX=omit 

YAXIS [RESET=yes] WINDOW=1; XOMETHOD=upper; TITLE='Sepal Length' 
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XAXIS [RESET=yes] WINDOW=1; YOMETHOD=centre; TITLE='Petal 

Length' 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='y-axis XOMETHOD=upper; x-axis YOMETHOD=centre'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

ENDJOB 

 

Example 15 

 

Example 16 

 

Example 17 

 

Example 18 
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3.5.1.5 Transformed scale 

Examples 19-22 showcase the changing appearance of the axis achieved from 

transforming the scale, using the TRANSFORM parameter. On the transformed scale, the 

tick marks are still defined and labelled according to the original scale, but their physical 

positions on the graph are transformed. To better observe the rescaling, we’ll use the 

MARKS parameter to space the tick marks 1 unit apart. 

An inverted scale, in which the axis is reversed to run from the upper bound to the 

lower bound, may be obtained by setting the REVERSE parameter to yes. This is 

demonstrated by Example 23. 

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

 

"Example 19" 

XAXIS WINDOW=1; TITLE='Petal Length'; MARKS=1 

YAXIS WINDOW=1; TITLE='Sepal Length'; MARKS=1 

DGRAPH [WINDOW=1; KEYWINDOW=0; TITLE='Identity scale'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 20" 

XAXIS WINDOW=1; TRANSFORM=log 

YAXIS WINDOW=1; TRANSFORM=log 

DGRAPH [WINDOW=1; KEYWINDOW=0; TITLE='Natural log scale'] \ 

       Y=Sepal_Length; X=Petal_Length 

      

"Example 21" 

XAXIS WINDOW=1; TRANSFORM=square 

YAXIS WINDOW=1; TRANSFORM=square 

DGRAPH [WINDOW=1; KEYWINDOW=0; TITLE='Square scale'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 22" 

XAXIS WINDOW=1; TRANSFORM=root 

YAXIS WINDOW=1; TRANSFORM=root 

DGRAPH [WINDOW=1; KEYWINDOW=0; TITLE='Square root scale'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 23" 

XAXIS WINDOW=1; TRANSFORM=*; REVERSE=yes 

YAXIS WINDOW=1; TRANSFORM=*; REVERSE=yes 

DGRAPH [WINDOW=1; KEYWINDOW=0; TITLE='Inverted scale'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

ENDJOB    
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Example 19 

 

Example 20 

 

Example 21 

 

Example 22 

 

Example 23 
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3.5.1.6 Hidden axis 

By default, the axis is displayed. However, you may wish to hide the axis, for example, 

when using the axis definition merely to control the positioning of the plot. The ACTION 

parameter controls whether the axis is displayed or hidden, as demonstrated by Example 

24. In Example 25 the box enclosing the plot is also omitted.  

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

 

"Example 24" 

XAXIS WINDOW=1; TITLE='Petal Length'; LOWER=0; UPPER=8; \ 

      ACTION=hide 

YAXIS WINDOW=1; TITLE='Sepal Length'; LOWER=0; UPPER=8; \ 

      ACTION=hide 

DGRAPH [WINDOW=1; KEYWINDOW=0; TITLE='Axes hidden'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

"Example 25" 

FRAME WINDOW=1; BOX=omit 

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Axes hidden and box omitted'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

ENDJOB 

Example 24 

 

Example 25 
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3.5.1.7 Colour of the axis 

Three parameters control the pens used to draw the axis: PENTITLE specifies the pen for 

the title (default -1), PENAXIS specifies the pen for drawing the axis (default -2) and 

PENLABEL specifies the pen for labelling (default -3). In Examples 26-28 we show how 

to use the PEN directive to modify the colours used when drawing the axes. 

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

 

"Example 26" 

XAXIS WINDOW=1; TITLE='Petal Length'; MARKS=1; \ 

      PENTITLE=2; PENAXIS=3; PENLABELS=4 

YAXIS WINDOW=1; TITLE='Sepal Length'; MARKS=1;\ 

      PENTITLE=5; PENAXIS=6; PENLABELS=7       

DGRAPH [WINDOW=1; KEYWINDOW=0; TITLE='Using pre-defined pens'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 27" 

"Titles" 

PEN NUMBER=-1; COLOUR='darkgreen'; FONT=4; SIZE=2 

"Axis" 

PEN NUMBER=-2; COLOUR='blue'; LINESTYLE=2 

"Labels" 

PEN NUMBER=-3; COLOUR='orangered'; FONT=5 

XAXIS [RESET=yes] WINDOW=1; TITLE='Petal Length'; MARKS=1 

YAXIS [RESET=yes] WINDOW=1; TITLE='Sepal Length'; MARKS=1     

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Changing attributes of the default pens'] \ 

       Y=Sepal_Length; X=Petal_Length 

        

"Example 28" 

"Pen for x-axis titles" 

PEN NUMBER=10; COLOUR='darkgreen'; FONT=8; SIZE=2 

"Pen for x-axis axis" 

PEN NUMBER=20; COLOUR='lawngreen'; THICKNESS=2 

"Pen for x-axis labels" 

PEN NUMBER=30; COLOUR='seagreen'; FONT=9; SIZE=1.5 

"Pen for y-axis titles" 

PEN NUMBER=40; COLOUR='darkviolet'; FONT=8; SIZE=2 

"Pen for y-axis axis" 

PEN NUMBER=50; COLOUR='indigo'; THICKNESS=2 

"Pen for y-axis labels" 

PEN NUMBER=60; COLOUR='magenta'; FONT=9; SIZE=1.5 

XAXIS WINDOW=1; TITLE='Petal Length'; MARKS=1; \ 

      PENTITLE=10; PENAXIS=20; PENLABELS=30 

YAXIS WINDOW=1; TITLE='Sepal Length'; MARKS=1; \ 
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      PENTITLE=40; PENAXIS=50; PENLABELS=60     

DGRAPH [WINDOW=1; KEYWINDOW=0; \ 

       TITLE='Defining own pens'] \ 

       Y=Sepal_Length; X=Petal_Length 

 

ENDJOB 

 

Example 26 

 

Example 27 

 

Example 28 
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3.6 DEVICE directive 

 

Genstat can generate high-resolution graphics in two forms: either on-screen, for 

interactive use, or outputted to a file in one of a number of standard formats suitable for 

plotters, printers or word processors, for later use outside Genstat. Each type of output, 

whether screen or file, is referred to as a device. Genstat has built-in interfaces to several 

different graphics devices. These vary according to the Genstat implementation, however 

details of the available devices can be obtained from the DHELP procedure by running the 

command 

DHELP TOPIC=possible  

 

The devices available in Genstat19 are: 

DEVICE: 

Device 1 ... 13  

* 1     Graphics Window 

 2      Windows Bitmap File (*.bmp) 

 3      Windows Default Printer 

 4      Portable Document Format (*.pdf) 

 5      Encapsulated PostScript File (*.eps) 

 6      Windows Enhanced Metafile (*.emf) 

 7      JPEG Files (*.jpg, *.jpeg) 

 8      TIFF Files (*.tif, *.tiff) 

 9      Portable Network Graphics Files (*.png) 

 10     Genstat Metafile (*.gmf) 

 11     Windows Bitmap File (*.bmp) 

 12     Windows Default Printer 

 13     Portable Document Format (*.pdf) 

* marks the current device 

 

The default device, selected automatically when you start Genstat, is device 1. 

However, you may switch between devices using the DEVICE directive. The parameters 

controlling DEVICE are briefly described in Table 3-6. (Note, there are no options.) A 

more comprehensive description is provided within the Genstat Help System ( ).  
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Table 3-6: Parameters of DEVICE. 

Parameters  

NUMBER = scalar Device number. 

ENDACTION = string token 
Controls the action taken by default at the end of each 

plot (pause, continue).  

ORIENTATION = string token 

Specifies landscape or portrait orientation of 

graphical output on PostScript and Interacter raster 

devices. Default portrait.  

PALETTE = string token 
Specifies how to represent colour (monotone, 

greyscale, grayscale, colour). 

SIZEPAGE = string token Size of page for each screen (A4, A3) for HPGL devices. 

RESOLUTION = scalar 
Specifies the height of the image for hard-copy output, 

in pixels.  

ACTION = string token 

Specifies how to create graphs for file types such as 

.emf, .jpg, .tif or .png. The setting synchronous 

creates the graph before executing another command, 

whereas the setting asynchronous allows subsequent 

commands to be executed whilst the graph is created. 

Default asynchronous. 

 

When selecting a file-based device you must open a file to receive the output, using 

the OPEN directive before any graphical output is generated. After the graphics are 

complete, you can close the file using the CLOSE directive. Note, when opening or closing 

files for graphical output the CHANNEL parameter of the OPEN and CLOSE statements must 

be set to the device NUMBER specified by the DEVICE statement. The parameters 

controlling the OPEN and CLOSE directives are briefly described in Table 3-7 and Table 

3-8, respectively. Refer to the Genstat Help ( ) for more information. 

To illustrate the use of the DEVICE, OPEN and CLOSE directives, we’ll output the 

graphic of Figure 3.4 to a pdf file (device 4) using the commands:  

OPEN NAME='PLOT.pdf'; CHANNEL=4; FILETYPE=graphics 

DEVICE NUMBER=4 

DGRAPH [KEYWINDOW=12; KEYDESCRIPTION='Iris species'] \ 

  Y=Sepal_Length; X=Sepal_Width; PEN=Species; \ 

  DESCRIPTION=!T(Setosa,Versicolour,Virginica) 

CLOSE CHANNEL=4; FILETYPE=graphics 

 

The file will be saved in your current working directory. 

 

mk:@MSITStore:C:/Program%20Files/Gen18Ed/Doc/genstat.chm::/html/server/OPEN.htm
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Table 3-7: Parameters of OPEN. 

Parameters  

NAME = texts Name of the file. 

CHANNEL = scalars 
Channel number used to refer to the file in other 

statements (e.g. DEVICE) 

FILETYPE = string tokens 

File type (input, output, unformatted, 

backingstore, procedurelibrary, graphics). 

Default input. 

WIDTH = scalars 
Maximum number of characters per line for input and 

output files. Default 80. 

INDENTATION = scalar 
Number of spaces to leave at the start of each line. 

Default 0. 

PAGE = scalars 
Number of lines per page in an output file. Set 

automatically, by default. 

ACCESS= string token 

Controls the way in which unformatted and 

backingstore files can be accessed (readonly, 

writeonly, both). Default both. 

STYLE = string token 
Style used to represent the information in an output 

file (plaintext, html, latex, rtf). Default plain. 

HTMLHEAD = texts 
Text structures containing custom content for the 

header of an HTML document. 

 

Table 3-8: Parameters of CLOSE. 

Parameters  

CHANNEL = scalars 
Channel number used to refer to the file in other 

statements (e.g. OPEN, DEVICE) 

FILETYPE = string tokens 

File type (input, output, unformatted, 

backingstore, procedurelibrary, graphics). 

Default input. 

DELETE = texts 
Whether to delete the file on closure (yes, no). Default 

no.  
 

3.7 Saving and loading a Graphics Environment 

 

The appearance of high-resolution graphics in Genstat is controlled by the Graphics 

Environment (see Section 1.3). The FRAME, PEN, XAXIS, YAXIS and ZAXIS directives 

described in this chapter allow you to modify the graphics environment to obtain control 

over the appearance of your graphical output. Once you have defined the Graphics 
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Environment, say for a particular type of plot, you may wish to save it for future use. The 

DSAVE directive allows you to save the current settings of the Graphics Environment to an 

external file. You can then use the DLOAD directive to read it back into Genstat at a later 

date, so that you can produce plots in the same style. (Note: Graphics Environments are 

saved in a special file format with extension .ggd, see Section 1.3.3). 

DSAVE has only two parameters (and no options): The FILENAME parameter gives the 

name of the file in which to save the current settings of the Graphics Environment. The 

optional DESCRIPTION parameter allows you to supply a text structure containing a one-

line description of the Graphics Environment. This is useful, for example, to note the 

particular type of publication the Graphics Environment was created for. 

DLOAD has only one unnamed parameter (and no options). This is used to supply the 

file from which to load the settings for the Graphics Environment. If this parameter is 

unset, Genstat restores the default Graphics Environment. 

In the example code below, we create a grayscale Graphics Environment. We save its 

settings to a .ggd file named “grayscale” (in our working directory). This environment 

can be loaded at a later date using the statement DLOAD 'grayscale.ggd'. 

 

JOB  

 

DLOAD "Set default environment" 

 

"Define the new environment" 

FRAME [RESET=yes; GRID=*] 1...32; BOX=include; BOXKEY=bounded; \ 

      BOXSURFACE=* 

PEN [RESET=yes] -1; \ "Axis Title Pen" 

    FONT=1; SIZE=1.6; COLOUR='black'             

PEN [RESET=yes] -2; \ "Axis Pen" 

    THICKNESS=1.6; LINESTYLE=1; COLOUR='black'   

PEN [RESET=yes] -3; \  "Axis Labels Pen" 

    FONT=1; SIZE=1.4; COLOUR='black'            

PEN [RESET=yes] -4; \ "Grid Pen" 

    THICKNESS=1; LINESTYLE=2; COLOUR='black'     

PEN [RESET=yes] -5; \ "Title Pen" 

    FONT=1; SIZE=2; COLOUR='black'               

PEN [RESET=yes] -6; \ "Key Pen" 

    FONT=1; SIZE=1; COLOUR='black'               

PEN [RESET=yes] -7; \ "DSHADE grid" 

    THICKNESS=1; LINESTYLE=1; COLOUR='black'     

PEN [RESET=yes] -8; \ "Histogram Outlines" 

    THICKNESS=1; LINESTYLE=1; COLOUR='black'     

PEN [RESET=yes] -9; \  "Barchart Outlines" 

    THICKNESS=1; LINESTYLE=1; COLOUR='black'    
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PEN [RESET=yes] -10; \ "Pie Outlines" 

    THICKNESS=1; LINESTYLE=1; COLOUR='black'     

PEN [RESET=yes] -11; \ "Error Bars" 

    COLOUR='black'; LINESTYLE=1; METHOD=line; SIZE=1  

VARIATE [NVAL=256] symbols; !((2,5,6,7,8,4,12,13,18,11,1,3,9,\ 

                               19,20,21,22)15,2) 

VARIATE [NVAL=256] linestyle; !((1...10)25,1...6) 

PEN [RESET=yes] 1...256; SYMBOL=#symbols; COLOUR='black'; \ 

    CSYMBOL='black'; \ 

    CFILL='black'; LINESTYLE=#linestyle; SIZE=1; THICKNESS=2 

 

"Save the environment" 

DSAVE 'grayscale.ggd'; DESCRIPTION='Grayscale graphics' 

 

ENDJOB 

 

3.8 Example 

 

Creating a pink heart (Figure 3.8a) using the fundamental Genstat directives, FRAME, 

XAXIS, YAXIS, PEN and DGRAPH.  

a) b)  

Figure 3.8: Plot of a pink heart (a) pierced with a red arrow (b). 

 

"Generate y and x coordinates to create a heart-shaped polygon" 

CALC twopi = 2*C('pi') 

CALC t = !(0,0.01...#twopi) 

CALC xheart = 16*sin(t)**3 

CALC yheart = 13*cos(t) - 5*cos(2*t) - 2*cos(3*t) - cos(4*t) 
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"Turn off usual axes and frame (window 3 = full screen)" 

XAXIS [RESET=yes] WINDOW=3; ACTION=hide 

YAXIS [RESET=yes] WINDOW=3; ACTION=hide 

FRAME [RESET=yes] WINDOW=3; BOX=omit  

 

"Turn off symbols and fill polygon with hot pink" 

PEN [RESET=yes] NUMBER=1; METHOD=fill; SYMBOL=0; JOIN=given; \ 

    CAREA='hotpink' 

DGRAPH [WINDOW=3; KEYWINDOW=0] X=xheart; Y=yheart 

Pierce the heart with a red arrow, diagonally through the centre, making use of the 

SCREEN option and LAYER parameter of DGRAPH. (Figure 3.8b). 

"Generate the coordinates of the arrow"  

CALC xarrow = !(0,15,15,14.1,*,14.7,15)  

CALC yarrow = !(0,15,15,14.7,*,14.1,15)  

"(arrow-head created by breaking the line with missing values)" 

 

CALC yline,xline = !(-15,0)  

"(line to heart centre)" 

 

"Add red arrow to existing plot" 

PEN [RESET=yes] NUMBER=2; METHOD=line; SYMBOL=0; JOIN=given; \ 

    COLOUR='red'; THICK=5 

DGRAPH [WINDOW=3; SCREEN=resize] PEN=2; LAYER=-1,2; \ 

  X=xarrow,xline; Y=yarrow,yline 

"(appropriate section of the arrow plotted behind the heart 

using the LAYER option)"  
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4 Example graphics 

 

This chapter showcases the wide variety of graphics that can be produced by Genstat. The 

examples contain both the Genstat program as well as the produced figure.  

The chapter begins by presenting the graphs generated by directives under their default 

parameter and option settings (Section 4.1). (A library of example graphs from Genstat’s 

collection of procedures is provided in Appendix 5.1.) The next section (Section 4.2) 

demonstrates some special features that can be used to create a customized graph. For 

example, how to add text, a reference line or an oblique axis to a plot. In the final section, 

an array of example graphs are produced that showcase the breadth of figures possible in 

Genstat (Section 4.2.17).  

Complementary to this chapter are Genstat’s built-in example programs. These 

programs provide examples of how to use the Genstat command language for different 

directives and procedures. The example programs are accessible via the Help | Example | 

Commands | Example Programs menu (Figure 4.1). For example, to access the example 

programs for the DGRAPH directive, search for ‘DGRAPH’ in the Look for: field and click 

the Open button. Where multiple examples are available, this launches the Select Example 

menu window (Figure 4.1) where you can select an example program to display.  

 

Figure 4.1: Accessing the built-in example programs for the DGRAPH directive. 

 

In this chapter you will: 

• generate a plot from each of Genstat’s graphical directives (Section 4.1) 
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• be introduced to many of Genstat’s graphical directives and procedures (Sections 4.1 

and 4.2) 

• create a wide variety of graphs using the command language (Sections 4.2 and 4.3) 
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4.1 Default output from Genstat’s graphical directives 

 

Genstat can produce graphical output in two distinctively different styles: high-resolution graphics and line-printer graphics. In this section 

we illustrate the graphs produced by the 10 directives for high-resolution plots (Appendix 5.1.2) and the 3 directives for line-printer plots 

(Appendix 5.1.1) under their default parameter and options settings. Help documentation for these directives is available within the Genstat 

Help System ( ) – also see in Genstat Reference Manual (Part 2 for Directives) accessible via Help | Reference Manual | Directives….  

Note, many additional graphical facilities are provided by Genstat procedures (see Appendix 5.1.3). 

Directives for high-resolution plots  

Default output for BARCHART (plots bar charts)  

 

JOB 'Default output from BARCHART' 

 

FACTOR [LEVELS=!(1999,2000)] Year 

FACTOR [LABELS=!t(April,June,September,December)] Month 

TABLE [CLASSIFICATION=Year,Month; \ 

      VALUES=45000,10000,-24000,11000,\ 

             21000,34000,-10000,47000] Results 

 

BARCHART Results 

 

ENDJOB 
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Default output for DGRAPH (plots scatter plots and line graphs)  

 

JOB 'Default output from DGRAPH' 

 

VARIATE [VALUES=1...20] Dose 

VARIATE [VALUES=1,1.1,1.2,1.2,1.5,1.6,1.9,1.8,2,2.3,2.8,\ 

                2.9,2.8,3,3.5,3.7,3.6,3.8,3.9,3.8] \ 

        Response 

 

DGRAPH Response; Dose 

 

ENDJOB 

 
Default output for DHISTOGRAM (plots histograms)  

 

JOB 'Default output from DHISTOGRAM' 

 

VARIATE [VALUES=11.6,9.9,10.7,10.7,10.3,10.0,9.7,9.3,\ 

                10.1,9.0,8.8,11.9,9.5,10.4,8.2,10.4,\ 

                10.9,9.4,11.1,10.2] ControlGroup 

VARIATE [VALUES=13.6,13.3,11.8,13.6,10.2,12.6,10.3,\ 

         12.7,10.2,8.3,8.8,12.0,9.2,12.6,9.0,\ 

         11.4,10.2,12.2,10.9,10.7] TrtGroup 

 

DHISTOGRAM ControlGroup,TrtGroup 

 

ENDJOB 
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Default output for D3GRAPH (plots a 3-dimensional graph) 

 

JOB 'Default output from D3GRAPH' 

 

VARIATE [VALUES=25,27,29,31,31,34,36,37,39,42,42,45,46,\ 

                48,49,49,50,56,58,63,67,72,85,91,92]\ 

        Tillers 

VARIATE [VALUES=1,1.2,1.5,1.7,1.6,1.9,1.8,2,2.1,2.4,2.3,\ 

                2.5,2.8,2.7,2.6,2.7,3,3.4,3.3,3.2,3.1,\ 

                3.5,3.5,3.6,3.7] DryMatter 

VARIATE [VALUES=121,101,122,111,117,129,110,59,98,37,25,\ 

                15,35,52,12,25,14,13,10,14,21,5,3,2,8] \ 

                Pests 

 

D3GRAPH  Pests; DryMatter; Tillers 

 

ENDJOB 

 
Default output for DPIE (plots pie charts)  

 

JOB  'Default output from DPIE' 

 

VARIATE [VALUES=1,1.1,1.2,1.3] Amount 

 

DPIE #Amount 

 

ENDJOB 
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Default output for DCONTOUR (plots contour maps)  

 

JOB 'Default output from DCONTOUR' 

 

VARIATE [VALUES=0,0.2...2] Rows 

VARIATE [VALUES=0,0.2...1] Columns 

MATRIX [ROWS=Rows; COLUMNS=Columns] X, Y, Function 

MATRIX [MODIFY=yes; VALUES=(#Columns)11] X 

CALCULATE Y$[*;1...6] = Rows 

CALCULATE Function=COS(1/(X+0.1)** 2)+SIN(Y**2) 

 

DCONTOUR Function 

 

ENDJOB 

 
Default output for DSHADE with INTERVAL=1 (plots a shade diagram)  

 

JOB 'Default output from DSHADE' 

 

VARIATE [VALUES=0,0.2...2] Rows 

VARIATE [VALUES=0,0.2...1] Columns 

MATRIX [ROWS=Rows; COLUMNS=Columns] X, Y, Function 

MATRIX [MODIFY=yes; VALUES=(#Columns)11] X 

CALCULATE Y$[*;1...6] = Rows 

CALCULATE Function=COS(1/(X+0.1)** 2)+SIN(Y**2) 

 

DSHADE Function; INTERVAL=1 

 

ENDJOB 
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Default output for DSURFACE (draws a perspective plot)  

 

JOB 'Default output from DSURFACE' 

 

VARIATE [VALUES=0,0.2...2] Rows 

VARIATE [VALUES=0,0.2...1] Columns 

MATRIX [ROWS=Rows; COLUMNS=Columns] X, Y, Function 

MATRIX [MODIFY=yes; VALUES=(#Columns)11] X 

CALCULATE Y$[*;1...6] = Rows 

CALCULATE Function=COS(1/(X+0.1)** 2)+SIN(Y**2) 

 

DSURFACE Function 

 

ENDJOB 

 
 

Default output for D3HISTOGRAM (plots a 3-dimensional histogram) 
 

 

JOB 'Default output from D3HISTOGRAM' 

 

VARIATE [VALUES=0,0.2...2] Rows 

VARIATE [VALUES=0,0.2...1] Columns 

MATRIX [ROWS=Rows; COLUMNS=Columns] X, Y, Function 

MATRIX [MODIFY=yes; VALUES=(#Columns)11] X 

CALCULATE Y$[*;1...6] = Rows 

CALCULATE Function=COS(1/(X+0.1)** 2)+SIN(Y**2) 

 

D3HISTOGRAM Function 

 

ENDJOB 
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Default output for DBITMAP (plots bitmaps of RGB colours)  

 

JOB  'Default output from DBITMAP' 

 

IMPORT [RGBMETHOD=matrix] \ 

       '%GENDIR%/Examples/GuidePart1/CapeWagtail.jpg'; \ 

       COLUMNS='RGB' 

" Resize window 3 to match the dimensions of the bitmap "  

CALCULATE Nr = NROWS(RGB) 

CALCULATE Nc = NCOLUMNS(RGB) 

FRAME 3; YUPPER= Nr / Nc 

 

DBITMAP [WINDOW=3] RGB 

 

ENDJOB 

 

 

Directives for line-printer plots 

As the name suggests, line-printer graphics are designed for printing on ordinary printers. They are also suitable for displaying on 

computer screens. Line-printer plots form an integral part of the Genstat output, and can thus be interspersed with other results during the 

analysis of the data.  

With line-printer graphics, the standard character set, made up of letters, digits and punctuation characters, is used to produce a 

graphical representation of the data. This will be of low resolution, but it is often adequate for a quick assessment of the data, or for 

checking the assumptions of an analysis. Graphs, histograms and contour plots can be produced in this basic style. 
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Default output for LPGRAPH (plots scatter plots and line graphs)  

 

JOB 'Default output from LPGRAPH' 

 

VARIATE [VALUES=1...20] Dose 

VARIATE [VALUES=1,1.1,1.2,1.2,1.5,1.6,1.9,1.8,2,2.3,2.8,\ 

                2.9,2.8,3,3.5,3.7,3.6,3.8,3.9,3.8] \ 

        Response 

 

LPGRAPH Response; Dose 

 

ENDJOB 

 

  

Default output for LPHISTOGRAM (plots histograms)  

 

JOB 'Default output from LPHISTOGRAM' 

 

VARIATE [VALUES=11.6,9.9,10.7,10.7,10.3,10.0,9.7,9.3,\ 

                10.1,9.0,8.8,11.9,9.5,10.4,8.2,10.4,\ 

                10.9,9.4,11.1,10.2] ControlGroup 

VARIATE [VALUES=13.6,13.3,11.8,13.6,10.2,12.6,10.3,\ 

         12.7,10.2,8.3,8.8,12.0,9.2,12.6,9.0,\ 

         11.4,10.2,12.2,10.9,10.7] TrtGroup 

 

LPHISTOGRAM ControlGroup,TrtGroup 

 

ENDJOB 
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Default output for LPCONTOUR (plots contour maps)  

JOB 'Default output from LPCONTOUR' 

 

VARIATE [VALUES=0,0.2...2] Rows 

VARIATE [VALUES=0,0.2...1] Columns 

MATRIX [ROWS=Rows; COLUMNS=Columns] X, Y, Function 

MATRIX [MODIFY=yes; VALUES=(#Columns)11] X 

CALCULATE Y$[*;1...6] = Rows 

CALCULATE Function=COS(1/(X+0.1)** 2)+SIN(Y**2) 

 

LPCONTOUR Function 

 

ENDJOB 

 

 
.
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4.2 Special graphical facilities 

 

Genstat’s many graphical directives and procedures (see Appendix 5.1) enable a wide 

variety of different graphs to be created and customized. This section demonstrates some 

of the special features that can be used to form a bespoke graph.  

 

 Adding text to a graph containing typesetting 

Text strings, used for example to add a title or label to a graph, can contain typesetting 

commands that represent Greek, mathematical and special symbols, or control text 

formatting. Typesetting commands are introduced by the character tilde (~). They are 

automatically converted by Genstat to match the style of output (HTML, LaTeX, plain-

text or RTF). If Genstat encounters a mistake in the syntax of a typesetting command, it 

will not issue a failure diagnostic but will output the remainder of the string (including 

any commands) as plain text. 

The following commands define Greek characters and various special and 

mathematical symbols. The character definitions (within the curly brackets,{}) can be 

abbreviated. Genstat checks through the possibilities, in the order defined below, until it 

finds the first match. Lower-case Greek characters are obtained by beginning the 

character definition with a lower-case letter, for example ~{sigma}, and upper-case by 

beginning with an upper-case letter, for example ~{Sigma}. 

 

Symbol Command Description Symbol  Command 
     

~ ~{~} 
tilde symbol; also see 

~{tilde} 
  

α ~{alpha}  
Greek character 

alpha 
Α ~{Alpha} 

β ~{beta}  Greek character beta  Β ~{Beta} 

γ ~{gamma}  
Greek character 

gamma 
Γ ~{Gamma} 

δ ~{delta}  Greek character delta Δ ~{Delta} 

ϵ ~{epsilon}  
Greek character 

epsilon 
Ε ~{Epsilon} 

ε ~{varepsilon} 
Greek character 

epsilon (variant) 
Ε ~{Varepsilon} 

ζ ~{zeta}  Greek character zeta Ζ ~{Zeta} 

η ~{eta}  Greek character eta Η ~{Eta} 
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Symbol Command Description Symbol  Command 
     

θ ~{theta}  Greek character theta Θ ~{Theta} 

ϑ ~{vartheta}  
Greek character theta 

(variant) 
Θ ~{Vartheta} 

ι ~{iota}  Greek character iota Ι ~{Iota} 

κ ~{kappa}  
Greek character 

kappa 
Κ ~{Kappa} 

λ ~{lambda}  
Greek character 

lambda 
Λ ~{Lambda} 

μ ~{mu}  Greek character mu Μ ~{Mu} 

ν ~{nu}  Greek character nu Ν ~{Nu} 

ξ ~{xi}  Greek character xi Ξ ~{Xi} 

ο ~{omicron}  
Greek character 

omicron 
Ο ~{Omicron} 

π ~{pi}  Greek character pi Π ~{Pi} 

ϖ ~{varpi}  
Greek character pi 

(variant) 
Π ~{Varpi} 

ρ ~{rho}  Greek character rho Ρ ~{Rho} 

ϱ ~{varrho}  
Greek character rho 

(variant) 
Ρ ~{Varrho} 

σ ~{sigma}  
Greek character 

sigma 
Σ ~{Sigma} 

ς  ~{varsigma} 

Greek character 

sigma (terminal 

version) 

Σ ~{Varsigma} 

τ ~{tau}  Greek character tau Τ ~{Tau} 

υ ~{upsilon} 
Greek character 

upsilon 
Υ ~{Upsilon} 

ϕ ~{phi}  Greek character phi Φ ~{Phi} 

φ  ~{varphi}  
Greek character phi 

(variant) 
Φ ~{Varphi} 

χ ~{chi}  Greek character chi Χ ~{Chi} 

ψ ~{psi}  Greek character psi Ψ ~{Psi} 

ω ~{omega}  
Greek character 

omega 
Ω ~{Omega}  
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Symbol Command Description 

• ~{bullet}  bullet 

∙ ~{cdot}  centred dot; also see ~{middot} 

÷ ~{divide}  divide symbol 

>> ~{gg}  ">>" symbol; also see ~{raquo} 

<< ~{laquo}  "<<" symbol; also see ~{ll} 

<< ~{ll}  "<<" symbol; also see ~{laquo} 

∙ ~{middot}  centred dot; also see ~{cdot} 

- ~{minus}  minus symbol 

± ~{plusminus} plus-minus symbol; also see ~{pm} 

± ~{pm}  plus-minus symbol; also see ~{plusminus} 

>> ~{raquo}  ">>" symbol; also see ~{gg} 

√ ~{sqrt}  square-root symbol 

⊕ ~{oplus}  plus within circle 

(-) ~{ominus}  minus symbol within round brackets  

⊗ ~{otimes}  multiply symbol within circle 

ø  ~{oslash}  slash symbol within circle 

(.)  ~{odot} dot within round brackets 

~ ~{tilde}  tilde symbol; also see ~{~} 

× ~{times}  multiply symbol 

 
The following commands control formatting:  

Command Description 
  

~{break} starts a new line 

~bold or ~b 

introduces a sequence of bold characters; these must be placed 

within curly brackets e.g. ~bold{this text is formatted 

bold} 

~italic or ~i 

introduces a sequence of italic characters; these must be placed 

within curly brackets e.g. ~italic{this text is 

italicized} 

~_ 

introduces a subscript; if the subscript is a single character it can be 

placed immediately after _, otherwise it must be placed within curly 

brackets 

~^ 

introduces a superscript; if the superscript is a single character it can 

be placed immediately after ^, otherwise it must be placed within 

curly brackets 
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You can use special characters in subscripts or superscripts, but fonts must be specified 

outside the subscript or superscript. For example: 

~italic{x~_{i,j}} defines xi,j 

x~^{2~{alpha}} defines x2α 

~bold{X}~italic{~_{i,j}}~^2 defines Xi,j
2 

Figure 4.2 provides the output from the various typesetting commands below. 

 

JOB 

XAXIS 1; ACTION=hide; LOWER=0; UPPER=11 

YAXIS 1; ACTION=hide; LOWER=0; UPPER=11 

FRAME WINDOW=1; BOX=omit 

 

PEN 1; SYMBOLS=0; \ 

    LABELS='~{alpha} ~{beta} ~{gamma} ~{delta} ~{epsilon}   ...\ 

   ~{phi} ~{varphi} ~{chi} ~{psi} ~{omega}'; SIZE=2 

DGRAPH [WINDOW=1; KEYWINDOW=0] 10; 1 

 

PEN 1; \ 

    LABELS='~{Alpha} ~{Beta} ~{Gamma} ~{Delta} ~{Epsilon}   ...\ 

    ~{Phi} ~{Varphi} ~{Chi} ~{Psi} ~{Omega}'; SIZE=2 

DGRAPH [WINDOW=1; KEYWINDOW=0; SCREEN=keep] 9; 1 

 

PEN 1; LABELS='~{bullet} ~{cdot} ~{divide} ~{gg} ~{ll}   ...\ 

   ~{otimes} ~{oslash} ~{odot} ~{tilde}  ~{times}'  

DGRAPH [WINDOW=1; KEYWINDOW=0; SCREEN=keep] 8; 1 

 

PEN 1; LABELS='x~^{2n}' 

DGRAPH [WINDOW=1; KEYWINDOW=0; SCREEN=keep] 7; 1 

 

PEN 1; LABELS='~i{x~_{i,j}}' 

DGRAPH [WINDOW=1; KEYWINDOW=0; SCREEN=keep] 6; 1 

 

PEN 1; LABELS='~i{x~_{i,j}}~^2' 

DGRAPH [WINDOW=1; KEYWINDOW=0; SCREEN=keep] 5; 1 

 

PEN 1; LABELS='x~_{i} - y~_{j}' 

DGRAPH [WINDOW=1; KEYWINDOW=0; SCREEN=keep] 4; 1 

 

PEN 1; LABELS='~b{X}~i{~_{i,j}}~^2' 

DGRAPH [WINDOW=1; KEYWINDOW=0; SCREEN=keep] 3; 1 

 

PEN 1; LABELS='a~^p + b~^q' 

DGRAPH [WINDOW=1; KEYWINDOW=0; SCREEN=keep] 2; 1 
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PEN 1; LABELS='y = ~{alpha} + ~{beta} e~^{~{kappa}x}' 

DGRAPH [WINDOW=1; KEYWINDOW=0; SCREEN=keep] 1; 1 

 

ENDJOB 

 

Figure 4.2: Examples of typesetting within text strings. 

 

 Specifying the default font using DFONT 

Textual information in high-resolution graphs can be displayed in a variety of fonts. The 

font of a graphical pen may be set using the FONT parameter of the PEN directive (see 

Section 3.4). If this is not done, the pen is assumed to use the default graphics font. When 

Genstat is first installed, the default graphics font is set automatically to Arial. However, 

a new default graphics font can be set either:  

• in the Fonts tab of the Tools | Options… menu in the Graphics Viewer (see Section 1.2.5); 

• in the Graphics tab of the Tools | Options… menu in Genstat; or, 

• using the DFONT directive (as described here). 

The DFONT directive has a single, unnamed, parameter. This can be used to supply the 

name of the font family to be used as the default. For example, the command 

DFONT 'Calibri' 

sets the default graphics font to Calibri. By doing so, all textual information displayed 

using the default graphics font will now appear in the Calibri font. This applies to all 

graphs that are displayed or redisplayed in the Graphics Viewer, including those stored in 

Genstat Meta Files. (Note, the standard Genstat font (i.e. Arial) can be restored as the 

default graphics font by calling DFONT without setting the parameter.) 

The example code below draws a bar chart using the default graphics font for all 

textual information. Observe the changing appearance of the bar chart in the Graphics 

Viewer as the DFONT directive is used to modify the default graphics font (Figure 4.3). 
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JOB  

 

FACTOR [LEVELS=!(1999,2000)] Year 

FACTOR [LABELS=!t(April,June,\ 

                  September,December)]\ 

       Month 

TABLE [CLASSIFICATION=Year,Month; \ 

      VALUES=45000,10000,-24000,11000,\ 

             21000,34000,-10000,47000]\ 

      Results 

"Sets the default graphics font to  

 the standard Genstat font, i.e. Arial"  

DFONT 

"Draw bar chart" 

BARCHART Results 

"Change default font to Georgia" 

DFONT 'Georgia' 

"Change default font to Comic Sans MS" 

DFONT 'Comic Sans MS' 

"Restore the standard Genstat font"  

DFONT 

 

ENDJOB  

a) Arial 

b) Georgia 

 

c) Comic Sans MS 

 

Figure 4.3: Changing appearance of a bar chart displayed in 

the Graphics Viewer as the DFONT directive is used to alter 

the default graphics font from a) the Genstat standard font, 

Arial, to b) Georgia, and to c) Comic Sans MS. 



Example graphics 

180 

 

The DFONT directive can also be used to save the name of the default graphics font. 

This is achieved by setting the DFONT parameter to supply either a text structure or an 

undeclared data structure. For example: 

JOB  

 

"Text string with no values" 

DFONT 'Courier New' 

TEXT Currentdefault_1 

DFONT Currentdefault_1 

PRINT Currentdefault_1 

 

"Undeclared structure" 

DFONT 'Impact' 

DFONT Currentdefault_2 

PRINT Currentdefault_2 

 

ENDJOB 

 

Note, a list of available fonts can be viewed in the Graphics tab of Genstat’s Tools | 

Options… menu, or in the Fonts tab of the Graphics Viewer’s Tools | Options… menu (see 

Section 1.2.5). 

 

 Adding text to a plot using DTEXT 

The DTEXT procedure provides a simple method for adding text to an existing plot. The 

text to be plotted is supplied using the TEXT parameter. This can be either a single string, 

or a Genstat text structure containing several lines of text. The Y and X parameters define 

the location that the text is to be plotted. (These are scalars for a single string or line of 

text, or variates for multiple lines of text.) The PEN parameter specifies the pen (or pens) 

used to plot the text, and the WINDOW option specifies the window number of the existing 

plot to which the text is to be added (default 1). In the example below, DTEXT is used to 

label a Venn diagram (see Figure 4.4). 

 

JOB  

 

"Plot Venn diagram in Window 3" 

VARIATE [VALUES=0...100] theta 

CALCULATE theta = 2 * C('pi') * theta / 100 

&         X  = COS(theta) 

&         Y1 = SIN(theta) 

&         Y2 = Y1 + 1 

PEN 1,2; METHOD=fill; SYMBOL=0; JOIN=given; \ 

    CAREA='blue','red'; TAREA=0,100 
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DGRAPH [TITLE='Venn diagram'; WINDOW=3; KEY=0] Y=Y1,Y2; X=X; \ 

       PEN=1,2 

  

"Add labels using DTEXT" 

PEN 3...5; SMLABEL=4; COLOUR='white'; XLPOSITION=centre 

DTEXT [WINDOW=3] Y=1.5,0.5,-0.5; X=0; \ 

      TEXT='A','A and B','B'; PEN=3,4,5 

 

ENDJOB 

 Adding text to a graphic frame using DFRTEXT 

Similarly to the way in which the DTEXT procedure can add text to a plot inside the 

graphics frame (Section 4.2.1), the DFRTEXT procedure enables text to be added to the 

frame. The text to plot is specified by the TEXT parameter. This can be either a single 

string, or a Genstat text structure containing several lines of text. The Y and X parameters 

specify the coordinates where the text is to be plotted. These coordinates relate to the 

standard device coordinates used to define windows within the frame (see Section 3.3). 

They must lie between 0 and the values supplied by the YUPPER and XUPPER parameters 

(default 1), which set the maximum values in the y- and x-dimensions, respectively. The 

PEN parameter specifies the pen (or pens) used to plot the text (default 1).  

  

Figure 4.4: Labels added to a Venn 
diagram using the DTEXT 

procedure. 
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The use of DFRTEXT is demonstrated by the commands below to produce Figure 4.5. 

 

JOB 

 

"Plot a simple line graph" 

PEN 1; METHOD=line; SYMBOL=0 

VARIATE [VALUES=1...10] x 

XAXIS 3; TITLE='x~^{2}' 

YAXIS 3; TITLE='x~^{3}' 

DGRAPH [WINDOW=3; KEY=0] x**3; x**2 

 

"Add text to the frame using DFRTEXT" 

PEN [RESET=yes] 1,2; ROTATION=315; SIZE=12,3; FONT=1,18; \ 

    COLOUR='red' 

DFRTEXT Y=1.1,0.9; X=0,0; YUPPER=1.1; PEN=1,2; \ 

        TEXT='DRAFT ONLY', \ 

             'Text has been added to the frame using DFRTEXT' 

 

ENDJOB 

 

Note, to include superscripts in the x- and y-axes labels, typesetting commands have 

been used. See Section 4.2.1 for more information on typesetting. 

Figure 4.5: Text added to 

the graphics frame using the 
DFRTEXT procedure. 
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 Adding a reference line to a plot using DREFERENCELINE 

The DREFERENCELINE procedure can be used to add horizontal or vertical reference lines 

to an existing plot.  

The window containing the plot to which the reference lines are to be added is specified 

by the WINDOW option (default 1). The ORIENTATION option controls whether horizontal 

or vertical reference lines are drawn (default horizontal). The POSITION parameter 

defines the position of each line, on the y-axis for horizontal lines, or the x-axis for vertical 

lines. The PEN parameter specifies the pen (or pens) used to draw the reference lines 

(default 255). 

Further parameters (LABEL, YLPOSITION, XLPOSITION and PENLABEL) enable 

labels to be plotted alongside the reference lines. LABEL supplies the text, YLPOSITION 

defines the position of the label in the y-direction (above, below, centre; default 

below), XLPOSITION defines the position in the x-direction (left, right, centre; 

default left), and PENLABEL specifies the pen to use to write each label (default 256). 

In the example that follows, we add vertical and horizontal reference lines to a scatter 

plot of petal length against petal width to indicate the mean values (see Figure 4.6). 

 

JOB 

 

"Plot graph of petal length vrs petal width" 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

PEN 1...3; SYMBOL='circle'; CFILL='black'; SIZE=1,2,2; \ 

    COLOUR='black','red','blue 

XAXIS WINDOW=3; TITLE='Petal Width'; PENTITLE=2 

YAXIS WINDOW=3; TITLE='Petal Length'; PENTITLE=3 

DGRAPH [WINDOW=3; KEY=0] Y=Petal_Length; X=Petal_Width 

 

"Calculate petal length and width" 

CALCULATE mpl,mpw = MEAN(Petal_Length,Petal_Width) 

PEN 2,3; THICKNESS=2; SIZE=1 

DREFERENCELINE [WINDOW=3; ORIENTATION=horizontal] mpl; \ 

               LABEL='Mean length';PEN=3; \ 

               PENLABEL=3; YLPOSITION=above 

DREFERENCELINE [WINDOW=3; ORIENTATION=vertical] mpw; \ 

               LABEL='  Mean width';\ 

               PEN=2; PENLABEL=2; XLPOSITION=right 

 

ENDJOB 
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 Adding an arrow to a plot using DARROW 

Arrows (or lines) can be added to an existing plot using the DARROW procedure.  

The options of this procedure are: 

• WINDOW: number of the window containing the plot to which arrows are to be added 

(default 3). 

• COORDINATETYPE: whether the points defining the arrows are specified in terms of 

the x- and y-axes (setting graph, the default) or relative to the frame (setting frame). 

• YUPPER and XUPPER: the maximum size of the frame used when 

COORDINATETYPE=frame (default 1). 

• ISTYLE and ESTYLE: symbol at the start and end of the arrows, respectively (none, 

open, closed, circle; default none). 

• ISIZE and ESIZE: size of symbol at the start and end of the arrows, respectively 

(default 1). 

• IANGLE and EANGLE: angle between the two sides at the start and end of the 

arrowheads, respectively (default 45). 

• LAYER: plot layer for the arrows. By default they overlay all previous items. 

The IY, IX, EY and EX parameters of the DARROW procedure define the starting and 

ending y- and x-positions of the arrows. The COLOUR, LINESTYLE, THICKNESS and 

Figure 4.6 Reference lines, with 

labels, added to a scatter plot using 
the DREFERENCELINE procedure. 

 



Example graphics 

185 

 

TRANSPARENCY parameters specify the colour, line style, thickness and transparency of 

each arrow. 

To illustrate the DARROW procedure, using the code below we create a circle of blue 

and red arrows of varying thickness. The resulting plot is shown in Figure 4.7. 

 

JOB 

 

"Initiate the plotting window" 

CALCULATE x1,x2 = 1,8 * COS(C('radians') * !(0,5...355)) 

CALCULATE y1,y2 = 1,8 * SIN(C('radians') * !(0,5...355)) 

PEN 1; SYMBOLS=0 

XAXIS WINDOW=3; ACTION=hide 

YAXIS WINDOW=3; ACTION=hide 

DGRAPH [WINDOW=3; KEY=0; TITLE='Circle of arrows'] \ 

       Y=!(-9,9); X=!(-9,9) 

 

"Add arrows to window 3" 

DARROW [WINDOW=3; ESIZE=2; EANGLE=30; ESTYLE='closed'] \ 

       IY=y1; IX=x1; EY=y2; EX=x2; \ 

       COLOUR=!t(('red','blue')36); THICKNESS=!((1...3)24) 

 

ENDJOB 

 
 

Figure 4.7: Circle of thick and thin 

blue and red arrows created using 

DARROW. 
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 Adding error bars to a plot using DERRORBAR 

Many graphical directives and procedures allow error bars to be plotted.  However, you 

may want to add error bars to an existing graph or require greater control over the 

placement and appearance of the error bars. The DERRORBAR procedure enables error bars 

to be plotted on a graph.  

The window containing the graph to which the error bars are to be added is specified 

by the WINDOW option (default 1). The ORIENTATION option controls whether the bars 

are plotted horizontally or vertically (default vertical). The BARLENGTH parameter 

defines the length of each bar, and the Y and X parameters their positions. The 

BARCAPWIDTH option sets the size of the caps drawn at the ends of the bars, and the PEN 

parameter specifies the pen (or pens) used to draw the error bars (default 255). The 

DESCRIPTION parameter enables annotation to be added on the graph’s key, and the 

key’s window is specified by the KEYWINDOW option (default 2). Further parameters 

(LABEL, YLPOSITION, XLPOSITION and PENLABEL) enable labels to be plotted 

alongside the error bars.  

To illustrate the DERRORBAR procedure, we’ll add error bars representing the standard 

error of the mean (SEM), the standard error of the difference (SED) and the least 

significant difference at the 5% level  (LSD(5%)) to a plot of means. The commands 

below produce Figure 4.8. 

 

JOB 

  

"Obtain means, SEMs, SEDs and LSD(5%)s from one-way ANOVA" 

SPLOAD '%GENDIR%/Data/Rat.gsh' 

A2WAY [PRINT=*; TREATMENTS=diet; PLOT=*] weight 

AKEEP diet; MEANS=meanT; SEMEANS=semT; SEDMEAN=sedT; \ 

     DFMEANS=dfT 

CALCULATE lsd = MEAN(sedT*EDT(0*dfT + 0.975; dfT)) 

 

"Plot means" 

VTABLE TABLE=meanT; VARIATE=means; CLASSIFICATION=!P(dietC); \ 

       LABELS=label_diet 

GETATTRIBUTE [ATTRIBUTE=levels] dietC; levels_diet  

XAXIS WINDOW=3; MARKS=#levels_diet; LABELS=label_diet; UPPER=7 

PEN 1; SYMBOL=2; SIZE=2; COLOUR='blue'; CFILL='blue' 

DGRAPH [WINDOW=3; TITLE='Mean gain weight for each diet'; \ 

       KEYWINDOW=0] Y=means; X=dietC  

 

"Add error bars representing the SEM, SED and LSD(5%)" 

CALCULATE sem = MEAN(semT) 

CALCULATE sed = MEAN(sedT) 
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PEN [RESET=yes] 1...3; COLOUR='black','darkgreen','red' 

DERRORBAR [WINDOW=3] BARLENGTH=sem,sed,lsd; X=4.15,5.15,6.15; \ 

  LABEL='SEM','SED','LSD(5%)'; PEN=1...3; PENLABEL=1...3; \ 

  YLPOSITION=below 

 

ENDJOB 

  

Figure 4.8: Error bars, with labels, added to a plot using the DERRORBAR procedure. 

 

 

 Adding a bespoke key to a graph using DKEY 

Keys are automatically added to graphs generated using the ordinary plotting commands. 

(These can be suppressed by setting the option KEYWINDOW in these commands to zero). 

However, greater flexibility over the layout and appearance of the key, including allowing 

the key to span multiple columns, is obtained by defining the key using the DKEY 

procedure. 

The labels to appear in the key are supplied by the DESCRIPTIONS parameter of DKEY. 

Their size, font and colour can be controlled using either the PENLABELS option or the 

LSIZE, LFONT and LCOLOUR options.  

The types of items to be plotted in the key (points, lines, lines and points, or filled 

rectangles) are specified using the METHOD parameter. The appearance of these items 

(symbol type, colour, size, line style, line thickness and transparency) can be controlled 
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using either the PEN parameter or the SYMBOL, COLOUR, CSYMBOL, CFILL, 

SIZEMULTIPLIER, LINESTYLE, THICKNESS and TRANSPARENCY parameters. 

The WINDOW, NCOLUMNS, NROWS, ORDER, XLOFFSET, COLSPACING, ROWGAP, 

COLGAP, BORDER and CBORDER options control the layout of the key, and the TITLE, 

PENTITLE and TPOSITION options are used to define the title. 

The examples below demonstrate how DKEY can be used to enhance a graph’s key. 

The default key of DGRAPH is shown in Figure 4.9a. Using DKEY, a key is drawn over 3 

columns in Figure 4.9b, in a user defined window in Figure 4.9c, and with bespoke labels 

in Figure 4.9d. 

 

JOB 

 

SPLOAD [PRINT=*] '%GENDIR%/Data/Iris.gsh' 

XAXIS [RESET=yes] WINDOW=1; Title='Sepal Width (mm)' 

YAXIS [RESET=yes] WINDOW=1; Title='Sepal Length (mm)' 

PEN [RESET=yes] 1...6; COLOUR=('red','blue','darkgreen')2; \ 

    SYMBOL=(1,2,3)2; SIZE=3(1,1.2) 

 

"Default key" 

DGRAPH Y=Sepal_Length; X=Sepal_Width; PEN=Species 

 

"Define a three-columned key using factor labels with DKEY" 

DGRAPH [KEYWINDOW=0] Y=Sepal_Length; X=Sepal_Width; PEN=Species 

GETATTRIBUTE [ATTRIBUTE=labels] Species; SAVE=SpeciesLabels 

DKEY [NCOLUMNS=3; TITLE='Iris species'; TPOSITION=left,inside] \ 

     PEN=!(4...6); DESCRIPTIONS=#SpeciesLabels  

 

"Plot key in a bespoke window" 

FRAME WINDOW=6; XLOWER=0.72 

DGRAPH [KEYWINDOW=0] Y=Sepal_Length; X=Sepal_Width; PEN=Species 

DKEY [WINDOW=6; NCOLUMNS=1; BORDER=none; LSIZE=1.2] \ 

     PEN=!(4...6); DESCRIPTIONS=#SpeciesLabels  

 

"Use coloured labels to define the key" 

PEN 1...6; SYMBOL='circle'; CFILL=('red','blue','darkgreen')2 

DGRAPH [KEYWINDOW=0] Y=Sepal_Length; X=Sepal_Width; PEN=Species 

DKEY [WINDOW=6; NCOLUMNS=1; PENLABELS=!(4...6); BORDER=none; \ 

      XLOFFSET=-6] !T('~i{Iris setosa}','~i{Iris versicolour}',\ 

                     '~i{Iris virginica}'); METHOD='none' 

PEN [RESET=yes] 1...6 

FRAME [RESET=yes] WINDOW=6 

 

ENDJOB 
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a 

 

b 

 

c 

 

d 

 

Figure 4.9: Examples of different keys. a) default key, b-d) keys added using DKEY. 

  

 Adding an oblique axis using AXIS 

Using the AXIS directive an oblique axis can be added to a high-resolution graph. Six 

parameters are used to define the location and direction of the axis:  

• The position of the axis origin in the x-, y- and z-dimensions is specified by the XZERO, 

YZERO and ZZERO parameters, respectively.  

• The size of the steps in the x-, y- and z-directions, corresponding to a step of length 
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one along the axis, are specified by XSTEP, YSTEP and ZSTEP parameters, 

respectively. 

The IDENTIFIER parameter is used to supply an identifier to store the axis definition. 

You can then use this as a setting of the AXES parameter of the FRAME directive to display 

the axis in a particular graphics window.  

The other parameters (TITLE, TPOSITION, TDIRECTION, LOWER, UPPER, MARKS, 

MPOSITION, LABELS, LPOSITION, LDIRECTION, LROTATION, NSUBTICKS, 

PENTITLE, PENAXIS, PENLABELS, ARROWHEAD, ACTION, TRANSFORM, DECIMALS, 

DREPRESENTATION, VREPRESENTATION, SAVE) define particular attributes of the axis 

(as for XAXIS, YAXIS and ZAXIS, see Section 3.5). For example, the LOWER and UPPER 

parameters specify the lower and upper bounds for the axis, respectively. The option, 

RESET, determines whether the axis definition is reset to the default values. 

In the following example, we examine two methods of measuring peak expiratory flow 

rate (data from Bland & Altman (1986), Lancet, 307-310). The data comprises Wright 

peak flow meter and mini Wright meter measurements made on 17 samples. We plot 

the data, and use the AXIS directive to add an oblique axes through the 1-1 line. The 

resulting graph is shown in Figure 4.10. 

 
JOB   

 

"Create two variates containing the data." 

VARIATE [NVALUES=17] peak,mini; VALUES=\ 

        !(494,395,516,434,476,557,413,442,650,\ 

          433,417,656,267,478,178,423,427),\ 

        !(512,430,520,428,500,600,364,380,658,\ 

          445,432,626,260,477,259,350,451) 

 

"Define the x and y-axes." 

XAXIS 1; LOWER=200; UPPER=700; \ 

      TITLE='Wright peak flow meter' 

YAXIS 1; LOWER=200; UPPER=700; \ 

      TITLE='Mini Wright meter' 

 

"Define an oblique axis through the 1-1 line. That is, set the 

origin to (x,y)=(0,0), and move SQRT(0.5) steps along both the x 

and y-axes for every 1 step along the 1-1 line. (The values of 

XSTEP and YSTEP are readily obtained using the Pythagorean 

theorem.) The LOWER and UPPER parameters are set to correspond 

to those defined by the XAXIS and YAXIS directives. The pen to 

be used to draw the axis is set to 2 using the PENAXIS 
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parameter. The resulting axis definition is saved to 'OnetoOne' 

using the IDENTIFIER parameter."  

AXIS IDENTIFIER=OnetoOne; LOWER=200; UPPER=SQRT(2*700**2); \ 

     LPOSITION=*; PENAXIS=2; \ 

     XZERO=0; YZERO=0; XSTEP=SQRT(0.5); YSTEP=SQRT(0.5) 

 

"Set the colour and thickness of the line used to draw the  

 oblique axis."     

PEN 2; COLOUR='blue'; THICKNESS=4 

 

"Set AXES parameter of FRAME to display the oblique axis  

 saved as OnetoOne." 

FRAME 1; AXES=OnetoOne 

 

"Plot the data." 

DGRAPH [WINDOW=1; KEYWINDOW=0] Y=mini; X=peak 

 

ENDJOB 

 

 

Figure 4.10: Blue line is an oblique axis (at 45 degrees) defined using AXES directive. 
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 Creating a composite graphic 

Many Genstat graphics commands have a SCREEN option, which can be set to keep to 

enable you to add new information to the current display. The output from each graphics 

command is drawn in one or more graphics windows (see FRAME, Section 3.3). These 

windows are independent of one another, and in most graphics devices they can be 

displayed simultaneously on the same graphics screen. Furthermore, on most devices, the 

windows can overlap or contain other windows. This enables you to plot a sequence of 

windows (keeping the current display) to build up a multiple display with different graphs 

in adjacent windows. Several Genstat procedures make use of this facility, for example 

trellis plots (TRELLIS) and scatter-plot matrices (DMSCATTER). 

Alternatively, you may be able to plot new information in an existing window to build 

up a complex picture in several stages. However, there are limitations on what a single 

window can contain. For example, you can use DGRAPH any number of times but with no 

more than one other DHISTOGRAM, CONTOUR or DSHADE command. This approach is 

used in graphics procedures like BOXPLOT and DDENDROGRAM. 

The following code generates the multi-layered plot in Figure 4.11, in which a 

monotonic line plot is superimposed onto a histogram.  

JOB 

 

"Generate data from the normal distribution" 

GRANDOM [DISTRIBUTION=Normal; NVALUES=1000; SEED=12345; \ 

        MEAN=10; VARIANCE=5] RandomNormal 

         

"Plot histogram" 

XAXIS WINDOW=3; LOWER=1; UPPER=18 

YAXIS WINDOW=3; LOWER=0; UPPER=200 

VARIATE [VALUES=2...17] Limits 

DHISTOGRAM [WINDOW=3; KEYWINDOW=0; LIMITS=Limits] RandomNormal 

        

"Superimpose normal curve" 

VARIATE [VALUES=1.0,1.1...18.0] X 

CALCULATE Mu = MEAN(RandomNormal) 

&         Sigma = SQRT(VARIANCE(RandomNormal)) 

&         Y = 1 / (SQRT(2*C('PI')) * Sigma) * \ 

              EXP(-0.5*((X-Mu)/Sigma)**2) 

&         Y = Y * NVALUES(RandomNormal) 

PEN 1; METHOD=monotonic; SYMBOL=0; THICKNESS=5 

DGRAPH [WINDOW=3; KEYWINDOW=0; SCREEN=keep] Y; X 

 

ENDJOB 
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When generating composite displays using a sequence of graphics commands, it is 

often convenient to clear the screen at the outset. Doing so means that all subsequent 

commands can have the option SCREEN=keep (or, for DGRAPH, SCREEN=resize), 

simplifying the programming particularly if they are in a FOR loop. This can be achieved 

using the DCLEAR directive. DCLEAR clears the screen of a graphics device so that the 

next plot produced by this device will be drawn onto an empty screen.  

An example illustrating the use of DCLEAR before a FOR loop follows. This produces 

the graph given in Figure 4.12. 

JOB 

 

DCLEAR 

 

"Variate of means" 

VARIATE [VALUES=1,4,6,10] means 

"Variate of variances" 

VARIATE [VALUES=2,4,8,3] variances 

"Colour for the pens" 

TEXT [VALUES=darkred,forestgreen,navy,orange] colour 

"Plot normal curves using a FOR loop" 

VARIATE [VALUES=-4,-3.9...20] X 

FOR n=1...4 

   CALCULATE Mu = means$[n] 

   &         Sigma = SQRT(variances$[n]) 

   &         Y = 1 / (SQRT(2*C('PI')) * Sigma) * \ 

                 EXP(-0.5*((X-Mu)/Sigma)**2) 

   PEN 1; METHOD=monotonic; SYMBOL=0; THICKNESS=2; \ 

Figure 4.11: Using SCREEN=keep 

to layer graphs. 
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       COLOUR=colour$[n] 

   DGRAPH [WINDOW=3; KEYWINDOW=0; SCREEN=resize] Y; X 

   TXCONSTRUCT [label] 'mean=',Mu,', variance=',variances$[n] 

   FRAME WINDOW=4; BOX=omit; \ 

         YLOWER=0.7; YUPPER=0.85; XLOWER=0.7; XUPPER=1; \ 

         YMLOWER=0; YMUPPER=0; XMLOWER=0; XMUPPER=0 

   DTEXT [WINDOW=4] Y=n/3; X=0; TEXT=label; PEN=1 

ENDFOR 

 

ENDJOB 

An efficient way of generating a composite display is to define an explicit sequence of 

plots using the DSTART and DFINISH directives. The information from each command is 

accumulated by Genstat, with no high-resolution plots being drawn until the DFINISH 

command is received. To demonstrate, replace the DCLEAR statement in the previous code 

with DSTART, and add a DFINISH statement before ENDJOB. This will result in a plot 

identical to that in Figure 4.12. 

When you use several statements with SCREEN=keep to build up a complex graph, 

the axes are drawn only the first time, and the same axes bounds are used for all 

subsequent graphs. If the axis bounds are too narrow, some points may be excluded, a 

phenomenon known as clipping. To avoid this you should define axis limits that enclose 

all the subsequent data, using YAXIS, XAXIS and ZAXIS. This was the approach we took 

to generate Figure 4.11. Alternatively, DGRAPH offers the option SCREEN=resize. This 

causes the axes and their bounds to be adjusted, if necessary, to enclose the additional 

information. This was the approach we took when generating Figure 4.12. 

 

Figure 4.12: Graph produced using 

DCLEAR before a FOR loop. 
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 Forming a plot-matrix using FFRAME 

The FFRAME procedure provides a convenient means of forming a plot-matrix, i.e. a 

multi-windowed figure. The options of FFRAME are used to define the windows 

comprising the plot-matrix, including their size and arrangement. The parameters are used 

to save these settings. The options and parameters controlling FFRAME are briefly 

described in Table 4-1. 

 

Table 4-1: Options and parameters of FFRAME. 

Options  

PRINT = string tokens 

Specifies whether to display the layout and numbering 

of the plot-matrix in a table or in a high-resolution test-

graph (table, testgraph). By default, nothing is 

displayed. 

ARRANGEMENT = string 

token 

Defines the arrangement of the plot-matrix. This can be 

either rectangle (the default), square, 

lowersymmetric, uppersymmetric or diagonal.  

ROWS = scalar Number of rows in the plot-matrix. Default 3. 

COLUMNS = scalar Number of columns in the plot-matrix. Default 3. 

DIAGONALWINDOWS = 

string token 

Specifies whether to include or exclude the 

diagonal in symmetric plot-matrices (default 

include). 

SQUARESHAPES = string 

token 

Specifies whether to force the individual windows 

(excluding margins for annotation) to be square. 

Default no. 

STARTWINDOW = scalar The number of the first window. Default 1. 

TESTGRAPH = variate 
Windows to be displayed in a test-graph. (Note, if this 

option is set, only a test-graph is produced and all other 

settings are ignored). 

NUMBERING = string token 
Specifies whether the individual windows are 

numbered rowwise (the default) or columnwise. 

DEFINE = string token 
Specifies whether to define the windows within the 

procedure (windows, nothing). Default windows. 

CLEARWINDOW = scalar or 

variate 

Defines the windows for which the screen should be 

cleared. Default 1. 

RLOWER = scalar Lowest y device coordinate. Default 0. 

RUPPER = scalar Highest y device coordinate. Default 1. 

CLOWER = scalar Lowest x device coordinate. Default 0. 

CUPPER = scalar Highest x device coordinate. Default 1. 

RSKIP = scalar Space between windows along the y-axis. Default 0. 

CSKIP = scalar Space between windows along the x-axis. Default 0. 
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MARGIN= string token 

Specifies where title margins are needed (xtitle, 

ytitle, none, small). The size of the margins is set 

to default values, however these can be explicitly set 

using YMLOWER, YMUPPER, XMLOWER and XMUPPER. 

YMLOWER = scalar 
Size of bottom margin (x-axis labelling) in each 

window.  

YMUPPER = scalar Size of upper margin (overall title) in each window.  

XMLOWER = scalar 
Size of left-hand margin (y-axis labelling) in each 

window.  

XMUPPER = scalar Size of right-hand margin in each window.  

RMLOWER = scalar 
Additional size of bottom margin (x-axis labelling) in 

windows at the bottom of the plot-matrix. Default 0. 

RMUPPER = scalar 
Additional size of upper margin (overall title) in 

windows at the top of the plot-matrix. Default 0. 

CMLOWER = scalar 
Additional size of left-hand margin (y-axis labelling) 

windows at the left of the plot-matrix. Default 0. 

CMUPPER = scalar 
Additional size of right-hand margin in windows at the 

right of the plot-matrix. Default 0. 

BACKGROUND = text or 

scalar 

Specifies the background colour to be used in each 

window. 

Parameters  

NGRAPHS = scalar 
Scalar to save the number of windows in the plot-

matrix. 

SWINDOW = pointer Pointer to save scalars with the window numbers. 

SYLOWER = pointer Pointer to save scalars with the lower and upper y 

device coordinates for each window, respectively. SYUPPER = pointer 

SXLOWER = pointer Pointer to save scalars with the lower and upper x 

device coordinates for each window, respectively. SXUPPER = pointer 

SSCREEN = pointer 
Pointer to save single-valued texts with value ‘clear’ or 

‘keep’ for each window. 

SMYLOWER = pointer Pointer to save scalars with the size of the bottom and 

upper margins for each window, respectively. SMYUPPER = pointer 

SMXLOWER = pointer Pointer to save scalars with the size of the left-hand and 

right-hand margins for each window, respectively. SMXUPPER = pointer 

 

To illustrate the FFRAME procedure, we create an array of 8 windows into which we 

display boxplots and scatterplots of Fisher’s Iris data. The arrangement of the windows 

in the frame is depicted in the test-graph of Figure 4.13. The resulting multi-windowed 

figure is shown in Figure 4.14. 

 

JOB 
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"Define a multi-window frames" 

FFRAME [ROWS=1; COLUMNS=2; STARTWINDOW=1; RUPPER=1.0; \ 

       RLOWER=0.9; MARGIN=none]  

FFRAME [ROWS=2; COLUMNS=2; STARTWINDOW=3; RUPPER=0.9; \ 

       RLOWER=0.3; CMLOWER=0.02]  

FFRAME [ROWS=1; COLUMNS=2; STARTWINDOW=7; RUPPER=0.3; \ 

       RLOWER=0.0; MARGIN=ytitle,xtitle] 

 

"Generate test graph showing layout" 

FFRAME [TESTGRAPH=!(1...8)] 

 

"Clear the graphics screen" 

DCLEAR 

 

"Text in windows 1 and 2" 

FRAME WINDOW=1,2; BOX=omit 

PEN 100; SIZE=2; FONT=5; COLOUR='blue' 

DTEXT [WINDOW=1] TEXT='Sepal Measurements'; PEN=100; Y=0; X=0 

DTEXT [WINDOW=2] TEXT='Petal Measurements'; PEN=100; Y=0; X=0 

 

"Boxplots of iris measurement in windows 3 to 6" 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

YAXIS WINDOW=3,4; MARKS=1; LOWER=0; UPPER=8 

YAXIS WINDOW=5,6; MARKS=1; LOWER=0; UPPER=5 

SCALAR win; 3 

TEXT [VALUES='Length',*,'Width',*] title 

FOR [INDEX=i] var=Sepal_Length,Petal_Length,\ 

                  Sepal_Width,Petal_Width 

   BOXPLOT [WINDOW=win; SCREEN=keep; \ 

           AXISTITLE=title$[i]] DATA=var; GROUP=Species 

   CALC win = win+1 

ENDFOR 

 

"Scatterplot of length vrs widths in windows 7 and 8" 

YAXIS WINDOW=7,8; MARKS=1; LOWER=0; UPPER=8; TITLE='Length' 

XAXIS WINDOW=7,8; MARKS=1; LOWER=0; UPPER=5; TITLE='Width' 

DGRAPH [WINDOW=7; SCREEN=keep; KEYWINDOW=0] \ 

       Y=Sepal_Length; X=Sepal_Width; PEN=Species 

DGRAPH [WINDOW=8; SCREEN=keep; KEYWINDOW=0] \ 

       Y=Petal_Length; X=Petal_Width; PEN=Species 

 

"Add a key in window 8" 

DTEXT [WINDOW=8] TEXT='Setosa'; PEN=1; Y=6; X=3.5 

DTEXT [WINDOW=8] TEXT='Versicolor'; PEN=2; Y=5; X=3.5 

DTEXT [WINDOW=8] TEXT='Virginica'; PEN=3; Y=4; X=3.5 

 

ENDJOB 
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Note, the code above makes use of the DCLEAR directive, which clears the screen so 

that the next plot produced is drawn onto an empty screen (see Section 4.2.10). 

 

 
 

Figure 4.13: Test-graph showing the arrangement of windows 1 to 8 following the three calls to FFRAME. 
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Figure 4.14: Multi-windowed figure created using FFRAME. 

 

 Forming a band of graduated colours using DCOLOURS 

Procedure DCOLOURS can be used to create a band of graduated colours by interpolating 

between start and end colour values (set by parameters START and END, respectively). 

The number of colours in the band is set using the NCOLOURS parameter (default 20). 

The type of colour band that is constructed is determined using the METHOD option. 

The default, METHOD=linear, forms the colour band by interpolating between START 

and END RGB values. (Text containing the name of a pre-defined colour may also be 

supplied). Alternatively, METHOD=spectral forms an approximate rainbow spectrum 

for wavelengths between 380 nm and 780 nm. Here, the START and END parameters 

specify the start and end wavelengths. The final setting, METHOD=blackbody, forms 

colours of hot objects with temperatures between 500 K and 11000 K. Here the START 

and END parameters specify the start and end temperatures. 
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By default, the red, green and blue values of the colour band are assumed to vary 

linearly with wavelength, temperature or RGB. However, you can use the GAMMA 

parameter to specify a power transformation (default 1). 

The RGB values of the colours in the band can be saved in a variate using the RGB 

parameter. Alternatively, the red, green and blue components of the colours can be saved 

using the RED, GREEN and BLUE parameters (again in variates). 

To display a test graph of the colour band, we can set option PLOT=testgraph (and 

use the parameters WINDOW, TITLE and SCREEN as normal). 

The following code generates a range of colour bands using DCOLOURS. These are 

displayed in a multi-windowed frame (defined using FFRAME, see Section 4.2.11) to 

generate Figure 4.15. 

 
JOB 

FFRAME [ROWS=9; COLUMNS=2; MARGIN=none; STARTWINDOW=21; \ 

       YMUPPER=0.02; YMLOWER=0.03; CSKIP=0.02; \  

       NUMBERING=columnwise] 

PEN -5; SIZE=0.9 

 

DCOLOURS [METHOD=spectral; PLOT=test] GAMMA=0.3; WINDOW=21 

 

DCOLOURS [METHOD=spectral; PLOT=test] GAMMA=1.0; WINDOW=22; \ 

         SCREEN=keep 

 

DCOLOURS [METHOD=spectral; PLOT=test] GAMMA=3.0; WINDOW=23; \ 

         SCREEN=keep 

 

DCOLOURS [METHOD=blackbody; PLOT=test] GAMMA=0.3; WINDOW=24; \ 

         SCREEN=keep 

 

DCOLOURS [METHOD=blackbody; PLOT=test] GAMMA=1.0; WINDOW=25; \ 

         SCREEN=keep 

 

DCOLOURS [METHOD=blackbody; PLOT=test] GAMMA=3.0; WINDOW=26; \ 

         SCREEN=keep 

 

DCOLOURS [METHOD=linear; PLOT=test] GAMMA=0.3; WINDOW=27; \ 

         SCREEN=keep 

 

DCOLOURS [METHOD=linear; PLOT=test] GAMMA=1.0; WINDOW=28; \ 

         SCREEN=keep 

 

DCOLOURS [METHOD=linear; PLOT=test] GAMMA=3.0; WINDOW=29; \ 

         SCREEN=keep 



Example graphics 

201 

 

 

DCOLOURS [METHOD=linear; PLOT=test] START='red'; END='green'; \ 

         WINDOW=30; SCREEN=keep 

 

DCOLOURS [METHOD=linear; PLOT=test] START='red'; END='blue'; \ 

         WINDOW=31; SCREEN=keep 

 

DCOLOURS [METHOD=linear; PLOT=test] START='green'; END='blue'; \ 

         WINDOW=32; SCREEN=keep 

 

DCOLOURS [METHOD=linear; PLOT=test] START='red'; \ 

         END=!t('yellow','green'); WINDOW=33; SCREEN=keep 

 

DCOLOURS [METHOD=linear; PLOT=test] NCOLOURS=10; START='red'; \ 

         END=!t('yellow','green'); WINDOW=34; SCREEN=keep 

 

DCOLOURS [METHOD=linear; PLOT=test] START='green'; \ 

         END=!t('blue','fuchsia','white'); WINDOW=35; \ 

         SCREEN=keep 

 

DCOLOURS [METHOD=linear; PLOT=test] NCOLOURS=40; START='green';\ 

         END=!t('blue','fuchsia','white'); WINDOW=36; \ 

         SCREEN=keep   

 

DCOLOURS [METHOD=linear; PLOT=test] START='green'; \ 

         END=!t('blue','aqua','red'); WINDOW=37; SCREEN=keep   

 

DCOLOURS [METHOD=linear; PLOT=test] NCOLOURS=5; START='green'; \ 

         END=!t('blue','aqua','red'); WINDOW=38; SCREEN=keep   

 

ENDJOB 
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Figure 4.15: Test plots of various colour bands constructed using DCOLOURS. 

 

Colours saved from DCOLOURS can be assigned to pens for use in plotting. In the 

following example, a yellow to green band of seven colours is created for use in a shade 

plot (see Figure 4.16). 
 

JOB  

 

"Create a color band" 

DCOLOURS START='yellow'; END='green'; NCOLOURS=7; RGB=rgbvals 
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"Assign colours to pens" 

PEN 1...7; CAREA=#rgbvals 

 

"Data to plot" 

VARIATE [VALUES=0,0.2...2] Rows 

VARIATE [VALUES=0,0.2...1] Columns 

MATRIX [ROWS=Rows; COLUMNS=Columns] X, Y, Function 

MATRIX [MODIFY=yes; VALUES=(#Columns)11] X 

CALCULATE Y$[*;1...6] = Rows 

CALCULATE Function=COS(1/(X+0.1)** 2)+SIN(Y**2) 

 

"Shade plot" 

DSHADE Function; PEN=!(1...7); INTERVAL=0.5 

 

ENDJOB 

 

Figure 4.16: Shade plot created using a colour band defined by DCOLOURS.  
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 Hot points with DGRAPH 

 

DGRAPH allows components of the graph (i.e. pairs of Y and X structures) to be defined as 

“hot components” that can be shown or hidden in the Graphics Viewer through their 

association with “hot points”. The hot components are identified by defining a unique 

integer number for each one, using the HOTCOMPONENT parameter. The hot points are 

plotted within the graph using the Y, X and other parameters (e.g. PEN) in the usual way. 

The extra information that defines them as “hot” is supplied by setting the 

HOTDEFINITION parameter to a matrix with a row for each hot point, and a column for 

each type of hot component. The elements of the matrix specify the hot components to be 

associated with each hot point, using the numbers defined by the HOTCOMPONENT 

parameter.  

In this example a regression line with residuals is plotted, and hot points are used to 

illustrate the size of the residual for each point. The data file, DGRA-8.DAT, contains 

recordings of blood-pressure (Pressure) from a sample of 38 women whose ages range 

from 20 to 80 (Age). 

 

"Read the data recorded in the file." 

FILEREAD [NAME='%gendir%/examples/DGRA-8.DAT'] Age, Pressure 

 

"Fit the linear model." 

MODEL Pressure 

TERMS Age 

FIT [PRINT=*] Age 

"Save the fitted values" 

RKEEP FITTED=Fitted 

 

"Construct matrix containing data values and the expected values 

of X." 

CALC nva=NVALUES(Age) 

MATRIX [ROWS=nva; COLUMNS=3] mx,my 

CALCULATE mx$[*; 1,2,3],my$[*; 1,2,3] = \ 

          Age,Age,!s(*),Pressure,Fitted,!s(*) 

 

"Set up hot definition matrix by creating a matrix with one 

column and values 1...nva. All values of the hot definition 

matrix have to be integers." 

MATRIX [ROWS=nva; COLUMNS=1; VALUES=1...#nva] h 

 

"Plot Pressure and Fitted values.  
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Set HOTDEFINITION so that Pressure is assigned to matrix h. This 

means that the first point of (X,Y) has the 'hot value' 1, the 

second point of (X,Y) has the 'hot value' 2, etc. The numbers 

1,2,3... come from the corresponding elements of matrix h." 

PEN [RESET=yes] 2 

PEN [RESET=yes] 4; METHOD=line; JOIN=ascending; SYMBOL=0 

DGRAPH [WINDOW=1] Y=Pressure, Fitted; X=Age; PEN=2,4; \ 

        HOTDEFINITION=h,* 

 

"Plot lines linking residuals to fitted line. 

Set HOTCOMPONENT so that each row of mx and my is assigned an 

integer which appears in the matrix h. For example, when the 

point associated with 'hot value' 10 is clicked the line with 

HOTCOMPONENT 10 appears." 

PEN [RESET=yes] 5; METHOD=line; JOIN=given; SYMBOL=0 

DGRAPH [SCREEN=keep] Y=my$[1...#nva;*]; X=mx$[1...#nva;*]; \ 

     PEN=5; DISPLAY=hide; HOTCOMPONENT=1...nva; DESC='' 

 

Running the above program gives the graph in Figure 4.17a. To activate hot definition 

mode, click on the Hot Choice button ( ) found on the toolbar of the Graphics Viewer 

(see Section 1.2.1). This special button allows you to toggle the visibility of hot 

components in a graph. In this example, clicking on a data point reveals a light blue 

vertical line, the residual for that data point (see Figure 4.17b). Click again to hide the 

residual line. 

a) 

 

b) 

  

Figure 4.17: a) Initial plot, in which hot components are hidden. b) Plot showing a hot component as a light blue vertical 

line representing the residual for the data point selected. 
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 Automating the construction of titles and labels using GETATTRIBUTE 

The GETATTRIBUTE directive allows us to access and save attributes of a data structure 

(to pointers), for example the identifier (i.e. variable name). Using GETATTRIBUTE we 

can automate the construction of text strings for annotation, including titles. This can be 

particularly useful when generating a series of graphs in a FOR loop.  

In the code that follows we demonstrate how an overall title, and x- and y-axis titles, 

can be automatically generated using GETATTRIBUTE. The directive TXREPLACE is used 

to “beautify” the overall title by replacing underscores with spaces. In addition, the 

TXCONSTRUCT directive is used to concatenate text strings.  

The code also illustrates how a legend can be constructed by i) saving the factor labels 

as a pointer to text structures using GETATTRIBUTE and ii) using DTEXT to annotate the 

plot using the saved labels.  

 
JOB 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

FFRAME [ROWS=2; COLUMNS=2; YMLOWER=0.1; YMUPPER=0.1; \ 

       XMLOWER=0.1; CSKIP=0.05]  

SCALAR win; 1 

 

FOR yvar=Sepal_Length,Petal_Length 

    

   "Get the y variable name" 

   GETATTRIBUTE [ATTRIBUTE=identifier] yvar; SAVE=yt 

   "Beautify by replacing _ with spaces" 

   TXREPLACE OLDTEXT=#yt; NEWTEXT=ytitle; \ 

             OLDSUBTEXT='_'; NEWSUBTEXT=' ' 

    

   FOR  xvar=Sepal_Width,Petal_Width 

   

      "Get the x variable name" 

      GETATTRIBUTE [ATTRIBUTE=identifier] xvar; SAVE=xt 

      "Beautify by replacing _ with spaces" 

      TXREPLACE OLDTEXT=#xt; NEWTEXT=xtitle; \ 

                OLDSUBTEXT='_'; NEWSUBTEXT=' ' 

       

      "Form a title for the plot" 

       TXCONSTRUCT [title] ytitle, ' vrs ', xtitle 

        

       "Title the y- and x- axes using the identifier" 

       YAXIS WINDOW=win; TITLE=ytitle 

       XAXIS WINDOW=win; TITLE=xtitle 
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 "Make the graph" 

      DGRAPH [WINDOW=win; TITLE=title; KEY=0; SCREEN=keep] \ 

      Y=yvar; X=xvar; PEN=Species 

 

      CALC win=win+1 

 

      ENDFOR    

   ENDFOR 

 

"Add a legend to window 4 using DTEXT" 

GETATTRIBUTE [ATTRIBUTE=labels] Species; SAVE=labels 

DTEXT [WINDOW=4] Y=3,2.5,2; X=3(1.8); TEXT=#labels[]; \ 

      PEN=1...3 

 

ENDJOB 

 

The resulting graphic is shown in Figure 4.18. 
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Figure 4.18: Plots with annotation generated using GETATTRIBUTE. 

 Saving plots with automated filenames 

In the examples below, we use the SETDEVICE procedure, the TXCONSTRUCT directive 

and the GETATTRIBUTE directive to save a series of plots as separate.png files, using 

automatically generated filenames. In the first example, the filenames simply reflect the 

order in which the graphs were created. That is, the code below results in four .png files 

being saved to your working directory with filenames 1.png, 2.png, 3.png and 4.png. 

 

JOB 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

 

FOR [INDEX=i] var=Sepal_Length,Petal_Length,\ 

                  Sepal_Width,Petal_Width 

    

   "Get the variable name to use as the title" 

   GETATTRIBUTE [ATTRIBUTE=identifier] var; SAVE=title 

   "Beautify title by replacing _ with spaces" 

   TXREPLACE OLDTEXT=#title; NEWTEXT=bettertitle; \ 

             OLDSUBTEXT='_'; NEWSUBTEXT=' ' 

              

   "Form the file name" 

   "Example 1: using index" 

   TXCONSTRUCT [tvar] i, '.png' 

   "Example 2: using the variable name" 

   "TXCONSTRUCT [tvar] #title, '.png'"    

 

   "Open a graphical file" 

   SETDEVICE tvar; NUMBER=Device 

 

   "Make the graph" 

   BOXPLOT [TITLE=bettertitle] DATA=var; GROUP=Species 

 

   "Close the graphical file" 

   CLOSE CHANNEL=Device; FILETYPE=graph 

 

   "Switch the graphics device back to 1 (the default)" 

   DEVICE 1 

 

ENDFOR 

In the second example, we modify the TXCONSTRUCT call so that the variable name 

(i.e. identifier) is used to construct the filename. That is, we replace  

TXCONSTRUCT [tvar] i, '.png' 

with 
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TXCONSTRUCT [tvar] #title, '.png', 

where title is a pointer to a text structure containing the identifier (generated using the 

GETATTRIBUTE directive). Doing so results in four .png files being saved to your 

working directory with filenames Petal_Length.png, Petal_Width.png, Sepal_Length.png 

and Sepal_Width. 

 

 Producing a multi-page pdf file of graphs  

In Section 3.6 we used the DEVICE, OPEN and CLOSE directives to save a graph to a pdf 

file. The following example expands on this by demonstrating how to produce a multi-

page pdf file using commands.  The commands below will save a multi-page pdf file, 

named IrisGraphs.pdf, to your working directory. 
 

JOB 

SPLOAD '%GENDIR%/Data/Iris.gsh' 

 

"Open graphics channel 4 or 13 and set DEVICE to that channel" 

OPEN 'IrisGraphs.pdf'; CHANNEL=4; FILE=graphics  

DEVICE 4  

 

"Generate graphs" 

FOR [INDEX=i] var=Sepal_Length,Petal_Length,\ 

                  Sepal_Width,Petal_Width 

   GETATTRIBUTE [ATTRIBUTE=identifier] var; SAVE=title 

   TXREPLACE OLDTEXT=#title; NEWTEXT=bettertitle; \ 

             OLDSUBTEXT='_'; NEWSUBTEXT=' ' 

   BOXPLOT [TITLE=bettertitle] DATA=var; GROUP=Species 

ENDFOR 

 

"Close the graphical file and switch the graphics device back  

 to 1 (the default)" 

CLOSE CHANNEL=4; FILETYPE=graph 

DEVICE 1 

 

ENDJOB 

 

 (Note: A multi-page pdf file can also be created from the Graphics Viewer menu File | 

Save All to PDF….) 

 

 Colourful plot using PEN 

In Section 3.4 we showed how the appearance of the graphical elements (e.g. symbols, 

lines, axes, titles, labels, annotation and filled polygons) could be altered by changing the 
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attributes of the graphical pens using the PEN directive. In the example below, we use the 

PEN directive to create the multi-coloured plot of Figure 4.19. 

 
JOB 

 

"Data for plotting" 

VARIATE Y; VALUES=!(2,6,4,8,10) 

VARIATE X; VALUES=!(2,4,5,1,6) 

VARIATE YL; VALUES=!(1,4,3.9,7.5,5.3) 

VARIATE YH; VALUES=!(3,7,6,8.5,11) 

VARIATE XL; VALUES=!(1.5,3.4,4.9,0.5,5.3) 

VARIATE XH; VALUES=!(2.5,4.4,5.2,1.5,7) 

 

"Setting the pens used when drawing the plotting windows" 

FRAME WINDOW=1,2; XLOWER=0,0.5; XUPPER=1 

FRAME [GRID=xy] WINDOW=1; PENTITLE=9; PENGRID=10; BOX=omit 

FRAME WINDOW=2; PENKEY=11; BOXKEY=omit 

 

"Setting the pens used when drawing the axis" 

XAXIS 1; TITLE='X-Title'; PENTITLE=2; PENAXIS=4; PENLABELS=6 

YAXIS 1; TITLE='Y-Title'; PENTITLE=3; PENAXIS=5; PENLABELS=8 

 

"Defining the pens" 

PEN -5; COLOUR='cyan' 

PEN 2...14; COLOUR='red','blue','green','gold','fuchsia',\ 

    'teal','chocolate','olive','palegoldenrod','lawngreen',\ 

    'purple','darkred'; SIZE=1.5; THICKNESS=2 

PEN 10; LINESTYLE=2 

PEN 12; LINESTYLE=4; METHOD=line; JOIN=ascending; SYMBOL=2; \ 

    CFILL='lavender'; CSYMBOL='navy' 

PEN 13,14; BARTHICKNESS=2 

" In this example the following pens are used: 

  pen 2 and 3 for plotting the titles along x- and y-axis 

  pen 4 and 5 for plotting the x-axis and y-axis, 

  pen 6 and 8 for plotting the labels along x- and y-axis, 

  pen 9, 10 and 11 for plotting the title, grid and key 

  pen 12 for plotting the points and line, 

  pen 13 for plotting the x-bars, 

  pen 14 for plotting the y-bars. 

  pen -5 for the key title." 

DGRAPH [WINDOW=1; KEYWINDOW=2; TITLE='Colourful plot'; \ 

       KEYDESCRIPTION='Key'] Y=Y; X=X; \ 

       YLOWER=YL; YUPPER=YH; XLOWER=XL; XUPPER=XH; \ 

       PEN=12; XBARPEN=13; YBARPEN=14 

 

ENDJOB 
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 Plot with bespoke symbols, rotated and labelled using PEN 

Genstat provides a selection of pre-defined symbols (see Appendix 5.3). However, the 

PEN directive also lets us define our own. To do so, we set the SYMBOL parameter to a 

pointer containing a pair of variates. These variates define a set of points that will be 

joined using straight lines to form our symbol. (Missing values can be used to break the 

connection.) The points should be within a notional square with bounds -1.0 to 1.0 in each 

direction. The square is centred on the data point, and scaled to the same size as the 

standard symbols.  

Alternatively, we can supply an image in the form of a bitmap (i.e. a matrix of RGB 

colour values). 

Using the commands below we generate a panel of four graphs with user-defined 

symbols: i) a diamond created using a pointer, ii) an arrow created using a pointer, iii) a 

colourful square created using a matrix of RGB values, and iv) an imported image. 

Furthermore, we alter the orientation of the symbols using the ROTATION parameter of 

PEN and add labels using the LABELS parameter. To avoid the labels being rotated, they 

are added as a separate series using their own pen. See Figure 4.20 

 

Figure 4.19: Multi-coloured plot created by assigning pens to draw particular elements of the plot. 
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JOB 

 

"Create a multi-panelled figure" 

FFRAME [ROWS=2; COLUMNS=2; STARTWINDOW=1; YMUPPER=0.07; \ 

       SQUARESHAPES=yes] 

        

"Coordinates of a diamond symbol" 

VARIATE [VALUES=-1,0,1,0,-1] Diamond[1] 

&       [VALUES= 0,-0.5,0,0.5,0] Diamond[2] 

 

"Coordinates of an arrow symbol" 

VARIATE [VALUES=-1,1,0.5,*,1,0.5] Arrow[1] 

&       [VALUES=0,0,-0.5,*,0,0.5] Arrow[2] 

 

"Create a matrix of RGB values" 

VARIATE [NVALUES=4] rgb  

CALCULATE rgb$[1...4]= RGB('limegreen','purple','gold','orange') 

MATRIX [ROWS=2; COLUMNS=2] RGBmatrix; VALUES=rgb 

 

"Import an image as a of RGB colours" 

IMPORT [RGBMETHOD=matrix] \ 

       '%GENDIR%/Examples/GuidePart1/CapeWagtail.jpg'; \ 

       COLUMNS='RGB' 

        

"Define the pens used to plot the data" 

PEN 2,3,4,5; SYMBOLS=Diamond,Arrow,RGBmatrix,RGB; \ 

    SIZE=2,2,2,3; \ 

    ROTATION=!(0,45,90,135,180,225,270,315) 

PEN 6; SYMBOLS=0; \ 

    LABELS=!T('   0~^o', '   45~^o', '   90~^o', \ 

              '   135~^o', '   180~^o', '   225~^o', \ 

              '   270~^o', '   315~^o') 

 

"Plot graphs" 

YAXIS 1...4; UPPER=9 

XAXIS 1...4; UPPER=10 

 

DGRAPH [WINDOW=1; TITLE='PEN with SYMBOL=Diamond pointer'; \ 

       KEY=0] 2(!(1...8)); !(1...8); PEN=2,6 

DGRAPH  [WINDOW=2; TITLE='PEN with SYMBOL=Arrow pointer'; \ 

        KEY=0; SCREEN=keep] 2(!(1...8)); !(1...8); PEN=3,6 

DGRAPH  [WINDOW=3; TITLE='PEN with SYMBOL=RGB matrix'; \ 

        KEY=0; SCREEN=keep] 2(!(1...8)); !(1...8); PEN=4,6 

DGRAPH  [WINDOW=4; TITLE='PEN with SYMBOL=RGB matrix of an \ 

imported image'; KEY=0; SCREEN=keep] \ 

        2(!(1...8)); !(1...8); PEN=5,6 

 

ENDJOB 
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Figure 4.20: Plot with bespoke symbols, rotated and labelled. 
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4.3 Showcase graphs 

 

Example 1  

Keywords: Bar chart, error bars, table 

 

JOB   

FACTOR [LABELS=!T(A,B)] Trt 

FACTOR [LABELS=!T(I,II,III)] f2 

TABLE [CLASS=Trt,f2; VALUES=4,7,2,7,12,1] mean 

TABLE [CLASS=Trt,f2; VALUES=1,2,0.5,1,3,0.2] SEM 

TABLE [CLASS=Trt,f2; VALUES=6(0)] lower 

PEN 2,3; COLOUR='blue','orange' 

PEN -11; COLOUR='red'; BARTHICKNESS=3 

YAXIS WINDOW=1; TITLE='Mean response' 

XAXIS WINDOW=1; TITLE='Species' 

FRAME 2; YLOWER=0.8; YUPPER=0.9; XLOWER=0.55; \ 

      XUPPER=0.7; BOXKEY=omit 

BARCHART [WINDOW=1; KEYDESCRIPTION='Treatment'; KEYWINDOW=2]\ 

         DATA=mean; ERRORBAR=SEM; LOWERERRORBAR=lower 

ENDJOB 
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Example 2 

Keywords: Histogram, axis marks, axis labels, adding text, table, multi-windowed 

 

JOB  

READ Length 

24 28 22 22 26 24 29 26 29 25 28 26 24 31 23 30 24 26 30 26 

25 31 27 21 30 20 21 29 29 28 21 26 21 22 26 29 20 28 30 30 

26 30 23 23 27 25 30 24 32 24 26 23 24 23 30 25 24 26 26 24 

22 27 23 26 26 24 21 29 25 25 30 23 25 21 25 26 20 23 27 21 

28 27 23 27 30 21 31 27 28 23 23 24 31 29 23 25 26 27 27 28 

25 22 30 29 27 29 24 25 19 25 26 20 23 22 26 25 24 23 28 27 

24 22 29 25 24 27 26 28 30 25 22 22 27 28 24 23 24 28 25 23 

27 27 24 22 26 29 23 22 26 25 26 23 26 26 25 21 24 20 25 23 

23 27 26 25 30 27 21 27 19 25 21 25 24 21 23 20 24 21 25 30 

25 20 21 27 23 24 25 28 21 28 34 24 23 23 24 30 19 22 27 25 

29 34 28 23 35 32 30 28 31 23 36 24 24 31 28 19 35 24 26 39 

34 32 41 24 25 34 29 34 23 23 29 25 30 31 31 33 21 24 31 33 

33 31 24 31 24 40 33 41 24 29 35 31 28 26 32 31 29 28 27 28 

31 30 32 28 25 29 30 28 36 29 34 30 28 32 30 29 30 26 39 37 

30 24 36 29 32 28 34 25 31 37 34 33 35 24 28 28 27 23 31 39 

36 28 38 31 20 26 23 29 32 37 25 34 29 26 32 28 35 28 26 27 

26 36 36 27 39 33 29 34 28 22 26 37 28 36 38 33 24 29 28 34 

36 25 34 20 31 28 32 33 26 22 38 27 31 25 31 33 26 26 31 31 

24 31 29 37 32 30 23 27 35 30 32 22 25 39 28 34 33 32 31 31 

33 16 34 31 32 29 36 35 27 36 30 23 34 29 22 30 27 33 36 28: 

FACTOR [LEVELS=!(18,22); VALUES=200(18, 22)] Temp 

VARIATE Leng18,Leng22; VALUES=Length 

RESTRICT Leng18,Leng22; Temp .EQ. 18, 22 

FRAME WINDOW=1,2; YLOWER=0.7; YUPPER=0.92; XLOWER=0.26,0.80; \ 

      XUPPER=0.5,1; XMLOWER=0; XMUPPER=0 
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FRAME 5,6; YMLOWER=0.05; XMLOWER=0.05; BOX=2(omit) 

PEN -5; SIZE=1.2 

VARIATE [VALUES=20,25...40] Limits 

TEXT [VALUES='-20','21-25','26-30','31-35','36-40','40+'] Labels 

XAXIS WINDOW=5; MARKS=!(17.5,22.5,27.5,32.5,37.7,42.5); 

LABELS=Labels 

DHISTOGRAM [WINDOW=5; KEYWINDOW=0; LIMITS=Limits;\ 

           TITLE='Histogram of length'] \ 

           Leng18,Leng22; PEN=1,2; \ 

           NOBSERVATIONS=NObs18,NObs22 

DTEXT [WINDOW=5] X=!(35,35); Y=!(100,90); \ 

      TEXT=!T('18~^o','22~^o'); PEN=!(1,2) 

VARIATE VObs18,VObs22; VALUES=NObs18,NObs22 

CALCULATE Diff = VObs18 - VObs22 

FACTOR [LABELS=Labels] FDiff 

TABLE [CLASSIFICATION=FDiff; VALUES=#Diff] TabDiff 

CALC Direction = (TabDiff>0)+1 

VARIATE [NVALUES=6] DPen 

EQUATE Direction; DPen 

PEN 1,2; COLOUR='hotpink','aqua' 

DHISTOGRAM [WINDOW=6; SCREEN=keep; KEYWINDOW=0; \ 

           TITLE='Difference in frequencies (i.e. bar length) \ 

 between 18~^o and 22~^o'] TabDiff; PEN=DPen 

ENDJOB 
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Example 3 

Keywords: Pie chart 

 

JOB  

FRAME WINDOW=1...4; YLOWER=2(0.25,0); YUPPER=2(0.75,0.35); \ 

      XLOWER=0,0.50,0.15,0.65; XUPPER=(0.5,1)2 

PEN -3,-6,-5; SIZE=0.85,0.95,1.50 

DPIE [WINDOW=1; KEYWINDOW=3; ANNOTATION=perc; \ 

     TITLE='Version 1'] SLICE=2(5),5(15),-15; \ 

     DESCRIPTION='Pie=1','Pie=2','Pie=3','Pie=4','Pie=5',\ 

     'Pie=6','Pie=7','Pie=8' 

DPIE [WINDOW=2; KEYWINDOW=4; SCREEN=keep; OUTLINE=perimeter; \ 

     TITLE='Version 2'] SLICE=2(5),5(15),-15; \ 

     PEN=11...18; DESCRIPTION='Pie=1','Pie=2','Pie=3','Pie=4', \ 

     'Pie=5','Pie=6','Pie=7','Pie=8' 

ENDJOB 
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Example 4 

Keywords: Trellis plot  

 

JOB   

SPLOAD '%GENDIR%/Data/Iris.gsh' 

PEN 1; COLOUR='slategray'; SYMBOL='circle'; CFILL='skyblue' 

PEN 2; COLOUR='blue'; THICKNESS=4; SYMBOLS=0 

TRELLIS [GROUPS=Species; USEPENS=yes; YTITLE='Sepal Length';\ 

        XTITLE='Petal Length'; KEYHEIGHT=0] \ 

        Y=2(Sepal_Length); X=2(Petal_Length); \ 

        METHOD=point,spline 

ENDJOB 
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Example 5 

Keywords: Shade plot, colour band 

 

 

JOB 

TEXT [VALUES=Estate,'Arna1.5','Alfa2.5',Mondialqc,Testarossa,\ 

     Croma,Panda,Regatta,Regattad,Uno,X19,Contach,Delta] Car 

CALCULATE nCar = NVALUES(Car) 

SYMMETRIC [ROWS=Car] Carsim 

READ Carsim 
 1.000 

 0.976 1.000 

 0.815 0.800 1.000 

 0.576 0.546 0.762 1.000 

 0.389 0.355 0.561 0.827 1.000 

 0.794 0.776 0.762 0.768 0.567 1.000 

 0.820 0.855 0.618 0.296 0.103 0.546 1.000 

 0.981 0.969 0.823 0.589 0.394 0.820 0.801 1.000 

 0.839 0.822 0.675 0.525 0.329 0.756 0.756 0.844 1.000 

 0.884 0.909 0.693 0.409 0.211 0.650 0.960 0.866 0.815 1.000 

 0.870 0.858 0.828 0.578 0.425 0.602 0.758 0.836 0.700 0.787 1.000 

 0.462 0.432 0.618 0.709 0.885 0.440 0.215 0.458 0.309 0.302 0.531 1.000 

 0.959 0.951 0.837 0.585 0.393 0.814 0.813 0.959 0.806 0.871 0.826 0.471 1.000 

: 
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VARIATE [VALUES=0.2,0.4,0.6,0.8,1] limits 

CALCULATE nlim = NVAL(limits) 

VARIATE [VALUES=0,#limits] lim0 

VARIATE [NVAL=nlim] lim1 

EQUATE lim0; NEWSTR=lim1 

TXCONSTRUCT [TEXT=hdesc] lim1,' - ',limits; DECIMALS=2 

TEXT [VALUES=#hdesc,'     1.00   '] desc 

CALCULATE ncolours = NVAL(limits) + 1 

CALCULATE ncol_1 = ncolours - 1 

VARIATE pen; VALUES = 10 + !(1...ncolours) 

CALCULATE revpen  = REVERSE(pen) 

TEXT lcol; VALUES=!t(red,black)  

VARIATE [VALUES=ncol_1,1] vncolours 

DCOLOURS [METHOD=LINEAR] START='lightgrey'; END=lcol; \ 

         NCOLOURS=vncolours; GAMMA=0.75; WINDOW=0; RGB=rgb 

PEN #pen; CAREA=#rgb 

FRAME 1; BOX=omit 

XAXIS 1; MARKS=!(1...nCar); LABELS=Car; LROTATION=25 

YAXIS 1; MARKS=!(1...nCar); LABELS=Car 

FRAME 1; YLOWER=0.1; YUPPER=0.9; XLOWER=0.1; XUPPER=0.9; \ 

      BOXKEY=omit 

FRAME 2; YLOWER=0.4; YUPPER=0.9; XLOWER=0.6; XUPPER=1; \ 

      BOXKEY=omit 

DSHADE [KEYDESCRIPTION='R~^{2} values'] Carsim; LIMITS=limits; \ 

       PEN=pen; DESCRIPTION=desc 

ENDJOB 
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Example 6 

Keywords: Plotting a table, 3D histogram, shade plot, surface plot, contour plot 

 

JOB  

TEXT [VAL=Aberdeen,Birmingham,Cardiff,Dundee,Edinburgh, \ 

          Liverpool,Manchester,Sheffield,Swansea] Town 
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VARIATE [VAL=79...84] Year; DECIMALS=0 

FACTOR [NVALUES=54; LABELS=Town] Factor1 

FACTOR [NVALUES=54; LEVELS=Year] Factor2 

TABLE [CLASSIFICATION=Factor1,Factor2] TabSales 

READ TabSales 

    608 635 672 692  685  723 

    757 743 785 816  783  737 

    714 751 710 763  788  830 

    662 632 758 721  893  837 

    416 461 478 462  497  520 

    618 601 784 720  863  921 

    343 391 358 366  418  470 

    816 859 820 938 1007 1158 

    531 569 615 624  607  593: 

VARIATE vTabSales; VALUES=TabSales 

GENERATE Factor1, Factor2 

FFRAME [ROWS=2; COLUMNS=2; MARGIN=ytitle,xtitle] 

XAXIS 1...4; TITLE='Year'; MARKS=Year 

YAXIS 1...4; MARKS=!(1...9); LABELS=Town; \ 

      LDIRECTION=perpendicular 

ZAXIS 1...4; TITLE= 'Sales'; TPOSITION=end 

PEN -1,-3; SIZE=2.5,1.7 

PEN 5,7; COLOUR='crimson','teal' 

D3HISTOGRAM [WINDOW=1; TITLE='D3HISTOGRAM'] TabSales; PEN=7 

PEN -1,-3; SIZE=1.2,1 

DSHADE [WINDOW=2; KEYWINDOW=0; SCREEN=keep; TITLE='DSHADE'; \ 

       YORIENTATION=normal] TabSales; NGROUPS=9; PEN=7 

PEN -1,-3; SIZE=2.5,1.7 

DSURFACE [WINDOW=3; KEYWINDOW=0; SCREEN=keep; \ 

         TITLE='DSURFACE'] TabSales; PENFILL=5; PENMESH=0; \ 

         PENSIDE=7 

PEN -1,-3; SIZE=1.2,1 

DCONTOUR [WINDOW=4; KEYWINDOW=0; SCREEN=keep; \ 

         TITLE='DCONTOUR'; YORIENTATION=normal] TabSales; \ 

          PENCONTOUR=7; PENFILL=5 

ENDJOB 
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Example 7 

Keywords: Monotonic line plot, shaded polygon, label 

 

JOB 

SCALAR u; VALUE=1.96 "Modify this to change percentage shaded" 

CALCULATE u_1 = u + 0.1 

VARIATE [VALUES=-4,-3.9...4] x 

&       [VALUES=u,u,u_1...4] xfill 

CALCULATE z, fu, zfill = \ 

          1 / SQRT( 2 * C( 'pi')) * EXP(-0.5 * x, u, xfill ** 2) 

&         zfill$[1] = 0 

YAXIS 3; LOWER=0; TITLE='f(x)' 

PEN [RESET=y] 1...3; METHOD=monotonic,line,fill; \ 

     COLOUR=*,'black','lime'; SYMBOLS=0; LINESTYLE=1; \ 

     JOIN=ascending,2(given) 

SCALAR %GT2; DECIMALS=1  

CALCULATE %GT2 = 100*CUNORMAL(u;0;1) 

TXCONSTRUCT [TEXT=label] %GT2,'%' 

PEN 4; LABELS=label; SYMBOLS=0; COLOUR= 0 

DGRAPH [WINDOW=3; KEYWINDOW=0; SCREEN=clear; \ 

       TITLE='Standard normal distribution'] \ 

       Y=z,!(0,fu),zfill; X=x,!(u,u),xfill; PEN=1...3 

&      [SCREEN=keep] 0.04; X=2.5; PEN=4 

ENDJOB 



Example graphics 

224 

 

Example 8 

Keywords: Line plot, secondary y-axis, automated title, FOR loop 

 
JOB 

DCLEAR 

FACTOR Treat 

READ Treat, Yld, TotN, Ngift, Nres 

1    2554   112.8     0   9.2     2    2554   112.8     0   9.2 

1    3198   171.9    88   6.1     2    3513   199.8    88   5.3 

1    3448   220.7   176  11.5     2    3666   230.8   176  11.4 

1    3473   272.4   264  13.4     2    3134   281.5   264  26.3 

1    3595   311.9   352  51.1     2    3701   308.3   352  59.0: 

FRAME 1...4; YLOWER=0.5; YUPPER=1; XLOWER=2(0,0.5); \ 

      XUPPER=2(0.5,1); XMUPPER=0.10; XMLOWER=0.10 

FRAME 5...8; YLOWER=0.55; YUPPER=0.67,0.65; \ 

      XLOWER=2(0.11,0.61); \ 

      XUPPER= 2(0.5,1); BOXKEY=omit 

XAXIS 1...4; LOWER=-20; UPPER=420; \ 

      TITLE= 'N Gift (kg/ha)'; YORIGIN=0; MARKS=100 

YAXIS 1...4; MPOSITION=outside; LPOSITION=outside; \ 

      LOWER=0; XORIGIN=(-20,420)2; MARKS=(1000,50)2; \ 

      TITLE='Yield (ton/ha)', 'N absorption (kg/ha)' 

PEN 1,2; METHOD=line; SYMBOLS= 9, 2 

FOR ii=1, 2; jj=1,3; kk=2,4; ll= 5,7; mm=6,8 

   TXCONSTRUCT [TEXT=title] 'Treatment ', ii 

   RESTRICT Yld, Ngift, TotN; Treat.EQ.ii 

   DGRAPH [WINDOW=jj; KEYWINDOW=ll; SCREEN=keep; \ 

          TITLE=title] Yld; Ngift; PEN=1; DESCRIPTION= 'Yield' 

   &      [WINDOW=kk; SCREEN=keep; KEYWINDOW=mm] TotN; Ngift; \ 

          PEN=2; DESCRIPTION= 'N Absorption' 

   RESTRICT Yld, Ngift, TotN 

ENDFOR 
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Example 9 

Keywords: Line plot, multi-axis 

 

JOB 

FACTOR Treat 

READ Treat, Yld, TotN, Ngift, Nres 

1    2554   112.8     0   9.2     2    2554   112.8     0   9.2 

1    3198   171.9    88   6.1     2    3513   199.8    88   5.3 

1    3448   220.7   176  11.5     2    3666   230.8   176  11.4 

1    3473   272.4   264  13.4     2    3134   281.5   264  26.3 

1    3595   311.9   352  51.1     2    3701   308.3   352  59.0: 

FRAME 5...8; XMLOWER=0; XMUPPER=0; YMLOWER= 2(0,0); \ 

      YMUPPER= 2(0,0); BOX=omit 
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XAXIS 5,7; LOWER=0,0; UPPER=500,500; YORIGIN=0; \ 

      MARKS=!(100,200,300,400),!(400); \ 

      LABELS=*,'N Gift (kg/ha)'; \ 

      MPOSITION=inside,*; LPOSITION=inside,inside; REVERSE=yes 

XAXIS 6,8; LOWER=0,0; UPPER=500,500; YORIGIN= 0; \ 

      MARKS=!(100,200,300,400),!(400); \ 

      LABELS= *,'N Absorption (kg/ha)'; \ 

      MPOSITION=inside,*; LPOSITION=inside,inside 

YAXIS 5...8; LOWER=0,0,0,0; UPPER=4200,4200,500,500; XORIGIN=0;\ 

      MARKS=2(!(1000,2000,3000,4000), !(100,200,300,400,460)); \ 

      LABELS=!T(3(''),'Yield (ton/ha)'),*,\ 

      !T('100','200','300','400','N Residual (kg/ha)'), \ 

      !T('100','200','300','400','N Gift (kg/ha)'); \ 

      MPOSITION=*,inside,inside,inside; \ 

      LPOSITION=inside,inside,inside,inside; REVERSE=2(no,yes) 

PEN 1,2; METHOD=line; LINESTYLE=1,7; SYMBOLS=2,4 

DSTART [TITLE='Cauliflower Lelystad summer 1992'] 

DGRAPH [WINDOW=5; KEYWINDOW=0] Yld; Ngift; PEN= Treat 

&      [WINDOW=6; SCREEN=keep] Yld; TotN; PEN= Treat 

&      [WINDOW=7] Nres; Ngift; PEN= Treat 

&      [WINDOW=8] Ngift; TotN; PEN= Treat 

DFINISH 

ENDJOB 
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Example 10 

Keywords: Monotonic line plot, error bars, transformed axis, typesetting 

 
JOB  

READ \ 

Log_h, Lower, Theta, Upper 

0.03 0.400 0.416 0.444 1.00 0.397 0.414 0.436 

1.30 0.391 0.411 0.432 1.50 0.385 0.408 0.428 

1.70 0.375 0.402 0.422 2.00 0.355 0.384 0.408 

2.40 0.312 0.342 0.373 2.70 0.266 0.297 0.336 

3.00 0.212 0.251 0.301 3.40 0.146 0.195 0.260 

3.70 0.109 0.161 0.233 4.00 0.081 0.132 0.210 

4.20 0.067 0.116 0.196 : 

CALCULATE h = 10**Log_h 

PEN 1; METHOD= monotonic; SYMBOLS= 0 

XAXIS 5,6; TITLE='~{theta} (cm~^3 / cm~^3)'; \ 

      LOWER=0; UPPER=0.5; MARKS=!(0, 0.1 ... 0.5) 

YAXIS 5; TITLE='log10(|h|) (cm)'; UPPER=5 

DGRAPH [TITLE='pF Curve'; WINDOW=5; KEYWINDOW=0] \ 

       Log_h; Theta; XLOWER=Lower; XUPPER=Upper 

VARIATE [VALUES=1...10,20,30...100,200,300...1000,\ 

        2000,3000...10000,20000,30000...100000] Marks 

YAXIS 6; TITLE='|h| (cm)'; UPPER=10**5; TRANSFORM=log10; \ 

      MARKS=Marks; LABELS=!t('10~^0',8(''), '10~^1',8(''),\ 

      '10~^2',8(''),'10~^3',8(''),\ 

      '10~^4',8(''),'10~^5') 

DGRAPH [TITLE='pF Curve'; WINDOW=6; KEYWINDOW=0; SCREEN=keep]\ 

       h; Theta; XLOWER=Lower; XUPPER=Upper 

ENDJOB 



Example graphics 

228 

 

Example 11  

Keywords: Line plot, trellised, automated labelling of key 

 

JOB 

DCLEAR 

FACTOR Year, Farm 

READ Year, Daynr, Farm, Index 
89 243  2 .26  89 243 11 .44  89 243 12 .38  89 243 22 .28  89 247  2 .16 

89 247 11 .20  89 247 12 .23  89 247 22 .17  89 250  2 .14  89 250 11 .20 

89 250 12 .20  89 250 22 .15  89 254  2 .10  89 254 11 .13  89 254 12 .17 

89 254 22 .11  89 257  2 .11  89 257 11 .09  89 257 12 .11  89 257 22 .08 

89 261  2 .07  89 261 11 .09  89 261 12 .09  89 261 22 .07  89 264  2 .07 

89 264 11 .07  89 264 12 .07  89 264 22 .06  89 268  2 .05  89 268 11 .06 

89 268 12 .06  89 268 22 .05  89 271  2 .05  89 271 11 .05  89 271 12 .06 

89 271 22 .05  89 275  2 .04  89 275 11 .04  89 275 12 .05  89 275 22 .04 

90 232  1 .54  90 232  2 .46  90 232 11 .52  90 235  1 .54  90 235  2 .35 

90 235 11 .49  90 239  1 .37  90 239  2 .33  90 239 11 .27  90 242  1 .36 

90 242  2 .27  90 242 11 .26  90 246  1 .26  90 246  2 .16  90 246 11 .18 

90 249  1 .16  90 249  2 .13  90 249 11 .11  90 253  1 .11  90 253  2 .11 



Example graphics 

229 

 

90 253 11 .12  90 256  1 .11  90 256  2 .09  90 256 11 .09  90 260  1 .09 

90 260  2 .07  90 260 11 .08  90 263  1 .05  90 263  2 .07  90 263 11 .06 

90 267  1 .05  90 267  2 .06  90 267 11 .05  90 270  1 .06  90 270  2 .05 

90 270 11 .05  90 274  1 .05  90 274  2 .05  90 274 11 .05  90 277  1 .05 

90 277  2 .05  90 277 11 .04  91 245 11 .84  91 245 12 .57  91 245 17 .47 

91 248 11 .91  91 248 12 .67  91 248 17 .69  91 252 11 .57  91 252 12 .40 

91 252 17 .35  91 255 11 .43  91 255 12 .47  91 255 17 .41  91 259 11 .39 

91 259 12 .40  91 259 17 .34  91 262 11 .42  91 262 12 .30  91 262 17 .28 

91 266 11 .25  91 266 12 .22  91 266 17 .22  91 269 11 .20  91 269 12 .20 

91 269 17 .15  91 273 11 .14  91 273 12 .14  91 273 17 .12  91 276 11 .12 

91 276 12 .12  91 276 17 .11  91 280 11 .14  91 280 12 .12  91 280 17 .12 

91 283 11 .06  91 283 12 .08  91 283 17 .06  91 287 11 .06  91 287 12 .07 

91 287 17 .07  91 290 11 .06  91 290 12 .06  91 290 17 .06  92 226 17 .41 

92 226 31 .41  92 226 34 .44  92 226 36 .47  92 230 17 .57  92 230 31 .51 

92 230 34 .59  92 230 36 .62  92 233 17 .39  92 233 31 .35  92 233 34 .39 

92 233 36 .45  92 237 17 .37  92 237 31 .35  92 237 34 .35  92 237 36 .42 

92 240 17 .33  92 240 31 .32  92 240 34 .31  92 240 36 .32  92 244 17 .34 

92 244 31 .19  92 244 34 .23  92 244 36 .31  92 247 17 .26  92 247 31 .15 

92 247 34 .18  92 247 36 .24  92 251 17 .22  92 251 31 .13  92 251 34 .15 

92 251 36 .21  92 254 17 .16  92 254 31 .15  92 254 34 .13  92 254 36 .15 

92 258 17 .13  92 258 31 .14  92 258 34 .10  92 258 36 .13  92 261 17 .09 

92 261 31 .09  92 261 34 .09  92 261 36 .14  92 265 17 .09  92 265 31 .08 

92 265 34 .07  92 265 36 .13  92 268 17 .07  92 268 31 .06  92 268 34 .07 

92 268 36 .08  92 275 17 .06  92 275 31 .05  92 275 34 .05  92 275 36 .06 : 

GETATTRIBUTE [levels] Farm; SAVE=SFarm 

FTEXT SFarm[]; FarmsLabels 

CALCULATE nlevels = NLEV(Farm) 

CALCULATE lnIndex= LOG(Index) 

FRAME 1...4; YLOWER=2(0.6,0.1); YUPPER=2(0.93,0.43); \ 

      XLOWER=(0.35,0.85)2; XUPPER=(0.5,1)2 

FRAME 5...8; BOX=omit 

XAXIS 5...8; TITLE='Day number from January 1'; LOWER=200; \ 

      UPPER=300 

YAXIS 5...8; TITLE='Yield index'; LOWER=-3.5; UPPER=0 

PEN 1...nlevels; METHOD=line; SYMBOLS=1...nlevels 

FOR jj=89...92; \ 

    tt='Year 1989','Year 1990','Year 1991','Year 1992'; \ 

    ww=5...8; kk=1...4 

  RESTRICT lnIndex, Daynr; Year .EQ. jj 

  DGRAPH [TITLE=tt; WINDOW=ww; KEYWINDOW=kk; SCREEN=keep; \ 

     KEYDESCRIPTION='Farm'] lnIndex; Daynr; PEN=Farm; \ 

     DESCRIPTION=FarmsLabels 

  RESTRICT lnIndex, Daynr 

ENDFOR 

ENDJOB 
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Example 12 

Keywords: Line plot, trellised, reversed axis, hidden axis, automated annotation 

 

JOB  

FACTOR Ngift 

READ \ 

Ngift, Depth, m[1...4]; FREP=labels 
   0   30  35.85  39.90   2.85  51.30    0   60  21.90  18.90   9.75   6.30 

   0   90  13.65  14.55  19.80   9.00    0  120   9.75  11.85  16.20  18.65 

   0  150   6.15   7.80  12.60  11.10    0  200   7.25   9.00  14.00  16.00 

   0  250  10.50   9.50  12.33  13.50    0  300  15.75  13.75  11.00  11.00 

 120   30  44.85  41.70   4.50  55.95  120   60  25.65  18.60  12.00  11.10 

 120   90  16.05  14.85  18.90  13.35  120  120  11.70  10.80  16.40  34.20 

 120  150   8.25  15.75  12.00  14.55  120  200   8.50   5.50  13.67  19.25 

 120  250   9.50  14.25   7.67  12.50  120  300  14.25  13.50   8.67   8.25 

 180   30  41.40  46.20   4.05  63.90  180   60  25.05  22.50  12.00   7.35 

 180   90  13.50  15.45  20.10  15.15  180  120   8.70   9.60  17.60  22.35 
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 180  150   5.55   9.00  13.20  15.45  180  200   7.00   7.75  15.33  19.25 

 180  250   9.25  12.00   8.67  12.00  180  300  16.50  15.00   9.33  10.75 

 240   30  36.00  53.70   6.45  60.45  240   60  22.35  28.05  16.20  11.55 

 240   90  13.35  15.45  27.30  22.20  240  120  11.10  10.20  22.60  27.60 

 240  150   6.45   5.85  16.60  19.35  240  200   7.00  10.00  18.00  21.25 

 240  250   8.50   9.50  12.33  15.25  240  300  13.25  13.50  11.33  12.50 

 300   30  38.55  97.75   7.65  22.50  300   60  22.35  56.85  31.95  13.05 

 300   90  13.80  19.95  57.75  32.55  300  120  11.40  12.15  29.00  40.50 

 300  150   6.75   7.65  20.40  30.75  300  200   7.50   7.75  24.00  33.75 

 300  250  12.25   9.50  15.67  22.50  300  300  14.00  14.50  14.67  18.50 : 

FRAME 1...4; XLOWER=0,0.25...0.75; XUPPER=0.25,0.5...1; \ 

      YLOWER=0; YUPPER=1; XMLOWER=0.04; \ 

      XMUPPER=0.02; YMUPPER=0.07; YMLOWER=0.08; BOX=omit 

XAXIS 1...4; TITLE='25-03-92','14-10-92','20-01-93','25-03-93';\ 

      LOWER=0; UPPER=100; MARKS=!(0,50,100); YORIGIN=0; \ 

      MPOSITION=outside; LPOSITION=inside 

YAXIS 1...4; TITLE='Depth in cm minus ground level',*,*,*; \ 

      ACTION=display,2(hide),display; \ 

      LOWER=0; UPPER=310; MARKS=!(100,200,300); \ 

      XORIGIN=0,0,0,100; MPOSITION=inside,*,*,inside; \ 

      LPOSITION=inside,*,*,inside; REVERSE=yes 

PEN 1...5; METH=line; JOIN=given; LINESTYLE=1,4,5,6,7 

GETATT [labels] Ngift; SAVE=SaveN 

FRAME 13; XLOWER=0.36; YUPPER=0.23 

DGRAPH [KEYWINDOW=13; TITLE='N Amount'; \ 

       KEYDESCRIPTION='N Gift'] Depth; m[1]; PEN=Ngift; \ 

       DESCRIPTION=SaveN['labels'] 

&      [WINDOW=2; KEYWINDOW=0; SCREEN=keep] Depth; m[2]; \ 

       PEN=Ngift 

&      [WINDOW=3] Depth; m[3]; PEN=Ngift 

&      [WINDOW=4] Depth; m[4]; PEN=Ngift 

ENDJOB 
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Example 13 

Keywords: error bars, composite plot, hidden axis, data labels 

NB: This example displays the results of a threshold model. The figure can also be 

produced by Biometris procedure DORDINAL. 

 

JOB  

TEXT tname 

READ tname, aantal[0...5]; FREPRESENTATION=labels 

         'Applause' 0  1  6 11  2  0     'Beau Jour' 0  0  1  7  7  5 

   'Big T. Supreme' 0  1  2  5  7  5  'Bonos Memory' 0  0  0  0  2 17 

          'Chapeau' 0  0  0  3 10  7     'Delhi Red' 5  4  7  1  1  2 

      'Esta Bonita' 0  0  0 10  7  3       'Fiancee' 0  0  0  1  4 15 

       'Friendship' 0  0  0  2  4 14    'High Style' 0  0 13  6  0  1 

'Jacksonville Gold' 0  1  2  4 12  1        'Jester' 0  2  3  7  7  1 

            'Lecce' 0  1  1  6 12  0   'Love Letter' 0  0  0  3  5 12 

          'Maestro' 0  0  0  0  1 19        'Nicole' 0  0  0  5 10  5 
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            'Oscar' 0  0  0  3  5 12      'Roselind' 0  6 14  0  0  0 

           'Saxony' 0  3 15  1  1  0 'Spic and Span' 0  0  0  0  0 20 

           'Topaze' 0  0  0  2  9  9    'Traderhorn' 0  0  0  0  4 16 

            'T 512' 0  0  0  0  1 19   'Vedi Napoli' 0  0  2  4  6  8 

           'Veerle' 0  1 10  1  7  1       'Venetie' 0  0  7  8  4  1 

         'Victoria' 0  0  0  0  7 13     'Wild Rose' 0  0  9  8  3  0 

           'Zenith' 0  0  0  0  0 20         'Zorro' 0  0  0  3  4 13: 

GROUPS tname; name 

MODEL [DISTRIBUTION=multinomial; YRELATION=cum] aantal[] 

TERMS [FULL=yes] name 

FIT [NOMESSAGE=dispersion] name 

RKEEP ESTIMATES=esti 

VARIATE [NVALUES=5] bound 

&       [NVALUES=30] estimate 

EQUATE esti; !P(bound,estimate) 

CALCULATE diff = DIFF(bound;1) 

&         diff$[1] = diff$[2] 

&         xpos = bound - diff/2 

SCALAR    L 

CALCULATE L = bound$[5] + diff$[5] / 2 

VARIATE [VALUES=#xpos, L] xpos 

TEXT [NVALUES=6; VALUES='0','1','2','3','4','5'] namebound 

CALC nlines = NVAL( estimate) 

&    nlines1 = nlines + 1 

&    minbound = MIN( esti) 

&    maxbound = MAX( esti) 

&    xlower = minbound - (maxbound - minbound) 

&    xupper = maxbound + (maxbound - minbound) 

&    lower, upper = estimate - 1, -1 * 2.9444 

VARIATE [VAL=(1, #nlines)5] y 

VARIATE [VAL=2(#bound)] x 

FACTOR [LEV=!(1...5); VAL=2(1...5)] factor 

FRAME 3; BOX=omit 

XAXIS 3; ACTION=hide; LOWER=xlower; UPPER=xupper 

YAXIS 3; ACTION=hide; LOWER=-1; UPPER=nlines1 

PEN 1...5; METHOD=line; JOIN=given; SYMBOLS=0; LINESTYLE=7; \ 

    COLOUR='red' 

PEN 6; SYMBOLS=0; LABELS=tname; COLOUR='blue' 

PEN 7; LINESTYLE=1; SYMBOLS=1; COLOUR='purple' 

PEN 8; SYMBOLS=0; LABELS=namebound; COLOUR='red' 

PRINT (factor)2; FREP=ord,lev; DEC=0 

DGRAPH [WINDOW=3; KEYWINDOW=0] !(1...nlines); \ 

       X=!(#nlines(xlower)); PEN=6 

&      [SCREEN=keep] y; X=x; PEN=factor 

&      !(1...nlines); X=estimate; PEN=7; XLOWER= lower; \ 

       XUPPER=upper 

&      !(6(0)); X=xpos; PEN=8 

ENDJOB  
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Example 14 

Keywords: Line plots with breaks, smooth curve, grid lines, pointer 
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JOB 

FILEREAD [NAME='%gendir%/examples/DGRA-7.DAT'] X,Y 

XAXIS 1; LOWER=0; UPPER=7000; MARK=!(0,1000...7000) 

YAXIS 1; LOWER=0; UPPER=10000; MARK=!(0,1000...10000) 

FRAME [GRID=xy,yx] 1; YLOWER=0; YUPPER=1; XLOWER=0; XUPPER=0.7 

PEN 1; SYMBOL=0; METHOD=closed; JOIN=given; LINESTYLE=1 

DGRAPH [KEYWINDOW=0; TITLE='Wind speed'] Y; X 

"Add arrows of different sizes and angles at different places" 

DELETE [REDEFINE=yes] Y,X 

SCALAR N,P; 35,5     "no. units, no. points in shapes " 

MATRIX [ROWS=P; COLUMNS=N] XX,YY 

DIAGONAL [ROWS=N] Size 

POINTER [NVALUES=!T(X,Y)] At,Shape 

MATRIX [ROWS=1; COLUMNS=N] Angle,At[] 

MATRIX [ROWS=P; COLUMNS=1] Onep,Shape[]; VALUES=!((1)#P),(*)2 

READ  Shape[1,2] 

   0.0  0.0 

   0.0  1.0 

  -0.25 0.75 

   0.0  1.0 

   0.25 0.75 : 

OPEN '%gendir%/examples/DGRA-7A.DAT'; CHANNEL=data7 

READ [CHANNEL=data7] At[],Size,Angle 

CLOSE data7 

CALC Rad = ARCCOS(0.5)/60.0 

CALC XX,YY = (Shape['X','Y']*+COS(Angle*Rad)+    \ 

     (-1,+1)*Shape['Y','X']*+SIN(Angle*Rad))*+(Size)*6    \ 

      + Onep*+At['X','Y'] 

VARIATE [NVAL=P] Xg[1...N],Yg[1...N] 

CALC Xg[1...N] = XX$[*;1...N] 

CALC Yg[1...N] = YY$[*;1...N] 

"Each Xg[] and Yg[] variate contains 5 points on the  

 coordinates scale to draw an arrow" 

PEN 1; LINESTYLE=1; SYMBOL=0; METHOD=line; JOIN=given; \ 

    CLINE='red' 

DGRAPH [SCREEN=keep; KEYWINDOW=0] Yg[]; Xg[]; PEN=1 

ENDJOB 
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Example 15 

Keywords: Symbol font, scatter plot, labels 

NB: The ‘ZDingbats Medium’ font was downloaded from https://bigfontsite.com/. 

 

JOB  

TEXT Labs; VALUES=!t(\ 

A,B,C,D,E,F,G,H,I,J,K,L,M,N,O,P,Q,R,S,T,U,V,W,X,Y,Z, \ 

a,b,c,d,e,f,g,h,i,j,k,l,m,n,o,p,q,r,s,t,u,v,w,x,y,z, \ 

'0','1','2','3','4','5','6','7','8','9','~','!','@', \ 

'#','$','%','^','&','*','(',')','_','+','<','>','?', \ 

',','.','/',':',';','{','[',']','}','|','\\','-','=',\ 

'``',',','.','†','‡','ˆ','¡','¢','£','¤','¥','¦','§',\ 

'¨','©','ª','«','¬','®','¯','°','±','²','³','´','µ', \ 

'¶','·','¸','¹','º','»','¼','½','¾','¿','À','Á','Â', \ 

'Ã','Ä','Å','Æ','Ç','È','É','Ê','Ë','Ì','Í','Î','Ï', \ 

'Ð','Ñ','Ò','Ó','Ô','Õ','Ö','×','Ø','Ù','Ú','Û','Ü', \ 

'Ý','Þ','ß','à','á','â','ã','ä','å','æ','ç','è','é', \  

'ê','ë','ì','í','î','ï','ñ','ò','ó','ô','õ','ö','÷', \ 

'ø','ù','ú','û','ü','ý','þ') 

https://bigfontsite.com/
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CALC N = NVALUES(Labs) 

CALC t = !(1...N) + 4 

CALC X = (t)**(2/3)*COS(C('pi')*(t/3)**(2/3)) 

CALC Y = (t)**(2/3)*SIN(C('pi')*(t/3)**(2/3)) 

 

PEN 1; SYMBOL=0; SIZE=2; FONT='ZDingbats Medium'; \ 

    LABELS=Labs; XLPOSITION=centre; YLPOSITION=centre 

DGRAPH [WINDOW=3; KEYWINDOW=0; TITLE='Points plotted with the \ 

''ZDingbats Medium'' font'] Y; X 

 

ENDJOB 

 

Example 16 

Keywords: Unicode, non-ASCII characters 

NB: If your computer allows it, you can use non-ASCII characters, such as accented 

letters and Chinese, Korean or Thai characters, in a Genstat graph.  
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JOB 

 

SCALAR N; 256  

VARIATE [NVALUES=N] t,X,Y 

TEXT[NVALUES=N] Labs 

FOR [NTIMES=N; INDEX=i] 

    TXINTEGERCODES [CONVERTTO=text] Labs$[i]; CODES=9808+i 

ENDFOR 

CALC t = !(1...N) + 4 

CALC X = (t)**(2/3)*COS(C('pi')*(t/3)**(2/3)) 

CALC Y = (t)**(2/3)*SIN(C('pi')*(t/3)**(2/3)) 

 

PEN 1; SYMBOL=0; SIZE=2; LABELS=Labs; \ 

    XLPOSITION=centre; YLPOSITION=centre 

FRAME WINDOW=3; BOX=omit     

YAXIS WINDOW=3; ACTION=hide 

XAXIS WINDOW=3; ACTION=hide 

DGRAPH [WINDOW=3; KEYWINDOW=0; TITLE='Unicode Miscellaneous \ 

Symbols'] Y; X 

 

ENDJOB  
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5 Appendices 

 

5.1 Genstat graphical directives and procedures 

 

 Directives for line-printer plots 

The following directives produce plots in “line-printer” style, i.e. using the characters of 

ordinary textual output: 

LPCONTOUR  produces contour maps of two-way arrays of numbers 

LPGRAPH  produces scatter plots and line graphs 

LPHISTOGRAM  plots histograms 

 

Example plots generated by these directives under their default parameter and option 

settings are given in Section 4.1. 

 

 Directives for high-resolution plots 

Directives for high-resolution plots have two main purposes: i) those that define the 

Graphics Environment, and 2) those that do the plotting.  

To change the Graphics Environment, the following directives can be used: 

XAXIS defines the x-axis in each graphical window 

YAXIS defines the y-axis in each graphical window 

ZAXIS defines the z-axis in each graphical window 

AXIS defines an oblique axis for high-resolution graphics 

DEVICE switches between graphics devices 

FRAME defines the positions of the windows within the frame 

PEN defines the properties of the graphical pens 

DFONT defines the default font for high-resolution graphics 

DKEEP saves information about the Graphics Environment in Genstat data 

structures 

DLOAD loads the Graphics Environment settings from an external file 

DSAVE saves the current Graphics Environment settings to an external file 

GETRGB provides a standard sequence of colours (defined by the initial defaults 

of the Genstat pens) 
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The directives for plotting high-resolution graphs are: 

BARCHART plots bar charts 

DGRAPH produces scatter plots and line graphs 

DHISTOGRAM plots histograms  

DPIE produces pie charts  

DCONTOUR produces contour maps  

DBITMAP plots a bitmap of RGB colours 

DSHADE produces a shade diagram of 3-dimensional data 

DSURFACE draws a perspective plot of a two-way array of numbers 

D3GRAPH plots a 3-dimensional graph 

D3HISTOGRAM produces 3-dimensional histograms 

DSTART starts a sequence of related plots 

DFINISH ends a sequence of related plots 

DDISPLAY redraws the current graphical display 

DCLEAR clears a graphics screen 

 

Example of plots generated by these directives under their default parameter and option 

settings are given in Section 4.1. 

 

 Procedures 

Other facilities, provided by procedures include: 

 

A2DISPLAY provides further output following an analysis of variance by A2WAY 

A2PLOT plots effects from two-level designs with robust s.e. estimates 

ABIVARIATE  produces graphs and statistics for bivariate analysis of variance 

ADPOLYNOMIAL plots single-factor polynomial contrasts fitted by ANOVA 

AFIELDRESIDUALS display residuals in field layout 

AGRAPH plots tables of means from an analysis of variance 

AKAIKEHISTOGRAM prints histograms with improved definition of group 

AMCOMPARISON plots pairwise multiple comparison tests between ANOVA means 

APLOT plots residuals from an ANOVA analysis 

AUGRAPH plots tables of means from AUNBALANCED 

BANK calculates the optimum aspect ratio for a graph 

BGPLOT produces plots for output and diagnostics from MCMC simulations 

BGRAPH plots a tree 
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BIPLOT produces a biplot from a set of variates 

BJFORECAST plots forecasts of a time series using a previously fitted ARIMA 

BLANDALTMAN produces Bland-Altman plots to assess the agreement between two 

variates 

BOXPLOT draws box-and-whisker diagrams (schematic plots) 

CABIPLOT plots results from correspondence analysis or multiple correspondence 

analysis 

CRBIPLOT plots correlation or distance biplots after RDA, or ranking biplots after 

CCA 

CRTRIPLOT plots ordination biplots or triplots after CCA or RDA 

CVAPLOT plots the mean and unit scores from a canonical variates analysis 

DARROW adds arrows to an existing plot 

DBARCHART plots bar charts for one or two-way tables 

DBIPLOT plots a biplot from an analysis by PCP, CVA or PCO 

DCIRCULAR plots circular data 

DCOLOURS forms a band of graduated colours for graphics 

DCOMPOSITIONAL plots 3-part compositional data within a barycentric triangle 

DCORRELATION plots a correlation matrix 

DCOVARIOGRAM plots 2-dimensional auto-and cross-variograms 

DDENDROGRAM draws dendrograms with control over structure and style 

DDESIGN plots the plan of an experimental design 

DELLIPSE plots 2-dimensional scatter plot with confidence, prediction and/or 

equal-frequency ellipses superimposed 

DERRORBAR adds error bars to an existing graph 

DFRTEXT adds text to a graphics frame 

DFUNCTION plots a function 

DHELP provides information about Genstat graphics 

DHSCATTERGRAM plots an h-scattergram 

DKEY adds a bespoke key to a plot 

DKSTPLOT produces diagnostic plots for space-time clustering 

DMADENSITY plots the empirical CDF or PDF (kernel smoothed) by groups 

DMASS plots discrete data like mass spectra, discrete probability functions 

DMSCATTER produces a scatter-plot matrix for one or two sets of variables 

DMST produces a plot of an ordination with minimum spanning tree 

DOTHISTOGRAM plots dot histograms 

DOTPLOT produces a dot-plot 
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DPOLYGON draws polygons using high-resolution graphics 

DPROBABILITY creates probability distribution plots 

DPSPECTRALPLOT calculates an estimate of the spectrum of a spatial point pattern 

DPTMAP draws maps for spatial point patterns using high-resolution graphics. 

DPTREAD adds points interactively to a spatial point pattern. 

DQMAP displays a genetic map. 

DQMKSCORES plots a grid of marker scores for genotypes and indicates missing data 

DQMQTLSCAN plots the results of a genome-wide scan for QTL × E effects in multiple 

environments 

DQRECOMBINATIONS plots a matrix of recombination frequencies between markers 

DQSQTLSCAN plots the results of a genome-wide QTL search in a single environment 

trial 

DREFERENCELINE adds reference lines to a graph 

DRESIDUALS produces model-checking plots of residuals 

DREPMEASURES plots profiles and differences of profiles for repeated measures data. 

DRPOLYGON reads a polygon interactively from the current graphics device. 

DSCATTER produces a scatter-plot matrix 

DSEPARATION creates a separation plot for visualising the fit of a model with a 

dichotomous or polytomous outcome 

DSPIDERWEB produces spider-web and star plots 

DTABLE plots tables 

DTEXT adds text to a graph 

DTIMEPLOT produces horizontal bars displaying a continuous time record 

DVARIOGRAM plots fitted models to an experimental variogram 

DXDENSITY produces one-dimensional density (or violin) plots 

DXYDENSITY produces density plots for large data sets 

DXYGRAPH draws two-dimensional graphs with marginal distribution plots 

alongside the y- and x-axes 

DYPOLAR produces polar plots 

FFRAME forms multiple windows in a plot-matrix for high-resolution graphics 

GGEBIPLOT plots displays to assess genotype+genotype-by-environment variation 

HGGRAPH draws a graph to display the fit of an HGLM or DHGLM analysis 

HGPLOT produces model-checking plots for a HGLM or DHGLM analysis  

INSIDE determines whether points lie within a specified polygon 

LORENZ plots the Lorenz curve and calculates the Gini and asymmetry 

coefficients 
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LSIPLOT plots least significant intervals, saved from SEDLSI  

MAHISTOGRAM plots histograms of microarray data 

MAPLOT produces two-dimensional plots of microarray data 

MASHADE produces shade plots to display spatial variation of microarray data 

MAVOLCANO produces volcano plots of microarray data 

MOVINGAVERAGE calculates and plots the moving average of a time series 

PLINK prints a link to a graphics file into an HTML file 

RDESTIMATES plots one-or two-way tables of regression estimates 

RGRAPH draws a graph to display the fit of a regression model 

RQLINEAR fits and plots quantile regressions for linear models 

RQNONLINEAR fits and plots quantile regressions for nonlinear models 

RQSMOOTH fits and plots quantile regressions for loess or spline models 

RUGPLOT draws rug plots to display the distribution of one or more samples 

SETDEVICE opens a graphical file and specifies the device number on basis of its 

extension 

SPCCHART plots c or u charts representing numbers of defective items 

SPEWMA plots exponentially weighted moving-average control charts 

SPPCHART plots p or np charts for binomial testing for defective items 

SPSHEWHART plots control charts for mean and standard deviation or range 

STEM produces a simple stem-and-leaf chart 

TRELLIS produces trellis plots for each level of one or more factors 

TVGRAPH plots a vector autoregressive moving average (VARMA) model 

VDEFFECTS plots one-or two-way tables of effects estimated in a REML analysis 

VGRAPH plots tables of means from REML 

VMCOMPARISON plots pairwise multiple comparison tests between REML means 

VPLOT plots residuals from a REML analysis 

WINDROSE plots rose diagrams of circular data like wind speeds 

 

5.1.3.1 Image library of example graphs 
 

Basic plots: 
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BGRAPH 

 

BOXPLOT

 

DBARCHART 

 

DCIRCULAR 

 

 

DCOMPOSITIONAL 

 

DCORRELATION 

 

DELLIPSE 

 

DMSCATTER 

 

DOTHISTOGRAM 
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DOTPLOT 

 

DREPMEASURES 

 

DSCATTER 

 

DSEPARATION 

 

DSPIDERWEB 

 

DTIMEPLOT 

 

DXDENSITY 

 

DXYDENSITY 

 

 

DXYGRAPH 
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DYPOLAR 

 

RUGPLOT 

 

 

STEM 

 

 

   

TRELLIS 

 

WINDROSE 
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Examples of other plots: 

ABIVARIATE 

 

AFIELDRESIDUALS

 

 

AGRAPH 

 

AMCOMPARISON 

 

APLOT 

 

 

BIPLOT 
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BLANDALTMAN 

 

CABIPLOT 

 

CRBIPLOT 

 

 

CRTRIPLOT 

 

 

CVAPLOT 

 

DBIPLOT 

 

DCOVARIOGRAM 

 

DDESIGN 

 

DDENDROGRAM 
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DFUNCTION 

 

DHSCATTERGRAM 

 

DMASS 

 

 

DMST 

 

DPOLYGON 

 

 

DPROBABILITY 

 

DPSPECTRALPLOT 

 

DPTMAP 

 

DQMAP 
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DQMKSCORES 

 

 

DQMQTLSCAN 

 

DQRECOMBINATIONS 

 

DTABLE 

 
 

DVARIOGRAM 

 

GGEBIPLOT 

 

HGGRAPH 

 

LORENZ 

 
 

LSIPLOT 
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MAHISTOGRAM 

 

 

MASHADE 

 

MAVOLCANO 

 

MOVINGAVERAGE 

 

RDESTIMATES 

 

 

RGRAPH 

 

RQLINEAR 

 

RQNONLINEAR 

 

RQSMOOTH 
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RUGPLOT

 

SPCCHART 

 

 

SPEWMA 

 

SPPCHART 

 

SPSHEWHART 

 

 

TVGRAPH 

 

VDEFFECTS 

 

VGRAPH 

 

VMCOMPARISON 
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5.2 Graphics colours  

 

Colours in Genstat graphs are specified in terms of RGB values, i.e. combinations of red, 

green and blue components, each of which can take any integer value from 0 to 255. The 

following table lists some pre-defined colours with their RGB values (and corresponding 

red, green and blue values). These names are used by the graphics menus and in graphics 

directives such as PEN (see Section 3.4). Note, the physical representation of any 

particular RGB value will depend on the quality of the display device and some colours 

may be indistinguishable in practice.  

Red Colours 

Colour Name RGB value R G B 

IndianRed 13458524 205 92 92 

LightCoral 15761536 240 128 128 

Salmon 16416882 250 128 114 

DarkSalmon 15308410 233 150 122 

LightSalmon 16752762 255 160 122 

Crimson 14423100 220 20 60 

Red 16711680 255 0 0 

FireBrick 11674146 178 34 34 

DarkRed 9109504 139 0 0 

Pink Colours 

Colour Name RGB value R G B 

Pink 16761035 255 192 203 

LightPink 16758465 255 182 193 

HotPink 16738740 255 105 180 

DeepPink 16716947 255 20 147 

MediumVioletRed 13047173 199 21 133 

PaleVioletRed 14381203 219 112 147 

Orange Colours 

Colour Name RGB value R G B 

LightSalmon 16752762 255 160 122 

Coral 16744272 255 127 80 

Tomato 16737095 255 99 71 

OrangeRed 16729344 255 69 0 

DarkOrange 16747520 255 140 0 

Orange 16753920 255 165 0 

Yellow Colours 

Colour Name RGB value R G B 

Gold 16766720 255 215 0 

Yellow 16776960 255 255 0 

LightYellow 16777184 255 255 224 

LemonChiffon 16775885 255 250 205 

LightGoldenrodYellow 16448210 250 250 210 

PapayaWhip 16773077 255 239 213 

Moccasin 16770229 255 228 181 

PeachPuff 16767673 255 218 185 

PaleGoldenrod 15657130 238 232 170 

Khaki 15787660 240 230 140 
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Purple Colours 

Colour Name RGB value R G B 

Lavender 15132410 230 230 250 

Thistle 14204888 216 191 216 

Plum 14524637 221 160 221 

Violet 15631086 238 130 238 

Orchid 14315734 218 112 214 

Fuchsia 16711935 255 0 255 

MediumOrchid 12211667 186 85 211 

MediumPurple 9662683 147 112 219 

BlueViolet 9055202 138 43 226 

DarkViolet 9699539 148 0 211 

DarkOrchid 10040012 153 50 204 

DarkMagenta 9109643 139 0 139 

Purple 8388736 128 0 128 

Indigo 4915330 75 0 130 

SlateBlue 6970061 106 90 205 

DarkSlateBlue 4734347 72 61 139 

MediumSlateBlue 8087790 123 104 238 

Green Colours 

Colour Name RGB value R G B 

GreenYellow 11403055 173 255 47 

Chartreuse 8388352 127 255 0 

LawnGreen 8190976 124 252 0 

Lime 65280 0 255 0 

LimeGreen 3329330 50 205 50 

PaleGreen 10025880 152 251 152 

LightGreen 9498256 144 238 144 

MediumSpringGreen 64154 0 250 154 

SpringGreen 65407 0 255 127 

MediumSeaGreen 3978097 60 179 113 

SeaGreen 3050327 46 139 87 

ForestGreen 2263842 34 139 34 

Green 32768 0 128 0 

DarkGreen 25600 0 100 0 

YellowGreen 10145074 154 205 50 

OliveDrab 7048739 107 142 35 

Olive 8421376 128 128 0 

DarkOliveGreen 5597999 85 107 47 

MediumAquamarine 6737322 102 205 170 

DarkSeaGreen 9419919 143 188 143 

LightSeaGreen 2142890 32 178 170 

DarkCyan 35723 0 139 139 

Teal 32896 0 128 128 
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Blue Colours 

Colour Name RGB R G B 

Aqua 65535 0 255 255 

Cyan 65535 0 255 255 

LightCyan 14745599 224 255 255 

PaleTurquoise 11529966 175 238 238 

Aquamarine 8388564 127 255 212 

Turquoise 4251856 64 224 208 

MediumTurquoise 4772300 72 209 204 

DarkTurquoise 52945 0 206 209 

CadetBlue 6266528 95 158 160 

SteelBlue 4620980 70 130 180 

LightSteelBlue 11584734 176 196 222 

PurwaBlue 10215935 155 225 255 

PowderBlue 11591910 176 224 230 

LightBlue 11393254 173 216 230 

SkyBlue 8900331 135 206 235 

LightSkyBlue 8900346 135 206 250 

DeepSkyBlue 49151 0 191 255 

DodgerBlue 2003199 30 144 255 

CornflowerBlue 6591981 100 149 237 

RoyalBlue 4286945 65 105 225 

Blue 255 0 0 255 

MediumBlue 205 0 0 205 

DarkBlue 139 0 0 139 

Navy 128 0 0 128 

MidnightBlue 1644912 25 25 112 

Brown Colours 

Colour Name RGB value R G B 

Cornsilk 16775388 255 248 220 

BlanchedAlmond 16772045 255 235 205 

Bisque 16770244 255 228 196 

NavajoWhite 16768685 255 222 173 

Wheat 16113331 245 222 179 

BurlyWood 14596231 222 184 135 

Tan 13808780 210 180 140 

RosyBrown 12357519 188 143 143 

SandyBrown 16032864 244 164 96 

Goldenrod 14329120 218 165 32 

DarkGoldenrod 12092939 184 134 11 

Peru 13468991 205 133 63 

Chocolate 13789470 210 105 30 

SaddleBrown 9127187 139 69 19 

Sienna 10506797 160 82 45 

Brown 10824234 165 42 42 

Maroon 8388608 128 0 0 
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White Colours 

Colour Name RGB value R G B 

White 16777215 255 255 255 

Snow 16775930 255 250 250 

Honeydew 15794160 240 255 240 

MintCream 16121850 245 255 250 

Azure 15794175 240 255 255 

AliceBlue 15792383 240 248 255 

GhostWhite 16316671 248 248 255 

WhiteSmoke 16119285 245 245 245 

Seashell 16774638 255 245 238 

Beige 16119260 245 245 220 

OldLace 16643558 253 245 230 

FloralWhite 16775920 255 250 240 

Ivory 16777200 255 255 240 

AntiqueWhite 16444375 250 235 215 

Linen 16445670 250 240 230 

LavenderBlush 16773365 255 240 245 

MistyRose 16770273 255 228 225 

Grey Colours 

Colour Name RGB value R G B 

Gainsboro 14474460 220 220 220 

LightGray 13882323 211 211 211 

Silver 12632256 192 192 192 

DarkGray 11119017 169 169 169 

Gray 8421504 128 128 128 

DimGray 6908265 105 105 105 

LightSlateGray 7833753 119 136 153 

SlateGray 7372944 112 128 144 

DarkSlateGray 3100495 47 79 79 

Black 0 0 0 0 

 

The RGB values for pre-defined colours (or specified red, green and blue component 

values) can be obtained using the RGB function. The RGB values and names of the initial 

default colours of the pens can be obtained using the GETRGB procedure.  

Two special strings can be used to set colours within the PEN directive: 'match' and 

'background'. CFILL='match' takes the colours from CSYMBOL, and 

CAREA='match' takes the colours from CLINE. Thus, for example, if you want all 

symbols filled, you could specify PEN 1...256; CFILL='match'. The string 

'background' uses the colours specified by the BACKGROUND option or parameter of 

the FRAME directive. 
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5.3 Graphics symbols and line styles 
 

Genstat provides a choice of standard symbols and line styles that can be specified either 

by giving the name (in a text with a single value), or the number (in a scalar). 

Symbols 

Number Name Symbol  Number Name Symbol 

1 Cross   15 Tinycircle  

2 Circle   16 Female  

3 Plus   17 Male  

4 Star   18 Rhombus  

5 Square   19 Circlecross  

6 Diamond   20 Circleplus  

7 Triangle   21 Squarecross  

8 Nabla   22 Squareplus  

9 Asterisk   -1 Sphere  
10 Minus   -2 Cone  
11 Heavyminus   -3 Cylinder  
12 Heavyplus   -4 Cube  
13 Heavycross   0 None  

14 Smallcircle      

 

Line styles 
Number Name Line style  Number Name Line style 

1 solid   6 longdash  

2 dot ∙∙∙∙∙∙∙∙∙∙∙∙∙∙  7 shortdash -  -  -  -  - 

3 dash   8 closedot  

4 dotdash   9 finedot  

5 tightdash -----------  10 doubledotdash − ∙∙ − ∙∙ − ∙∙  
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